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Preface

This Quick Start Guide provides a fast and friendly introduction on Fine HVAC main
features and functionalities. All the features and functions of the program are presented
and explained in detail within the complete User’s Guide, along with informative examples.

Fine HVAC, the Fully INtegrated Environment for Heating, Ventilation and Air-
Conditioning Installations combines both designing and calculations in a uniform,
integrated environment, consisting of two main components, CAD and Calculations:

Concerning the CAD component, it is based on an autonomous CAD embedding
4MCAD engine adopting the common cad functionality and open dwg drawing file
format. The CAD component helps the user to design and then calculates and
produces completely automatically the entire calculations issue for every HVAC
project, as well as all the drawings in their final form.

Concerning the Calculations component (called also as ADAPT/FCALC), it has been
designed according to the latest technological standards and stands out for its unique
user - friendliness, its methodological thoroughness of calculations and its in-depth
presentation of the results. The HVAC Calculation Environment consists of 8 modules:
Heating Loads, Single Pipe System, Twin Pipes System, Infloor System, Cooling Loads,
Fan Coils, Air Ducts and Psychrometrics. Each module acquires data directly from the
drawings (automatically), thus resulting in significant time saving and maximum reliability
of the project results. It can also be used independently, by typing data within the
module spreadsheets.

Despite its numerous capabilities, Fine HVAC has been designed in order to be easy to
learn. Indeed, the simplicity in the operation philosophy is realised very soon and all that the
user has to do is to familiarise with the package.

This Guide is divided into three short parts:

Part 1 describes the installation procedure and the main menu structure.

Part 2 deals with the CAD component of Fine HVAC, showing its philosophy and main
features.

Part 3 describes the calculation environment of Fine HVAC and its 8 application
modules mentioned above.
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1. Installation - Launching

1.1 Installing Fine HVAC

1. Insert the CD in your computer CD-ROM drive (e.g. D:, E:) or, if you received your
software via Internet, run the installation application you downloaded.

2. When the Setup window appears, choose the language for the installation and click
OK.

3. When the Welcome page appears (as shown below), click Next.

(#] Setup - FINE-HVAC 14 NG =y

Welcome to the FINE-HVAC 14 NG
Setup Wizard
This will install FINE-HWVAC 14 NG on your compiter.

It i= recommended that you close all other applications before
caontinuing.

Click Mext to continue, or Cancel to exit Setup.

vy Amea, com [ Mext > ][ Cancel

4. When the License Agreement appears, read it carefully. If you agree with the terms,
check the respective “radio button” and then click Next (you must agree with the terms
to proceed with the installation).

5. In the next screen enter your username and organization information and check if you
want to create a desktop icon. Then click Next to see if the information is correct (see
the following window) and finally click Install for the installation procedure to begin.

6. Upon completion of the installation procedure, the following last window appears on
screen and all needed is to click Finish. In case that the Run Fine HVAC checkbox is
selected, the program will start running.

FINE - HVAC -1-



(] Setup - FINE-HVAC 14 NG o=

Completing the FINE-HVAC 14 NG
Setup Wizard
Setup has finished installing FINE-HVAC 14 NG on your

computer. The application may be launched by selecting the
installed icons.

Click Finish to exit Setup.

v, Amea, com I Mext = I[ Canicel

—— |

7. After installation, the program is located within the programs list.
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2. CAD Component

2.1 Overview

Fine HVAC is a powerful Workstation for Heating, Ventilation and Air-Conditioning Design,
which automatically performs the necessary calculations directly from the drawings,
producing all the case study results (calculation issue, technical descriptions, full-scale
drawings, bills of materials etc.). This first Part (Part 1) of the user's guide describes the
operation of the CAD component of Fine HVAC. As mentioned in the preface, the CAD
component is based on 4MCAD technology. Furthermore this CAD component is
considering the building and HVAC installation as being composed of intelligent entities
with their own attributes and properly related each one to each other. Fine HVAC CAD
Component includes 2 main modules, which co-operate closely and give the Designer the
impression he virtually works on the building: It is about a) AutoBLD that is used to load-
identify the building and b) AutoNET that is used to design and identify the network
installations. Those two subsystems are supported by a third one, with the name PLUS,
which includes many useful designing facilities.

2.2 Main menu

As soon as the program is loaded, the main menu screen appears for the first time:

Fine 14 NG - [Drawingd] = | E i
File Edit View Insert Format Tools AutoBLD AutoMET Plus Draw Dimension Modify Window Help - || & =
wid D 5H |dL [ DOV Q0 [FA |/l Fukeu|e ||/ 222007 2o B - & A
HEHE | | HyvUOH ||l | | degdehk | av =g ¢e! |KE4 7
F 3| ~][[Devaven =11 gvaveR 7 || BYLAYER =] | [BYCOIOR - |
x
Mo Selection hd jyﬂ Hy
l‘-t' General i B
Color 1 BYLAYER %
Layer BUILD_FLODT_| ﬂ‘
Linetype BYLAY] - *
Linetype ... | 1.00 m
Line weight BYLAYE )
Thickness | 0.00 s
% Plot Style
Plotstyle | BYCOLOR
Plot style ...
Plot table ... Model
£ View i
p
x
&[] Plan Views
] 4| » | M\ Model £ LayoutT ), Leyout2
|Gxid is off: ON/Snap/Aspect/<Grid spacing (X and ¥y = 1.00)>: _T Ce
FIME 14NG Levell Single Pipe Heating Sys. Elevation :0.00 10.96,-6.55,0.00 SMAP |GRID |ORTHO |POLAR |ESNAP |ETRACK |LWT MODEL |TABLET |DYN

Among the commands of the designing environment, we notice the following main options
of the package:

1. Project files management options (New Project, Open Project and Project Information)
which are located into the options group FILE.
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2. Option Group with the name AutoBLD, which includes all the commands required for
the Architectural designing.

3. Option group with the name AutoNET, which includes all the commands required for
the designing and calculation of the application (Single-pipe system, Two-pipe System,
Air-ducts etc.).

4. Auxiliary option group with the name PLUS, which |7~ —
contains a series of designing facilities for the user. T

Starting with FINE, you define a new project through
the corresponding option in the FILE menu mentioned | = -
above. In case that "New project" is selected, a window
appears on the screen where the name of the Project
should be typed. '

In order to "load" an existing project, which has

been created with the program and you want to further edit it or just view it, you select
"Select Project", and a list with the existing projects in the hard drive will be displayed on
the screen. At first, the list displays all the projects
that exist in the FINE directory and with the use of
the mouse or the keyboard and acting | = | s s
correspondingly, you can transfer to any other | "G"° —
directory, viewing at the same time the existing
projects. It is noted that the projects are included | #

into directories with the extension BLD. If an

existing project is selected, it is loaded and |
displayed on the screen. ;

Either if a new project is created or a saved one is loaded, you can start working with the
use of the subsystem commands described above. A detailed description of these
commands is available in the following chapters. Before this detailed description, a short
reference of the basic designing principles featured in the designing environment of the
package is recommended, in chapter 2.3 that follows next. If you are familiar with the use
of 4AMCAD or AutoCAD, you may page through or even skip this chapter, while if you are
not, you should read it carefully.

2.3 Drawing Principles & Basic Commands

A great advantage of the package is that the structure and the features of the drawing
environment follow the standards of the CAD industry adopted by AutoCAD, 4MCAD eftc.
In particular, the available working space is as follows:
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As shown in the above figure, the screen is divided into the following "areas":

Command line: The command line is the area where commands are entered and the
command messages appear.

Graphics area: The largest area of the screen, where drawings are created and
edited.

Cursor: The cursor is used for drawing, selecting objects and running commands from
the menus or the dialog boxes. Depending on the current command or action, the
cursor may appear as a graphics cursor (crosshairs), a selection box, a graphics cursor
with a selection box etc.

Pull-down menus: Each time you select one of these commands (AutoBLD, AutoNET
etc.) a pull-down menu is shown.

Status Line: It is the line on the bottom of the screen where the current level, the
drawing status and the current cursor coordinates are displayed. From the status line
you can enable or disable tools such as SNAP, GRID, ORTHO etc., which are
explained in the following chapter.

Toolbars: You can arrange which toolbars you want to be shown in the screen in each
project. To enable or disable a toolbar, in the upper part of the screen (where the
existing toolbars are shown) right click with the mouse and select the desired toolbar
from the list (as it is shown below).

File Edit View Inset Format Tools AutoBLD AutoNET Plus Draw Dimension Modify Window Help V| Command Bar
DEHISRIXDEVY Qe FA | A/ B|lFfdRau|o |/ 72202 @ wo @@ « A ||LY Stk
AEEE HyvrODH LE Chdaik| | av |=Z06idp! BHEFERELE AP v | Standard
v | Draw
F 7| | [[Eerarer =] praer || BYLAYER ] |[[B¥C0LoR =1
Dimensioning
B
—| & P Insert
Noselecton ] 1] k| % | / - V| Modify
s camea b3 g Explode
Color T BYLAYER @ Modify T
e BUILD_FLO0T_U. p 7] Propetie
Linetype BYLAYE | & : .
Linetype Scale 1.00 0 # i
Line weight BYLAYE Zoom
Thickness | 0.00 4 v | Entity Snaps
% Plot Style 2 Render
Plot style BYCOLOR ° XREF
Plot style ta... y Solids
Plot table ... Model )
# Solids Editing
U =y Surfaces
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Apart from that, each time you select an application from the AutoNET menu, a toolbar
with the name of the application is shown and you can either work from there or from
the AutoNET commands.

2.3.1 Drawing aids
This section describes the most important drawing aids. These are the commands:

SNAP: The graphics cursor position coordinates appear in the middle of the upper part of
the graphics area. If "Snap" is selected, the graphics cursor movement may not be
continuous but follow a specific increment (minimum movement distance). To change the
increment, right click with the mouse on “SNAP” and choose “Settings”. To activate or
deactivate it, double click on the “SNAP” icon.

GRID: The screen grid is a pattern of vertical and horizontal dots, which are placed at the
axes intersection points of an imaginary grid. The grid can be activated or deactivated by
clicking the corresponding icon or by pressing F7.

ORTHO: The "Ortho" feature restricts the cursor to horizontal or vertical movement. The
status bar shows whether the "Ortho" command is activated by displaying "ORTHQO" in
black characters. The command is activated or deactivated by clicking the corresponding
icon or by pressing F8.

ESNAP: The "Esnap" command forces the cursor to select a snap point of an object,
which is within the Pick box outline. The esnap points are characteristic geometric points
of an object (i.e. endpoint of a line). If you have specified a snap point and move the
cursor close to it, the program will identify it with a frame. The "Esnap" command can be
activated either by holding down the "SHIFT" key and right clicking the mouse or through
the additional toolbar.

2.3.2 Drawing Coordinates

When you need to determine a point, you can either use the mouse (by seeing the
coordinates in the status bar or using the snap utilities), or enter the coordinates directly in
the command line. Moreover, you can use either Cartesian or polar coordinates and
absolute or relative values, in each method (relative coordinates are usually more
convenient).

Relative coordinates: Enter the @ symbol (which indicates relative coordinates) and
then the x, y, z coordinates (Cartesian system) or the r<8<¢ coordinates (polar system) in
the command line. The system used (Cartesian or polar) is defined by the “,” or “<” symbol
respectively. If you do not insert a value for z or ¢, it will be automatically taken as zero.
For example, if you are prompted to locate the second (right) endpoint of a 2m horizontal

line, you enter:

@2,0 if you use the Cartesian coordinates (which means that the distance of the second
point from the first is 2 m on the x axis and 0 m on the y axis), or

@2<0 if you use the polar coordinates [which means that the second point is at a distance
of 2m (r=2) and an angle of 0 degrees (8=0) from the first].

Absolute coordinates: They are specified in the same way as the relative coordinates
but without using the @ symbol. The absolute coordinates are specified in relation to the
0,0 point of the drawing.

The measurement system can be activated, deactivated or changed with the F6 key.
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2.3.3 Drawing Basic Entities
In the “Draw” menu you will find the basic drawing entities:

Line: "Line" option is used for drawing segments. When you select "Line" from the menu
or type "Line" in the command line, you will be prompted to specify a start point (by left
clicking or by entering the point coordinates — relative or absolute — in the command line)
and an endpoint (determined in the same way).

Arc: The "Arc" command is used for drawing arcs. An arc can be drawn in different ways:
the default method is to specify three points of the arc ("3-Points"). Alternatively, you can
specify the start point and endpoint of the arc as well as the center of the circle where it
belongs (St, C, End). You will not find it difficult to understand and become familiar with
the various methods of drawing an arc.

Polyline: This command allows you to draw polylines, which are connected sequences of
line or arc segments created as single objects. The command is executed by either using
the menu or typing "pline" in the command line. You will be prompted to specify a start
point and an endpoint (by right clicking the mouse or by entering the point coordinates —
relative or absolute — in the command line). Then, the command options will appear (Arc,
Close, Length etc). Select A to switch to Arc mode, L to return to Line mode and C to
close the polyline.

2.3.4 Useful Commands

This section includes brief descriptions of the basic program commands, which will be
very useful. These are the commands "Zoom", "Pan", "Select", "Move", "Copy" and
"Erase" (you will find them in “View” and “Modify” menus). In particular:

Zoom: "Zoom" increases or decreases the apparent size of the image displayed, allowing
you to have a "closer" or "further" view of the drawing. There are different zooming
methods, the most functional of which is the real-time zooming ("lens / £" button). You can
use the mouse to zoom in real time — that is to zoom in and out by moving the cursor.
There are a number of zoom options as shown by typing "Zoom" in the command line:
All/Center/Dynamic/Extents/Left/Previous/Vmax/window/<Scale(X/XP)>.

Pan: "Pan" ("hand" icon) moves the position of the visible part of the drawing, so that you
can view a new (previously not visible) part. The visible part of the screen moves towards
the desired area and to the desired extent.

Select: This command selects one or more objects (or the whole drawing), in order to
execute a specific task (erase, copy etc.). Select is also used by other CAD commands
(for example, if you use the "Erase" command, "Select" will be automatically activated in
order to select the area that will be erased).

Move: This command allows moving of objects from one location to another. When the
"Move" command is activated, the "Select" command is also activated so that the object(s)
you want to move (in the way described in the previous paragraph) can be selected.

After you have selected the desired object(s), you are prompted to specify the base point
(using the snap options), which is a fixed point of the drawing. When you are prompted to
specify the position where the base point will be moved, use either the mouse or the snap
options. After you have completed this procedure, the selected object(s) will move to the
new position. Please note that the base and the new location points can be also specified
with the use of coordinates (absolute or relative, see related paragraph).

Copy: The "Copy" option allows the copying of objects from one location to another. The
"Copy" procedure is similar to the "Move" procedure and the only difference is that the
copied object remains at its original location in the drawing.

FINE - HVAC -7-



Erase: Choose this option to delete objects. The procedure is simple: Select the objects
you wish to erase (as described above), type "E" in the command line and press <Enter>.
Alternatively, you may first type "E" in the command line, then select the object(s) by left
clicking and finally right click to erase the object(s).

DDinsert (Insert Drawing): This command allows you to insert another drawing (DWG
file) or block in the drawing. When this command is selected, a window appears in which
you select block or file and then select the corresponding block or file from disk. Then you
are prompted to specify the insertion point, the scale factor etc., so that the selected
drawing is properly inserted.

Whblock: The "Wblock" command allows us to save part of a drawing or the entire drawing
in a file, as a block. When this command is selected, you are prompted to enter the file
name and then you select the drawing or the part of the drawing you wish to save. The
use of this command is similar to the "Screen Drawing" command in the AutoBLD menu,
which will be described in a following section. In order to insert a block in a drawing, you
use the "ddinsert" command described above.

Explode: The "Explode" command converts a block in a number of simple lines so that
you can edit it in that form. If it is selected, the program will prompt you to select the block
("Select object") you wish to explode.

2.3.5 Grips

Grips are some characteristic points of an object, which appear after it is selected (by
moving the cursor on the object and left clicking). The object is displayed with grips (small
squares in blue colour), which mark control s smmmmm—— -
locations and are powerful editing tools (by i3ens e ma sks e Ty

selecting one grip you can for example, move or
change the length of the line). When you click a = &
grip, the following prompt appears in the | = -~ -
command line: **STRETCH** <stretch to point> =N
/Base point /copy/ undo/ exit. If you press
<Enter> (or right click), the first characters of the
corresponding word are entered, e.g. “sc and
enter” for the "Scale" command).

When a command is executed, grips disappear and the objects are deselected. If the
command is an editing command (correction or copy), which can be preselected, the
objects take part in the execution of the command automatically. In this case, the
command overrides the "Select objects" prompt and proceeds. To deselect grips and
objects you should press <Esc> twice: once to deselect the objects and twice to
deactivate the grips.

In each object the positions of the grips are different. Namely, for a point the grip is the
point itself, for a segment the grips are the midpoint and the two endpoints, for an arc the
midpoint and the two endpoints, for a circle the center and the quadrants, for a polyline
the endpoints of the line and arc segments and the midpoints points of the arc segments,
for a spline the spline points, for a block the insertion point, for text the insertion point etc.

2.3.6 Print

This section may be read after you have created a drawing and you want to print it. Any
drawing can be printed using a printer or plotter or to a file. Printing is performed using
"PLOT" command, selected either from the "FILE" menu or typing it in the command line,
provided there is a drawing already loaded.
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Viewing a drawing before printing gives you a preview of what your drawing will look like
when it is printed. This helps you see if there are any changes you want to make before
actually printing the drawing.

If you are using print style tables, the preview shows how your drawing will print with the
assigned print styles. For example, the preview may display different colours or line
weights than those used in the drawing because of assigned print styles.

To preview a drawing before printing
1. If necessary, click the desired Layout tab or the Model tab.

2. Do one of the following:

Choose File > Plot Preview.

Y

On the Standard toolbar, click the Plot Preview tool = .

Type ppreview and then press Enter.

3. After checking the preview image, do one of the following:

To print the drawing, click Plot to display the Print dialog box.
= To return to the drawing, click Close.

The Plot dialog box is organized in several areas as it is shown in the picture below. For
help defining print settings before you print, see Customizing print options.

In the plot window, you can select the printer, the paper size and the number of copies
and several plot options such as the style (pen assignments), the orientation etc.

Moreover, you can select the plot scale and the plot area. Before you proceed to printing,
you select “Apply to layout” and then “Preview” so as to make any modifications you might
want.

To print a drawing

1. If necessary, click the desired Layout tab or the Model tab.
2. Do one of the following:

Choose File > Plot.

On the Standard toolbar, click the Print tool ( = ). If you click the Print tool, the Print
dialog box does not display. Your drawing will be sent directly to the selected printer.

Type print and then press Enter.

w

. From the Plot dialog box, make any adjustments to the settings.
. Click OK.

N
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2.3.7 Plus Drawing Tools

Those tools belong to the large group of options under the general menu PLUS. These
are a series of additional drawing tools, which have been embodied in the package in
order to help the user during drawing, and are described within the Full User’s Guide.
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2.4 AutoBUILD: Architectural Drawing

The AutoBLD option group, as we will see in detail below, includes all the facilities
required to insert a building in order to create an Architectural drawing. As it is shown in
the corresponding AutoBLD menu, the various options are divided into sub-groups.

[31 Fine 14 NG - [Drawingl] =RANE X
@ File Edit View Insert Format Tools [ AutoBLD | AutoNET Plus Draw Dimension Medify Window Help - |7 =%
db kR 0 S H |G 4| % [@ [ Building Definition... [@.&-‘:’.3@@&? O ||/ 20 3o dB - A
- " —| &= Layers Management... 8 T —

EE P [HVOE [ 8 oy bulding foor B ien B4 F
o . £
#F 1% || & O BULD_FLON_US ~| oy A - BYLAYER ~||[————FrLavER | | [evesmRT - |
Typical Data L
x
o Element Parameters L3
Mo Selection x| i Jﬂ 5 Morth Direction
]S General = B Wall 3
Color [ BYLAYER b2 Opening »
Layer BUILD_FLDO1_|= o Column »
| Linetype BYLAY] lm: Floors - Ceilings... 3
Linetype ... 1.00 Drawings - Symbaols 3
Line weight BYLAYE 2] DT R
Thidness  0.00 s
: — - N
i PlotStyle Definition of Plan View Elements
Platshde | RYCOI OR =4 Calculations 4
Element Libraries L4
2D Drawings...
[ Plan View
x gy 3D View
E@ Plan Views Axonometric |_
Screen Drawing W
=
W 4] v | ]\ Model £ Layout1 A Layout2

‘Dpposi:e corner: :

29.85,-7.10,0.00 SNAP |GRID [ORTHO [POLAR |[ESNAP |ETRACK |LWT |MODEL |TABLET |DYN

In general, the first sub-group includes commands for the definition of the project
parameters, the second and the third sub-group includes drawing commands, the fourth
sub-group includes commands for linking to the calculations, and the fifth sub-group
includes management options for the AutoBLD libraries and commands for the building
supervision. In the following sections, the options reported above are described one by
one, starting from the "Building Definition" option.

2.4.1 Building Definition and Layers Management

As soon as you select the "Building Definition" command, the levels management menu

appears ° ( Levels Management T |
On this screen the levels of the project || et _

A . . evel File Elevation Mame
building are defined, which means that 1 o

you have to determine the level and
the corresponding architectural
drawing (plan view-as xref) (DWG file)
of each building floor (only in case you
use a drawing that was created by

another architectural designing Options
program). More specifically: Love: [ JElvation: [ |
Mame :
= |n the "Level" field, define the level Fie.. | : :
(floor) number (always starting with | o | - | [ |

the number “17).
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In the "Elevation" field, define the height of the floor level. You can define manually a
benchmark for level measurement (e.g. the pavement). You can also define negative

levels (e.g. -3 m for the basement).
In the “Name” field, you give a name for each level.

In the "File" field, define the path and the name of the relevant DWG drawing-file, only
if you refer to an already existing drawing (which means that you do not intend to draw
the plan view from scratch). If there is no DWG architectural drawing available, leave

this field empty.

The insertion and the management of plan views are performed with use of the xref
command. At the bottom of the dialog box there are three functions available which are
used to manage the level files. Specifically:

Press the “New” button to save a new level or save the changes in the data of a level

(e.g. elevation, DWG drawing).

Use the "Current" option to select the plan view/file you want to work on each time.

Select the "Delete" option to delete the level you want
(after you have it selected). The "Delete" command
removes the plan view of the relevant level in the
project without deleting the original architectural
DWG file.

The “Accept” command closes the dialog box (it does
not save the floor data. This can be managed with the
“‘New” command). Fine HVAC enables also the use of
a “scanned” ground plan, which is a ground plan in a
bitmap file created by a scanner. In this particular
situation the steps to follow are described in detail
within the User’s Guide.

The “Layers Management’ option gives you the choice
to enable or disable in a quick and practical way (during
working) several layers. If you want, you can disable any
element group by simply clicking inside the indicator-box of the corresponding group.
When the box is checked, the corresponding group is enabled.

2.4.2 Drawing Walls

AutoBLD menu contains all the commands required for drawing and editing walls, such as
parallel moving of walls, trimming, extending, joining and breaking walls as well as placing
openings of any kind on them (windows, sliding doors, openings, arches). During the initial
drawing, as well as during any modification at any stage, the drawing is automatically
updated (e.g. placing an opening on a wall does not break the wall in two parts, the
opening moves easily from side to side whether you are working on the ground-plan or on
a 3D view and the wall is restored without leaving undesirable lines after deleting an
opening etc.).

-12 -
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The Wall option, located at the second subgroup of the AutoBLD group of commands,

includes the Outer, Inner, Outer wall from polyline, Inner (g ol
wall from polyline and Outline options as well as the -
option subgroup Modify, Delete, Extend, Break, Join, ||,
Trim and Move. The first subgroup concerns the wall e W Eevsisn
drawing, while the second their further processing after || _cos. | B swe 7
being drawn. By selecting Outer Wall, first of all its || = | W s = oo
attribute dialog appears with a series of parameters | == M e oo .
(type, dimensions, colours etc.), which are described in | [l [ —
detail within the User’s Guide. e

Type of ASHRAE CLTD c
In order to start drawing a wall, you click OK and then | ™™= = @ :
follow the instructions shown below: TpeolsSHRERTS 17 [ThemelAe
Outer wall (straight / arc): After activating the command
(by pressing <Enter> in the menu), you are required to

successively provide:

i) the starting point of the wall (the application message in the command prompt is: “Wall
start \ Relative to wall \ Toggle shape <Linear>")

ii) the ending point of the wall (the application message in the command prompt is “Wall
end \ Relative to wall \ Toggle shape <Linear>")

iii) the direction towards which the wall shall grow, by providing any point on one of the
two half-planes defined by the wall line (the application message in the command prompt
is "Enter Side Point").

1st Point
2nd Point .

\ Growing

Side

?\

Il )
N
Ve

After the above actions, you can see that the wall has been drawn and that you can
continue to draw another wall starting from the ending point you defined earlier, unless
you right click, which means that you want to stop (or press “ENTER”). You can change
the wall drawing from linear into circular, typing T in the following program prompts and
pressing <Enter>. During drawing, one can come to the conclusion that the ability of
drawing consecutive walls is very convenient since it prevents you from making many
movements. As mentioned further below, in the “Element Parameters” section, the
thickness of the wall, its height and its level in relation to the floor level (when the level is
0, the wall starts from the floor), are stored within the “Element Parameters” for the wall.
By providing proper values for the wall height and level, any possible case of walls of
unequal height can be dealt with. The techniques and tools for creating walls are
described in detail within the User's Guide.
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Further to the drawing functions, the program also provides powerful editing tools, such as
erase, modify (through the wall dialog box), multiple change etc.. Within the User’s Guide
there are complete instructions regarding the above commands plus the applicable
commands Copy, Stretch, Extend, Trim, Break, Unify, Mirror, Rotate, Scale, Base point.
Two other commands that are widely used while drawing the walls are a) the Undo
command, which enables you to reverse the previous command executed and b) the
Properties command, which enables you to view (and change) the attributes of the
selected wall.

2.4.3 Drawing Openings

Once the command "Opening" is activated, a second option menu is displayed, including
a variety of opening types (window, sliding door, door etc) to draw, plus also a set of
editing functions such as "Erase", "Modify" or "Move", applied to existing openings.
Besides, at the bottom of this menu lies the option “Libraries”, which enables the user to
define his/her own opening freely, to create various shapes of windows.

Window: The option "Window" demands that you select the wall on which the opening will
be placed and then define the beginning and the end of the opening (all these actions are
carried out using the mouse and pressing <Enter> each time). The window will
automatically obtain the data that are predefined in the “Attributes”, namely the
corresponding values for the height, the rise, the coefficient k etc). Of course, you can
draw the window from the ground plan as well as in the three-dimensional (3D) view.
During drawing a window, it is very helpful to the user the fact that, after the wall where
the window will be automatically placed is selected, the distance from the wall edge is
displayed in the coordinates position on the top of the screen, while the crosshair is
transferred parallel to the wall for supervision reasons. The measurement starting point
(distance 0) as well as the side (internal or external) are defined by which one of the two
edges is closer and which side was "grabbed" during the wall selection. Similar
functionality exists for other types of openings, such as Sliding Doors, Doors, Openings
etc. All the details are included within the User’s Guide.

2.4.4 Other Entities

AutoBLD provides tools for designing columns and other elements, as well as drawing
libraries including drawings and symboils to place within the drawing (i.e. general symbols,
furniture, plants etc.). Details are shown within the User Guide of Fine HVAC.

Finally, the Building model of a Fine HVAC project can be viewed through the commands:

* Plan View (2D): The two- "I 2o SmtiTRIT L e
dimensional plan view of the .
respective building level is shown. : ==

= 3D View: A three-dimensional
supervision of the ground plan of the
current floor (with given viewing -
angles) is shown. | BE=
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= Axonometric: Provides three-dimensional supervision of the whole building (for all
floors), with the given viewing angles as they have been selected in "Viewing
Features".

2.4.5 Definition of spaces — loads calculations

The Fine HVAC building model includes intelligent information, capable to recognise the
spaces and their heating and cooling loads. More specifically, the “space definition”
command enables the user to define one or more spaces, in two alternative ways

a) by selecting the walls that surround each space, or

b) by defining an internal and an external point of the space. This way needs only the
definition of an internal point of the space (by a left click of the mouse) and an external
point so that the line-rubber that is formed intersects a space wall. Then the program
"indicates" (by discontinuous outline) the defined space and asks for the space name in
the command line. By entering the name the space definition is completed and its features
are indicated on the drawing. Given that one or more spaces are already defined, the
command "Calculations" serves to calculate the Thermal losses and Cooling loads of the
building. Each one of the commands “Thermal losses” or “Cooling loads” activates the
respective application window. In each window, first of all, you have to select the “Update
from drawing” command (located at the “Files” menu) in order to transfer the drawing data
automatically (see paragraphs 3.2.1 and 3.3.1).

2.5 AutoNET: Piping Drawing Principles

The AutoNET group includes all those tools the designer needs in order to draw (and then
calculate) the HVAC piping installations. Below are described the general AutoNET
commands and you will find the specific commands for FINE HVAC applications in the
next chapters.

Drawing Definition: The layers for each installation are organised properly and the
information is shown on the respective dialog. The command "Colour" is used to assign
the desired colour to each network while the command "Linetype" is used to select the
desired line type.

Applications Layers Management: This command leads to a dialog screen where you
can activate more than one applications and monitor those which are possibly overlapping
(i.e. both Single pipe and Fan coils networks at the same time).

Copy network of Level: AutoNET enables copying of typical (installation) plan views and
pasting them on other levels through this command, which functions similarly to the “copy
level” AutoBLD option. When you select this command, the program prompts you to select
the network you want to copy (you can select it in a window), and after you do it and press
ENTER, it asks you to give the number of the level in which you want to copy it.

Select Application: This option enables selection of the desired application of Fine
HVAC. Depending on the selected application, the section of the following AutoNET menu
will be configured accordingly.

The basic principles and rules for drawing a network are described below:

Network Drawing: The installation network drawing is carried out with a single line, by
drawing lines and connecting them to each other, exactly as the network is connected in
fact. You should keep in mind some general principles regarding drawing and connecting
between straight or curved, horizontal or vertical network branches.
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Horizontal & Vertical Piping: In any case, the piping drawing is carried out exactly as the
line drawing (in AutoCAD or 4MCAD). You are able to draw horizontal or vertical pipes.
The pipe installation elevation is the current elevation. Modification of the pipe installation
elevation is possible through the menu PLUS -> Set elevation (or if you type the command
"elev"). If you type "elev" (in the command line), you are prompted to determine the new
current elevation. Press <Enter> if it is O or type the value you want. At this point it should
be emphasised that, if a horizontal piping which is found on a specific level is drawn and it
is connected to another piping or a contact point (receptor), the program automatically
"elevates" or "lowers" the pipe so that connecting to the other pipe or receptor,
respectively, is possible. In this way, the program facilitates the drawing of piping in three
dimensions while you are actually working in a two-dimension environment. In any case of
a network design, all facilities provided by AutoCAD can be utilised through relative co-
ordinates.

Vertical pipe Drawing: Drawing vertical pipes which cross floors (one or more) is
possible through the option "Main Vertical pipes (Building)". When the respective option is
selected from the menu, the program asks for the pipe position ("Enter xy Location") and
then for the height of the starting point ("Enter Height for First Point") as well as the height
of the ending point ("Enter Height for Second Point"). For example, if you want to draw a
vertical pipe from 0 to 3, by inserting the location point (XY) and then the numbers 0 and 3
successively, the symbol for direction change appears on the ground plan and in 3D View.

T e 190 - NSRBI A8 St o O —— i A AL o e i e e TS "
AR 8 S SG20E Ao R s A
o Hasrn ®

Vertical sections within the same floor: If you want to elevate or lower a pipe within the
same floor, you can use the relative coordinates. For example, if you have drawn a
horizontal pipe (in elevation of 0 m) and you want to elevate it to 2 m, when in the
command line asks for “Enter next point”, you Will Tgwaes [av |[mst4 |Bresscwe

type @0,0,2 and continue drawing the pipe (see Drwe =l el sver < |[aveoton
the adjacent photo). In the same way, if you want

to lower the pipe by 2 m, you will type @0,0,-2. d

Drawing of Curved Pipes: You can draw curved

pipes by inserting the points from which the

curved pipe is to pass (give at least 3 points). The

respective command prompts for the following: -

= First point: Insert the starting point of the pipe.

= Next point: Insert next point, the one after that and so on (successively), defining the
pipe routing in this way and to stop press <ENTER> or right click of the mouse.
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The user can easily modify curved pipes using “grips". As soon as the pipe is selected,
grips appear which you can move, altering this way the pipe routing. In the Bill of Materials
and the Calculations phase, the program will measure the pipe length precisely.

Connecting network sections: Connections between network sections (horizontal,
vertical or both) as well as between network parts and receptors can be easily executed
by using the "Snap" commands. For example, suppose that the two horizontal parts of the
ground plan below, which are placed in different heights, have to be connected. If you

start by "grabbing" the "upper" pipe end and then end up at the "lower" pipe end, the result
in the three-dimension representation will be as on the right.

T P 1410 2N L VADVCALE Dt b i\ Db hoom gl < ———
E] 06 tdn Vem bwmt fomu Toch AdchlO AvshET Py Ome Comemmn Moddy Wirdes Hep

P -
TLLCIE k] ;9w flem o B FMRRT @ (S SG0E G o@B - HA
HMEFE Bvid L dodah av -Si4s KOs B

e a0 =TT

L,

il

Another example, the result of the connection of a radiator starting from its "connection
point" and ending at the base point of the vertical pipe is shown below. Alternatively, you
can use the “Connect radiators to an existing pipe” command where after you define the

pipe and the radiators you want to be connected to it, the program connects them
automatically.

.......
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Special Commands for Pipe Construction: This is actually a set of commands aiming
at the facilitated drawing of the installation piping. More specifically, there are two basic
commands:

= Double Pipe '>Supp|y-Return A I.I:J'I:iﬂ:i'l?'\'INLIMJNl:?&A\C.D:u:mA:u:e:a‘.:u::an:u*,n;m A - o v,,..z.u
double pipe (e.g. supply-return) can be |t&owu g2 xonsveza ses 8 sucan e 2oz
<% a5B4+CHALS AT FRDHLALQLD | F|F| Y WER

drawn, when the in between distance is | > . . .. -
known, by simply defining the routing. EEi e o ool o

BYLAYER

= Pipe parallel to Wall: A pipe parallel to
the wall (walls) that you mark is drawn,
with a given distance from the wall, in
printing mm (which depends on the
printing scale as well). The program
asks for the first point and afterwards |-wew-
the wall or the walls (successively) | . sooiesiyes _
parallel to which (in a certain fixed | R
distance) the pipe is o be drawn. | TR e

BxI2ANERILR

1

= Pipe parallel to Points: A pipe is drawn parallel to the points you defined (supported
by automatic snap), with a given distance from the crooked line defined by these
points. The program asks for the first point and then for the other points (successively)
parallel to which it is desired to have the pipe drawn. When all points are inserted (and
you right click), the distance will be requested.

= Pipe parallel to Wall (or Points) and Receptor Connection: This is a particularly
useful command similar to the two commands above "Pipe parallel to wall" and "Pipe
parallel to points", which, however, enables selecting the receptors to be connected on
the routing which will be drawn parallel to the walls or the points. Therefore, it is
possible to connect a whole set of appliances to the nearest vertical or horizontal pipe,
with 2-3 moves.

For better understanding of the command function, assume that in a given room with its
radiators it is desired to install a pipe parallel to the wall and connect the radiators to it.
The steps are the following:

= Select the "Pipe parallel to points and receptor connection" command and the
following options will appear:

= Select receptors: Select the receptors to be connected to the pipe applied in a parallel
arrangement against the wall by defining certain points on the wall.

= Enter the first point & Enter the next point: Provide the points parallel to which you
want to install the pipe. The points are shown on the drawing with an X.

= Distance from a point <1.00>: Provide the distance in printing mm where the pipe is
going to be drawn starting from the inserted points.

The program draws the pipe and connects it to the receptors.

Modifying an existing network: You can edit an existing network by using any CAD
command (i.e. copy, move or erase etc. of a network section) or utility (i.e. grips) during
the design process. The only rules to apply are the following: Pipes supplying the
appliances (receptors) should be connected to the touch points of these receptors.
Obviously only one pipe can be connected to a touch point. The connection with the touch
points which appear as red "stars" in the ground plan can be executed with the "esnap"
function. Piping can be branched to one another and extend in any way as long as they do
not form loops, something which does not apply to reality anyway.
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If however a mistake occurs, the program (during the recognition procedure) will perform
all checks and indicate the mistake and its location. A necessary step before the "Network
recognition” is defining the point (1) where the network starts, that is the supply point (1).
In reality, this point corresponds to the Fire Pump. In Fine HVAC application, the menu
includes the specific options, so that you can be easily guided when drawing any
installation.

2.6 AutoNET: Network Installation Design

The previous chapter described the drawing principles, while the present one describes
those commands in relation to the special features of Fine HVAC.

Regardless of the fact if there is an AutoBLD building model, an external reference, a
digital image or even no architectural drawings, a Fine HVAC installation can be drawn
and then calculated.

Although there are no limitations regarding the order of actions followed in drawing an
installation, the following order is suggested:

= Place the receptors (Radiators, Grilles etc.)

= Draw the horizontal pipes (or air ducts)

= Connect the receptors to the pipes

= Draw the vertical pipes

= Connect the horizontal to the vertical pipes

= Define the Supply point(s)

= Run “Network Recognition”

= |[f there are no mistake messages, proceed to the calculations

In the case of heating and air-conditioning, the program automatically senses the load of

each space and allocates it equally over the redistos 23]
respective radiators or units (FCUs), or grilles (for |« Fulbrauing € Touch Points Drly
air-ducts). You can change this allocation in the | cuentSmbo. 11855

calculating environment, as you desire. The
"Receptors" selection shows the screen including
the receptors of each installation (radiators in the
Single-pipe and Two-pipes system, Fan Coils in a
Fan Coils network and grilles in an Air-duct | 15T 1ESS pm— e
network) in the form of slides. The location
procedure is exactly the same as the block
|nsert|0n procedure in AUtOCAD or 4MCAD IWG05 14355 RUMNTAL K140 RUMTAL RUNTAL K280
Receptors are always installed in the current
helght’ that c¢an be Changed through the “Set RUNTAL RUMTAL RUMNTAL K420 RUNTAL RUNTAL K560
elevation" command. |

Go to page : 1 -

Page 1/19

11905 1655 11505 11355 11305

Mext | Accept Cancel

FINE - HVAC -19-



Example: Suppose that a grille has to be installed in 2.85 m height from the floor. After
selecting "Set elevation" (from the PLUS menu) or executing the "elev" command by
typing it in the command line and inserting value 2.85, press <Enter> in the receptor
screen "on" a grille and afterwards press "OK" (or alternatively double click). Then you can
see the grille moving on the ground plan together with the graphic cursor.
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If the mouse is moved properly the grille can be carried in such a way that its base point
(which coincides with the cross of the graphic cursor) will be placed in the respective
point.
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It can now be observed that if the mouse is moved, the grille rotates around the base
point. Thus, if you confirm the angle in which you desire to install the receptor, the grille
can be seen in its final position.
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It is possible not to install the whole receptor if it already exists in the architectural ground
plan (if it has been drawn by the Architect), but activate the "Touch Points Only"
indication in the upper side of the receptor selection window, so that only the receptor
touch point will be selected in order to install it in the appropriate position.

“‘Receptors grid”, as well as the “Automatic radiators placement’, are two additional

options, explained in the main User’s Guide.

Fittings: The "Fittings" command selects the accessories to
be also inserted in the drawings, which applies exactly the
same as the receptors. Fittings have "touch points" upon
which the piping will be connected so that the network can
be recognised. A symbol may also have more than one
touch points (e.g. a collector), in which case the fitting will be
numbered as a junction point in the "Network Recognition".
The program provides the capability of cutting off the line
automatically when a symbol is inserted on the line, exactly
where the accessory interjects. This capability is defined by
the indication of the accessories box "Break Pipe". If this
option is activated, then the program will automatically
"Break" the pipe when the accessory is placed. Moreover,
the "Move Symbol" indication is in the same box, which
defines whether the accessory will be moved in relation to
the position it was initially placed (so that it will be placed
parallel and on top of the pipe) or the pipe will be moved
(so that the accessory can be attached).

Symbols: "Symbols" include various general symbols,
layout of machines (i.e. pressure units) and other drawings
that can be used in the corresponding installation.

Fittings @
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Network Recognition and Numbering: Since the network has been drawn according to
the current rules and the supply point has been determined, the "Network Recognition"
option converts the network in the required standard pattern and updates appropriately
the calculation sheet. During updating, junction points and receptors are numbered on the
ground plan. Note that if a receptor is not numbered, means that it is not connected to the
network. Besides, if a network section has a different colour it cannot be connected to the
network. Connect it or select "Break at selected point" at the connection point with the
previous pipe.

Calculations: The "Calculations" option leads you in the corresponding calculating
environment, which means that the window of the current application is “opening”, while
FINE HVAC always remains "open". In order to transfer the data from the drawings, you
select "Update from Drawing" in the menu "Files" of the corresponding calculating
application (in order to carry out the corresponding calculations, answer "Yes" to the
question "Calculate" that appears). It has to be noticed that the numbering of the sections,
the lengths of the network sections, the receptors with their supplies and the fittings (from
the piping routing) are transferred in the calculation sheet. Of course, if you want to, you
can intervene in the calculations in order to make any modifications.

Update Drawing: After the calculation part of the program is completed, save the project
file, return to the drawing program (FINE HVAC) and select “Update Drawing”. The
following window will open and you will select the information you want to be shown on
the drawing. Particularly:

- In the left part of the window, you select the information you want to be shown
regarding the pipes (or air ducts). You can select to see information for all the pipes
(choose “Select All’), some of them (choose “Select from Drawing” and select the
pipes from the drawing) or none (choose “Deselect All”). Furthermore, below this list,
you can choose which information you want to be shown, such as the length, the flow
rate, the diameter etc. If you do not want, for example, the “Velocity” to be shown,
select it and uncheck the “Selection” button.

- In the right part of the window, you select the information you want to be shown
regarding the receptors. You can select to see information for all the receptors
(choose “Select All’), some of them (choose “Select from Drawing” and select the
receptors from the drawing) or none (choose “Deselect All”). Furthermore, below this
list, you can choose which information you want to be shown, such as the receptor
name, the water flow etc. If you do not want, for example, the “Group” to be shown,
select it and uncheck the “Selection” button.

Finally, to place the information on the drawing, select either “Manually placement” or
“Auto Placement” (the program automatically chooses to place the information for each
pipe and receptor in the best position without covering each other).
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Convert single line to 3D: After the drawing has been updated, you can convert the
single lines to 3D pipes or air ducts (depending the application you are working on), by
choosing this command. The dimension of the 3D pipes and air ducts will be related to the
calculation results. When you select this command, in the command line you will have to
define which network will be converted to 3D (supply, return or both) and in which level
(one or all) and the drawing once again will be automatically updated.

Legend: The "Legend" option creates a legend with all the symbols that have been used
in this specific project. By selecting it, the program asks for the location where the Legend
is going to be inserted. Use the mouse to define the location and the legend will appear
automatically on your screen, exactly under the location point.

Vertical Diagram: This option is used for the automatic creation of the vertical diagram of

the installation and in its appearance on [ = memam fri At ==
the screen, within few seconds. In case | m ietn = w i txna|
there is already a vertical diagram, the || Network ]

program asks if you want to update it. It is |
obvious that, in order to create a vertical | """
diagram, you should draw and identify a
network and enter the calculation sheet,
so that the program knows all the data
needed for the vertical diagram creation
(pipe  dimensions, junction  points
numbering, etc). By the “creation” iﬂ
command the window of the vertical e
diagrams manager appears on screen.
This window is composed of two parts,
the part with the network tree and the part with the vertical diagram. Through specific
commands, the user can intervene in several ways on the output of the diagram:
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= Enable or disable various branches of the network

= Change the order of the columns of sub-networks in the vertical diagram
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= Change the sub-networks direction connection on the vertical columns (right or left)
= Read the information of each node
= Describe the sub-networks

The changes done in the vertical diagram are displayed in real time, in the second part of
the window. On the upper side of this window there are also icons for processing the
diagram (real time zoom and pan, zoom extends etc). In addition, in the upper-left side
there are some other icons having to do with the appearance of the screen, such as the
hiding of the left part of the window, the appearance of the level names and heights on
the left to be edited, the appearance of the numbers of the receptors, the layers and
others.

Finally there are some options for the initialization of the vertical

diagram, its recreation and the definition of the drawing 25 Initialization
parameters. In particular, these parameters depend on the Reconstruction
application and include the following options: Drawing Parameters

Layers: Through a supervisory window table you can define the drawing scale, the colors
corresponding to the various layers and the height of the texts (in mm drawn on paper)
placed on the vertical diagram.

Drawing distances: The drawing dimensions that will be considered on the creation of

the diagram are also defined on mm | Drawing Paramet B
drawn on paper Layers | l B|DCkS] Miscelaneuus] —
nelination of pipes

Blocks_ There |t can be deflned on Minimum distance between receptors : — o

- ’ O/ /|
each application different network || "
Startlng pOIntS and type Of tables Receptor - vertical pipe distance: Andell 0
You can choose from a set of .dwg || & L;‘IZI
drawings. L

Maximum dy allowed:

Miscellaneous: A set of attributes i

concerning the form of the vertical

Vertical pipe to pipe distance
|4

d|agram |S deflned, SUCh as the Bifurcation dy: | 1 Text distance: -
condensation of the columns, the B .
number of branches over whom the

node is considered as collector, Bttt ||| Swestidiee | B [ Gt | |

whether the z height information will
be considered in the diagram creation and whether the sub-networks pipes on the vertical
diagram will be placed over or under the receptors. Finally, it should be mentioned that
during the editing procedure concerning the vertical diagram manager, if there are
mistakes the program displays the proper messages and warnings.

Library Management: The Library Management leads to a submenu including the
options "Numerics", "Drawings" and “General Symbols”. The first option leads to the
libraries with all the numerical data of the materials. The "Drawings" option leads to a
dialog box where the following data can be seen, regarding each application and the
“General Symbols” window has symbols such as arrows etc..
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2.7 AutoNET: Fine HVAC Installations

In this section AutoNET commands are described in relation to the special features of
each application, which means that the general features are analysed and the special
features applying to each installation network are pointed out.

2.7.1 Two-Pipes System

The basic AutoNET drawing principles apply here as well. Generally, a typical two-pipe
heating system network (parallel induction-return networks) is drawn according to the
following procedure:

¢ Install radiators on the ground plans

Radiators are installed on the ground plans either by running the "Radiators™
command and selecting from the appearing dialog box the type which will be used (size
will be estimated in the calculating environment) or by running the "Automatic
radiators placement” command and selecting the spaces where automatic installation
will take place (on the condition that spaces are defined on the ground plan and their
thermal losses are calculated).

e Draw horizontal supply and return pipes (simply or parallel to walls, points etc.) and
connect them to the radiators (automatically or manually)

o Draw vertical pipes

¢ Install fittings such as collectors (optional)

¢ Connect horizontal to vertical pipes (directly or through collectors)
¢ Place network starting points

¢ Run network recognition

e Proceed to the calculations (pipe lengths and the respective fitting number will be
automatically inserted in the calculation sheets)

e Ground plan update including transfer of calculated types, radiator loads and pipe
dimensions through the “Update drawing” command (see paragraph 2.6 for more
information)

e Convert single lines to 3D pipes (optional)
e Create the Vertical Diagram

In two-pipes system you can design only the supply network and not the return and when
you proceed to the calculations the program will automatically double the length of the
network sections so as to calculate the return network as well.

In case that the supply is not parallel to the return network (or if they are parallel and the
user wants to draw them), then two independent networks should be drawn (one for the
supply and one for the return network) as well as two starting points in the network willl be
placed (supply point and return point). After recognition, two networks will be transferred
in the calculation sheet (supply with "." and return with "-" symbol) according to the valid
standardisation required from the calculating environment (see Two-Pipes System
calculating environment).

For example, in the following screen appears a section of a Two-Pipe installation, where
we have drawn only the supply section, which however is enough for the analytical
calculation of the installation:
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In the above example radiators are connected automatically to the columns through small
horizontal sections.
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You are absolutely free to draw horizontal and vertical sections as well as columns,
according to the example in section 5.1. The network starting pomt is provided with the
command “Supply Start Point” (Boiler), while a
return point is required only if there is a return
network.

Apart from the above general functions, you
should also be aware of the following:

e The space loads are distributed equally
over the radiators installed within the space.
From this point on, the user is able to
interfere in the calculating environment in
order to distribute the total load over the
radiators, exactly as it is desired.

- 26 - FINE - HVAC



The program recognises as space load the modified (perhaps) space load which exists
in the "Thermal Losses" and not the one which the program had initially “read" from the
ground plan.

The program shows error messages in case that the network does not fulfil the logical
drawing rules (i.e. there is a short circuit, a point where pipes of supply and return end up
etc.), while the wrong connected sections are shown with a different colour.

2.7.2 Single-Pipe System

The general AutoNET principles apply in the Single-Pipe System application as well.
However, there are several variations which result from the fact that the standardisation
applied in the Single-Pipe System application differs from the others significantly. In
general, a Single-Pipe Heating System network is drawn following the order described
below:

Install radiators on the ground plans (automatically or manually):

Radiators are installed on the ground plans either by running the "Radiators™
command and selecting from the appearing dialog box the type which will be used (size
will be estimated in the calculating environment) or by running the "Automatic
radiators placement” command and selecting the spaces where automatic installation
will take place (on the condition that spaces are defined on the ground plan and their
thermal losses are calculated).

Draw the main vertical pipes (supply and return):

Define the location where the vertical pipes will be placed as well as their starting
and ending points. Note that the vertical pipe heights should be provided in relation to
the heights determined for the building floors.

Install collectors on the ground plans

Install the supply and return collectors which are found on the various building floors on
the ground plan. Collector installation is carried out by running the "Fittings" command
and selecting the respective desired collectors from the appearing dialog box. Keep in
mind that the collector connection points are just drawing symbols, so you can connect
more than one circuit pipes to each connection point.

Draw horizontal pipes from collectors to columns

Draw the network section connecting the supply collector to the supply vertical pipe as
a supply horizontal pipe. Regarding the pipe drawing, first you select the point of the
collector (you can use the "Set point snap" to help you) and then the vertical pipe (for
the vertical pipe you can use the "Perpendicular snap" to help you). The vertical pipe is
not represented by the arrow but by the dot displayed in the middle of it (this is the
projection of the vertical pipe on the ground plan).

The same steps are followed for the connection of the return collector to the return
vertical pipe.

Draw the circuits that connect the collectors to the radiators. You can either draw
the circuits manually or automatically. If you want to draw them automatically, you
select the “Automatic placement” command. You start from the supply collector and
select the first radiator (you can then see the circuit section forming until the first
radiator), continue to the second (you select it in the same way) and so on until the last
radiator you want to be included in this circuit. When you finish, you press “‘ENTER”
and select the return collector so as to close the circuit. Circuits can be drawn using
either straight or curved pipes.
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¢ Define the network start points (supply and return) of the installation

Place the supply and return points by using the option “Network Start Point” and
selecting the endpoint of the respective pipe through “End Point” snap.

¢ Network Recognition

If the command “Network Recognition” is activated, the program identifies the circuits
as well as the radiator locations in the spaces and prepares linking files to the
calculation sheets. If something hasn’'t been drawn correctly, you will get a message
which informs you where exactly is the problem .

e Calculations

Select the option “Calculations” to call the calculation program of the Single-Pipe
application, where data are transferred to the calculation sheet when the option
"Update from Drawing", under "Files" menu, is selected.

o Update Drawing

If this option is selected, the calculated radiator types and loads as well as the circuit
data are transferred to the ground plan. If the ground plan has been updated before,
the program prompts you to update the ground plan erasing the old data (see
paragraph 2.6 for more information).

e Insert arrows on circuits

Run the command “Circuit arrows placement” to insert arrows automatically on the
circuits, following the direction from the supply collector to the return collector (you can
find the command in AutoNET -> Network start point menu).

e Convert single lines to 3D pipes (optional)
e Create the Vertical Diagram

The vertical diagram is created according to the DXF file, generated by the calculation
module.

2.7.3 Fan Coils

Everything mentioned above about the Two-Pipe system, applies here as well. Besides, in
order to transfer the calculated cooling loads, in the Cooling Loads program, the user
has to choose from the "Files" menu the option Export to -> Fan coils. There he can also
select whether he wants to transfer the "Total Loads" (e.g. in case only FCUs are used for
cooling) or the "Space Loads" (e.g. in case there is a FCU and a central air-conditioning
unit which precools the air induced in the space) or the "Ventilation Loads" (rare case).
Otherwise, the user has to enter manually the load which corresponds to each FCU in the
calculation sheet. Apparently, in the case of more than one FCU units, the space loads
are distributed equally over the FCU units installed within the particular space. From this
point on, you are able to interfere in the calculating environment in order to distribute the
total load over the FCUs, exactly as it is desired.

Furthermore, you should also be aware of the following:

e The space loads are distributed equally over the Fan Coils installed within the particular
space. From this point on, you are able to interfere in the calculating environment in
order to distribute the total load over the FCUs, exactly as it is desired.

e The program recognises as space load the modified (perhaps) space load which exists
in the "Cooling Losses" and not the one which the program had initially “read" from the
ground plan.
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The program shows error messages in case that the network does not fulfil the necessary
rules.

2.7.4 Air-Ducts

An air-duct network can be drawn in one dimension so that it can be identified and
transferred to the calculation sheet automatically. Moreover, there is also the possibility to
draw in two or three dimensions for detailed and complete air-duct ground plan drawings.
These three possibilities can be used independently as well as in combination with each
other. The greater interest lies within the automatic creation of a two-dimensional drawing
starting from a linear (one-dimensional) one. First draw the linear (one-dimensional)
figure, proceed to the network identification, carry out the calculations and update the
ground plan with the calculation results (air-duct and grille dimensions). Then run the
command "Convert single line into 2D" to receive the two-dimensional drawing of the air-
ducts, completely automatically, on the basis of the calculation results. Moreover, you can
use the “Convert single line to 3D” command so as to receive directly the three-
dimensional drawing (after the calculations have been made).

More specifically, a linear air-duct network, either supply or return, is drawn according to
the following procedure:

¢ Install grilles on the ground plans (automatically or manually)

e Draw vertical ducts

e Draw horizontal ducts (connect them to grilles)

¢ Define the network starting point (supply or return point)

¢ Run Network Recognition

e Proceed to the Calculations

¢ Update the ground plans concerning transfer of the calculated dimensions
e Convert single lines to 3D (optional)

e Create the Vertical Diagram

The above procedure should be followed separately for the supply network as well as for
the return network. During the design process, the program detects and shows all the
possible error messages.
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Example: In the following ground plan grilles are installed on the ceiling, the supply ducts
are drawn in one dimension and the supply start point (fan) is located, so the supply
network is ready for recognition.
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Suppose that there is a return network as well (e.g. with two circular grilles). The above
ground plan would look like this:
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Note that, in all connections, the section part which runs from the duct to the grilles should
be clearly shown (even through a very small section), even if these are practically placed
on the duct.
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Regarding network recognition and the loads distributed to each grille, everything
mentioned for the FCUs applies as well: In order to transfer the calculated cooling loads,
in the Cooling Loads program, the user has to choose from the "Files" menu the option
Export to -> Air ducts. There he can also select whether he wants to transfer the "Total
Loads", the "Space Loads" or the "Ventilation Loads". Otherwise, the user has to enter
manually the load that corresponds to each grille in the calculation sheet. The loads and,
by extension, the air supplies in the various spaces, are distributed equally over the grilles
installed in the space, however the user is able to interfere.

As long as the linear network has been recognised and the ground plans have been
updated, the command "Convert Linear into 2D" converts the linear air-duct network into a
two-dimensional one.

Example: The identified air-duct network displayed in the following screen:

3

will be converted according to the parameters of the "AutoFine.ini" file, which will be
described below) into the two-dimensional network shown below:

 }
E=
-
Lt %
il %300
| =
] 3000 x 250.0 H 2 h

o000 »x 2500

Note: The logical parameters - drawing commands are determined within the
"Autofine.ini" file and are explained further within the user’s guide.
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Apart from the automatic conversion of the linear network into two-dimensional, the
program enables the independent two-dimensional air-duct drawing on the ground plans,
through the "2D Design" option, activating a series of slides, each one of which is linked to
an integrated drawing routine. For example, if you select an elbow, the corresponding
drawing routine will ask for information about the starting point and the size of the
respective angle.

Each air-duct section can be constructed either as an independent section, or
consecutively to an already drawn section. In the latter case the program reads from
the previous section the direction and the initial width of the
accessory. Depending on the section, the program asks for the
necessary values of parameters. For example, regarding the
Straight Air-duct option, which corresponds to the AERE
command, the program prompts for the width, the direction and
the length of the air-duct. More specifically, the options the
previous command includes, are shown below:

= Select air-duct endpoint Points/<Line>: Select the endpoint of an already drawn air-
duct section.

= Air-duct length: Insert the air-duct length, either by typing it or using the mouse.

The program includes a series of section types/commands, covering most of the possible
cases. Some of those commands are shown below.

Contraction to the right Contraction to the
(AERR command) middle (AERM “Trousers” with straight
command) section and angle with

inner radius (AEREOQ)

“Trousers” with
curves (AERCC)

Lowering induction air-

Curve with equal Elevating induction
Curve (AERC) inner and outer air-duct (AERPU) duct (AERPD)
radius (AERS)
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Besides the two-dimensional drawing
(manually or after the automatic linear
drawing conversion), Fine HVAC also
enables 3D design, through rather a
manual procedure, supported by the 3D
drawing subsystem, which appears in the
AutoNET menu. When "3D Design" is
selected, a series of slides appear on the
screen, each one of which is linked to a
complete 3D drawing routine.

More details about how to design a 3D
air-duct network are shown within the
user’s guide.
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3. Calculations

3.1 Overview

This chapter provides a description of the Calculations Component of Fine HVAC. Each
module can be used either independently by filli

ng the numeric data, or in co-operation
with the CAD Component {q-A.‘r—Duc:s-[F:\TMP\BIKV\&_;_BUH.D(NG.BLD_ i) [

of Fine HVAC, in which | ' forcdme Bt fiov ndows Lbredes Hep
. == S ESNEE S ST EE) =E] [ [2a]m)
case the calculation | - —— == — o B3 guos

environment acquires the
data directly from the
drawings.

At the top of the

bt [ E[EEE Bl [ 2 Bl EIf feodediio H

application window
appear the general
options of each
application menu,

constituted of the group
options "Files", "Project
Data", "View",
“Windows”, "Libraries"
and "Help".

11 View Network Section

3.1.1 Files

The "Files" option deals with the file management and printing options according to the
known windows standardisation. By summarizing:

New project: Type a name in order to save the new project in a file.

Project Selection: A window appears where you can select the desired (existing) project
file and load it.

Update from Drawing: In case of cooperation with the Fine HVAC component, the
project calculation sheet is updated with the drawing data. This option replaces the data
that have already been saved in the calculation sheet.

Export to: This option serves for exchanging data between calculation applications (i.e.
the heat losses calculation is completed and you want to proceed to studying a "TWO
PIPES SYSTEM", "SINGLE PIPE SYSTEM", “INFLOOR HEATING SYSTEM” or
“PSYCHROMETRICS”). If you have used the Fine HVAC component, you should not use
the commands “Export to” -> “Two Pipes System”, “One Pipe System” etc., given that the
"Network Recognition" command updates automatically the calculation sheets of all HVYAC
applications.

Save Project: The project you are currently working on is saved on the hard disc (with the
previously given name).

Save as..: The project you are currently working on is saved in a different file with a new
name.

Load Prototype: The saved prototype appears on the screen.
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Save as Prototype: The form, which you have created and is displayed on the screen
when this option is selected, can be saved as a Prototype.

Printing Prototypes: The printing prototype management window is activated.

Printing: The project issue is printed according to the selected options in "Printing
Contents" and "Printing Parameters", following the print preview output.

Printing Contents: You can select the project items you want to print, as shown in the
respective window.

Printing Parameters: The desired printing parameters can be selected in this window
according to the procedure already mentioned in Chapter 1.

Print Preview: The complete project issue appears on the screen, exactly as it will be
printed, page to page.

Export to RTF: An rtf. file containing the project items, is created.

Link to WORD: An rtf. file, containing the project items, is created (within the project

directory. At the same time, the MS-Word application is activated (if it is installed in your
PC).

Link to EXCEL: An excel file, containing the project items, is created. At the same time,
the MS-Word application is activated (if it is installed in your PC).

Link to 4M editor: An rtf. file, containing the project items, is created. At the same time,
the 4M text editor is activated for further editing.

Export to PDF: A PDF file containing the project items, is created (within the project
directory. At the same time, the Acrobat Reader application is activated (if it is installed in
your PC).

Exit: With this command, the application stops running.

3.1.2 Project Data

This group of commands depends on the specific application, concerning the necessary
parameters and is summarized separately for the respective application.

3.1.3 View

This option follows the known windows standardization.

3.1.4 Windows

Windows include a set of windows with the case study results. The main window refers to
the calculation sheet which constitutes the core of each application.

3.1.4.1 Calculation Sheet

The execution of the calculations takes place in an advanced calculation environment
especially designed by 4M for the particular needs of any specific application. It is a
spreadsheet type environment with specific capabilities and facilities, tailor-made for each
application. More specifically, regarding Fine HVAC applications which refer to an
installation network, the calculation sheet is shown in a spreadsheet using lines
corresponding to the network branches, and columns containing primary data (e.g. length)
and results of calculations (e.g. water flow) for each branch. An example of such a
spreadsheet for the Two Pipes Application is shown below:
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I. Pipe Networks: In case the application refers to an installation network (e.g. two Pipes
system, single pipe system, or even air ducts, fan coils etc.) the calculation sheet is
standardised in a specific way. More specifically, the installation network is shown in a
spread sheet using lines corresponding to the network branches, and columns containing
primary data (e.g. length) and results of calculations (e.g. water velocity) for each branch.
An example of such a sheet for the Two Pipes System is shown below:

Y Twin Pipes System - [FATMP\BIKY\8 3 BUILDING.BLD] - [Calculation Sheet] = | E S
Ft Files Project Data View Calculation Sheet Windows Libraries Help — ||
M= I I = E RIS S
Bl7lU = &y - A -|aral YT
Else
Metwork |Pipe Radiator |Temperature|Water [Des. |Pipe Max |Water |Type|Fittings|Pipes |Total Polar  |Heated| +
Section |Length |Loads Difference |Flow Pipe |[Size Vel |Velocity |of Fr.Drop|Friction |Friction [Angle |Space
(m) {(Mcalih) |(*C) {mah) |Size (mis) [(mis) Fitt. |(mWaG)|Drop Loss )
(MWG) |(m.W.G.
1 1.2 4 1.986 125" 06 0545 F-1 0127 0.041 0.168
2 23 0.75 0.436 kil 0.6 0.331 F-2 0.034 0.006 0.039
3 (34 0.8 0.354 12" 0.6 0489 F-2 0083 0019 0101
4 |45 2 0272 1z 0.6 0376 F-2 0043 0028 0.072
5 5.6 0.5 1.485 15 0.099 12" 06 0137 F-4 0009 0.001 0.010
5 57 085 2R00 15 0.172 442" 06 0238 F-5 0022 0004 0028
7 -
4 1 »
1.5 View ‘Water Flow (m3/h)

In order to make the network understandable by the program, a specific standardization
should be followed, which is more or less the same in all applications. This
standardization can be easily understood with the following simple example.

Suppose we have the network which is shown in

the adjacent figure. This network comprises of 4 3 —/15
several branches (i.e. parts of the network),
junction points and terminals (end points). Thus in
this network, we have assigned arbitrary numbers
to both the junction points (1,2,3) and the
hydraulic terminals (4,5,6). Each junction point 6
may be assigned to a number (from 1 to 99), a 1 1
letter (lower or upper case, e.g. A, d efc) or a 2

combination of letters and numbers (e.g. A2, AB,

eZ, 2C etc.). The main restriction is that the starting point is always assigned to the
number 1. Also, assigning the same number to the same network twice is not permitted
for obvious reasons, with the exception of the junction point 1 for which the assignment
may be repeated as desired (for networks with more than one starting points). After
numbering the junction points and the terminals according to the above rule and in order
to represent the network in the spreadsheet, it is enough to give a name to the various
sections of the network entered in the first column of the spreadsheet. Having in mind that
the order of the network sections is not important, we fill in the first column with the two
junction points of each section (putting a dot in between) so that the sequence of junction
points matches the direction of the water flow in the pipe. In the above example the
network sections will be shown as:

Network section
1.2
2.3
2.6
3.4
3.5
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Above standardization, in spite of its several variations or extensions, is generally applied
so as to contribute to an easy understanding of any application even if the user applies it
initially for one particular application.

Il. Space Sheets: This standardization is encountered in applications where the related
calculations refer to the spaces of the building (or, more generally, to other building
entities such as the building views). Applications of such type are, for example, the
calculation of Thermal losses or Cooling loads for each space separately. The spread
sheet for a space is the structural element of this standardization, while all such sheets
compose the complete set of spread sheets of the study.

-
[ Thermal losses - [FATMP\BIKY\8_3_BUILDING.BLD] - [Thermal Losses Calculation Sheet] = X
E.’?Eiles Project Data View Calculation Sheet Windows Libraries Help = [ & =

DA SR il=(m)  EBIE LA A
Rl 7 U|ll=|=I==|d- iv Arial -1 |- hermal Losses Calculations -
W=z o
Level - Spaces - Losses
Surface |Orientation | Subtracted |Thicknnes{Length [Height or [Surface |Equal Total Subtracted |Calculated|L =
f R Basement o Type (m} Width (m2)  |Surface |Surface |Area Surface (|
g Ground Floor g L (o el
& 1 LivingR 2474 —
RSB 00 1 w2 [w 620 300 1860 1 1860 526 1334 0
= 2 Bedroom1 1216 =
%' 3 Bathroom 843 o1 NW S 100 220 220 A 220 220 4
. 4 Bedroom 2 790 3 o1 MW S 1.00 1.20 120 A 1.20 1.20 4
..o 5 Kitchen 1746 4 W7 MW S £.20 0.30 186 1 1.86 1.86 0
""IF”St Floor 5 W2 SW 6.65 3.00 19.95 1 19.95 5.30 1465 0
'v; ;"”d”g R°°1’“ ?i;g s (o2 SW s 150 220 330 1 3.30 330 5§
edroom
- E W7 SW S 6.65 030 200 A 2.00 2.00 0
=g 3 Bathroom a17 B
& 4 Bedroom 2 790 [_||:
%' 5 Kitchen 1916 | ||: |8 =
'@ Second Floor e I 3
% 1 LiingRoom 2069 e - Length () s6.45 | [ I'TotalThermallosses 1015 |
2 Bedroom1 1643
.‘ Shut - Down Increment (%) | 30 Width {m} 1 Increments 355
=g 3 Bathroom 770
% 4 Bedroom 2 1033 Des. Increment (%) 35 Height (m} 3.00 Final Thermal Losses 1370
.. 5 Kitchen 1746 Coef. Rorr 0s Air Changes/h 1 Losses due to Opening Slots| 294.8
"‘Third Floor Coeff. H 0.60 Property Losses due to air changes | 8084
. 1 Living Room 2873 Coeff. ZC 1 “Main Pipe. Circuit” Total Space Losses 2474
e 2 Bedroom 1 1429
% 3 Bathroom 917 Radiator No
=<' 4 Bedroom?2 912
.. 5 Kitchen 1916 7
4 m 3
11 View Surface Type (eg. W1,F2,01 eic.) Ctrl + Enteror F11 :
h

Focusing our attention on a space spread sheet we see a series of rows corresponding to
structural elements (e.g. walls W1, W3, openings O1, O2, floors F1 etc.) and columns
referring to specific characteristics of these structural elements (such as Orientation,
Length, Width etc.). Remaining columns are automatically updated with the results of
calculations related to each row element (with deferent colour for clarity). At the lower part
of the space sheet total results are also given resulting from calculations performed on all
rows’ data. In the example above which is an extract of thermal losses calculation, we can
see the sum of room partial losses at the bottom right in red.

Taking as a reference point the above spread sheet and ignoring initially the filled in
values, we can see the columns heading zone (every column has its title and units), the
zone for filling in values with a number of rows (separated with dotted lines for better
supervision and clarity) and a status bar (at the bottom of the window) where helpful
information appear depending on the position in the spread sheet we are in. Since the
spread sheet contains usually a lot of information and is the core of the calculations in
each application, it is particularly useful to have it maximized on screen by clicking on the
upper arrow (located at top right of the window), so that the whole computer screen area
is utilized. Next section will familiarise you with the “Calculation Sheet”, as the basic
functions described therein hold good for every application.
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Furthermore, the Calculation Sheet provides you with all the editing functions, which are
described below:

First of all, as stated earlier, you can use in the frames where the Calculation Sheets
appear the "Font" option for both the calculations zone (so that values appear with the
desired size and style) and the headings zone (so that headings are shown to your
satisfaction).

As far as the headings zone is concerned you can also increase or decrease the column
width using the mouse: As long as the mouse pointer rests on the vertical line separating
two adjacent columns, it takes the form of a double arrow and then by pressing (and
keeping pressed) the left mouse button and dragging, the column width is increased or
decreased depending on the direction of mouse movement. In the spread sheet below we
can see columns having different widths:

-
44+ Air-Ducts - [FATMP\BIKY\8_3_BUILDING.ELD] - [Calculation Sheet] = | B S
ﬁ"EiIes Project Data  Calculation Sheet  Edit  View Windows Libraries Help - ||& || %

=0 I JIESNEE IS IE ) ] 4@

Bl 7 ulll=l===%- A-|ad o |- q || oo |-

P L Cis i o I
Metwork (Conditioned [Space |Temperature |AirFlow |Duct |Duct Fric.Drop  |Air Type Fittings |AirDuct =
Section |Space Loads |Difference (ma3ih) Leng. |Cr.Sect perm. Welocity |of Fr.Drop |Fri.Dro|

(Mcalfh) (*C) (m) |{cm2) (mmW.G/m)(m/s) |Fitt (MmMWG) | (mmi

4 |5 8229 3.00 5125 0.05 6.00 2 3.09 0.16

5 5.6 5486 300 3125 0.07 5.00 2 3.09 0.20

5 |67 2743 375 1500 0.08 552 F-2 485 072

7 7.8 1042 1.26 7500 0.08 434 2 1.61 0.10

2 (39 52 1.56  9.00 597.7 572 500.0 0.08 378 F-3 1.08 0.47

q .10 5.4 1.16 9.00 444 4 283 3750 0.08 3.50 g 0.38 0.23

10 [7.11 1701 234 1000 0.08 4.90 2 2.08 0.19

11 1112 5.5 1.30 9.00 4881 427 3750 0.08 3.62 1 0.438 0.36

12 1113 51 314 9.00 1203 196 [750.0 0.08 4.49 3 0.62 0.16

13 [6.14 2743 575 1500 0.08 5.52 F-1 373 0.45

14 [14.15 1042 1.26 [750.0 0.08 434 2 1.61 0.10

15 [15.16 4.2 1.568 9.00 5977 572 5000 0.08 378 F-3 1.08 0.47 -

4 1 b
11 View Metwork Section

Above, alternative supervision possibilities available to the user depend on several factors
such as the resolution of the graphics card and screen size, and for this reason any
possible interventions are left your discretion. For that matter, there is also the possibility
of “Load Prototype” from you. Note however, that best supervision results are achieved
with higher resolutions and large screens..

Access to the positions of the zone for filling in values is carried out by means of the
mouse and the arrow keys of the keyboard. Moving the mouse pointer in the zone for
filling in values we can see that in some columns the pointer takes the form of a vertical
line (]) while in other columns it takes the form of a prohibitive traffic sign. We cannot
modify the values contained in these last columns (because they result from calculations).

If we move the mouse pointer (having the form of a cross) in to a cell or small square and
click the left mouse button, we’'ll see that the cell contour (outline) becomes dark and we
can fill in a value or modify the cell content. In the same way we can move to any other
cell, or using the <Enter> key we move to the next cell below and using the <Tab> key
we move to the next cell at the right and so on. Besides, in case the window width is not
large enough to accommodate all columns, we can review the entire calculation sheet by
manipulating it up-down or left-right using the vertically or horizontally sliding keys. In
addition, when access to a column for filling values is denied the mouse pointer takes the
form of a prohibitive traffic sign. This way, the user is informed that the quantity under
examination is a derivative one i.e. resulted automatically from calculations.
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The user should keep in mind the following useful commands when entering values in
the Calculation Sheets of any application:

Deleting cell content: Pressing the <Del> key on a cell, the value it contains is deleted,
and the cell is blank.

Deleting a row: Pressing the keys <CtrI>&<Del> in combination, the row we are in is
deleted.

Inserting a row: Pressing the keys <CtrI>&<Ins> in combination, a new (blank) row is
inserted immediately below the cell we are in.

Moving to the beginning of a row: Pressing the <Home> key we move automatically in
the first column of the row we are in.

Moving to the end of a row: Pressing the <End> key we move automatically in the last
column of the row we are in.

Moving to the upper part of the sheet (first column-first row): Pressing the keys
<Ctrl>&<PgUp> in combination, we automatically move in the first column-first row of the
calculation sheet.

Moving to the lower part of the sheet (first column-last row): Pressing the keys
<Ctrl>&<PgDn> in combination, we automatically move in the last row of the calculation
sheet.

Finally, you can move from an upper to a lower cell using the <Enter> key and from a
left cell to a right cell using the <Tab> key.

In addition, the calculation sheet provides you with a set of Spreadsheet Functions,
which are available in most windows applications, such as the Cut-Copy-Paste type of
commands of a subset of lines (or even the whole calculation sheet), the row and columns
width definition, the font type (as well as font attributes, justification etc) of a selected
area, and so on. The various functionality options are described in detail within the User’s
Guide. Further to the calculation sheet, each application has additional windows with
complementary results (e.g. “Bill of Material — Costing” Window, “Technical Description”
Window etc.). The “forms” of these windows are described shortly below.

3.1.4.2 Bill of Materials -Costing

The “Bill of Materials - Costing” window is found in all applications related directly to an
installation (e.g. Single Pipe System, Fan Coils etc.). This window comprises, in a table,
the materials of the specific installation together with the quantities resulting from the
calculation sheet and corresponding library values.

% Twin Pipes System - [FATMP\BIKY\8 3 BUILDING.BLD) - [Bill of Materials - Costing] o e
%t Files ProjectData View Bill of Materials - Costing Windows Libraries Help _=]x
BN SIS S = EHE S AR
B I U :} Sy - A -|Aral 5 | FTTr
CIFAle) ey

No Description Un.Pr. Quant. Disc. VAT T.Price -
% i

FIPES

Steel Pipes 1/2° 400 196.96 5.00 230 92059
Steel Pipes 3/4” 500 2621 5.00 230 15316
Steel Pipes 17 200 6.00 5.00 230 14.02
Steel Pipes 1.25" 500 10.00 5.00 230 5843

“"‘“‘““"‘|“|“|“‘”

FITTINGS

E

Radiator 150.00 20,00 10.00 230 3321.00
Bend 90 degrees 5.00 70.00 10.00 230 387.45
Tee 90 deg. opposite flows 200 48.00 10.00 230 101.84
Gate Valve 300 40.00 10.00 230 132.84

i

o

=

&

‘ ‘ | ‘ ‘5059.33 il
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Materials are listed as items (e.g. pipes, flttlngs etc) in the rows of the table, while the

table columns contain information such as "unit
price", "quantity", "discount %", "VAT" and
"Total Price". Calculations are performed
automatically and the results appear in the last
column. You can edit the bill of materials-
costing table in a similar way as for the
calculations sheet. When the "Bill of Materials"
window is active, then the option with the title
name appears in the main menu together with
the two secondary options "Offer Parameters"
and "Printing Parameters" providing more
options to the user.

3.1.4.3 Technical Description

Prlntlng Parameters

S

{’

| Frame Texts | Frame | Pagination | Prototype

Print with ...
_) Current Mode

@ Saved Prototype

Prototype

|Arial & Tiles 6

7

[ RTF Prototype Selection...

[ Save... J [ Ok ]

[ Load. | [ cancel |

The “Technical Description” window supports composition of the project’s technical

description, allowing selection of different | prototype Selection

EE)

technical description prototypes with all
word processing features available, as
we will see below, and free configuration

of new prototypes according to the user || saved

File Mame

DSOLTP

Mame

desire. 01 Technical Description

Making the selection “Technical
Description” the corresponding title
window in yellow background appears
updated with the project’s results (where
word-parameters  exist). When the
Technical Description  window is
activated, an additional option in the main
menu (just above the “Windows” option)
is appeared with the name “Technical

Delete

Description”. Choosing “Prototype

Selection” from this menu the prototype management window will appear on our screen.

Selecting the corresponding prototype (with the help of the mouse and using the “Load”
key), the corresponding text appears in the Technical description window (also in yellow
background and with updated results of the project).
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Ft Twin Pipes System - [FATMPBIKY\8_3_BUILDING.BLD] - [Technical Description] = | B 2

%t Files Project Data View Technical Description Windows Libraries Help
NEEIEN HEED R P DT
ETE| %é_%| (& A ] arial ) ETO I | P
Elrsle) Ele)
] IE ------ I T e A T & o
TECHNICAL REPORT OF TWO-PIPE HEATING INSTALLATION =
Master : Tom Smith f Prototype Selection &11
7 File Name Mame
Project : Centar Heating| | psoLtp
. Save As
" Location - Jonhson Avenul | Saved
4 - 01 Technical Description Delete
' Date 12471172012
. Designer - Tom Smith
™ Remarks
' 1.GENERAL
. . Load
. For this study the value of 20 °C was
-~ corresponding outdoor temperature of Exit
The total building thermal heating [0St
- Theintake (supply) water temperature is equal to t =85 °C.

If we choose to modify an existing prototype in any way (even re-writing a description from
scratch), we can easily save it using the “Save As” button after giving it a name at the top
right and a two-digit number (as done for the “Printing Prototypes”). Also we can easily
delete a prototype using the “Delete” button.

In general, as stated earlier, a technical description prototype comprises not only text but
word-parameters (in square brackets) as well. With the help of these word-parameters,
you can pass values to technical description prototypes since the word-parameters are
automatically replaced by the values calculated in the project we work with (for example,
the word-parameter [BOILER POWER] found in the technical description text for the Two
Pipes System is automatically replaced by the thermal power value calculated in the
project, e.g. 35.000 Kcal/h).

Any desired modification in the technical description of the project, either by changing the
position of a word-parameter or processing the text the way we want to, can be done by
pressing the "Edit Prototype" icon. There is, also, the "Edit Text" icon used for further
processing of the final text.

3.1.4.4 Assumptions (methodology)

All applications, in the window "Assumptions"” include text of the general Assumptions of
the project issue, which may be included to the printing of the project as long as it is
selected in the "Printing Contents". Assumptions function is quite similar to the Technical
Description providing alternative prototypes.

-42 - FINE - HVAC



3.1.4.5 Cover Page (of the project issue)

The “Cover Page” window is the first page of the project that is printed and the program
enables you to select between different types of cover pages, or even to create your own
cover page. Its function is similar to this of the Technical Description, providing alternative
prototypes.

-
G Twin Pipes System - [FATMP\BIKY\8_3_BUILDING.BLD] - [Cover Page] = |8 BS

F Files Project Data View CoverPage Windows Libraries Help

J[3[e) (IS (@[l B ko)l il

E. My | A __farial -0 o 100% > Twin Pipes Heating System Calculations

HEATING

Twin Pipes System Calculations

Prototype Selection
. File Hame Mame
: psocy
% Saved
01 Simple - Left Alignment Delete

Employer - Tom Smith

Project Centar Heating
: Location Jonhson Avenue 24
: Date © 24/11/2012 Load
) Project Manager : Tom Smith
. - Exit

3.1.4.6 Text Editing-Word Processor

Fine HVAC contains a build-in Word Processor with advanced functions (just as MS
Word), in order for you to have all the needed management and editing tools. On this
word processor the program’s report generator is based, as well. Particularly, in each
case the text-editing program is selected through the relevant icons and then the menu of
the text-editing program replaces the application menu, which covers all the upper
part of the screen.
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Z Twin Pipes System - [FATMP\BIKY\8_3_BUILDING.BLD] =ARC X
Files  Edit |!|ew| Insert Font Paragraph Table Other Options

[ e i [¢] BogeMoce | 20 Bl (sula
B 7 1 [k A ~|Arial -1 |- 100% - Twin Pipes Heating System Calculations =
-

@Ii Toolbars »

s Paragraph Marker

EH|3=|3

Hidden Text

-0 R R s s e R St

Field names b
Hyperlink Cursor
1.IN Page Header - Footer

Page Bord
. This e 4 N 4701 methodology. Furthermore, the following literature was also used:
. Zoom In
i) Enaererungenzuromwarutro3, mit Beispielen, Wermner-Verlag
i) Recknagel-Sprenger, Taschenbuch fuer Heizung und Klimatechnik,
i) Rietschel, Raiss, Heiz und Kiimatechnik, Springer-Veriag
iv) DIN Standards

2. ASSUMPTIONS & RULES OF CALCULATION

The choice of pipe size in every pipe-network segment is based on the following assumptions:

~ &) The water supply in the pipes that connect to the radiators is designated by the ratio of load over
temperature drop:

q
G=

At
Where:

G:  water flow (I/h)

The option groups of the text editing program consist of the following: "Files", "Edit",
"View", "Insert", "Font”, "Paragraph”, "Table" and "Other options". In detail, the commands
of the text-editing program are divided in the groups Editing Commands (Cut, Copy,
Paste, Delete, Paste Special, Edit Picture, Undo, Redo, Select All, Repaginate etc.), View
Commands (Page Mode, Fitted View, Ruler, Tool Bar, Zoom etc.), Insert (Add)
Commands (Insert Break, Page Break, Section Break, Column Break, Embed Picture,
Link Picture, Ole Object etc.), Font Commands (Normal, Bold, Underline, Italic,
Superscript, Text Colour etc), Paragraph Commands (Normal, Centre, Justify, Indent
Left, Border and Shading, Bullet, Numbering, Set Tab etc.), Table Commands (Insert
Table, Insert Row, Merge Cells, Header Row, Cell Vertical Align etc) and More Options
(Search, Replace, Snap to Grid, Background Picture etc.). All those commands are
mentioned within the Users’ Guide.

Besides, when the text-editing program is "active", there is a "ruler" in the upper part of
the text window, which shows the distances with the "guides" and the tab symbols.

Iﬂ[‘é|.1.|.2,_|.3.|.4.|.5.|.5.|.;a.J_.s.|.g.|.1n.|.11.|.12.|.13.|.14.|.15.J.B

In general whatever applies to Word applies here too. In order to exit the Word Processor
and return to the previous desktop, you select "Exit" in the first menu under "File".

As mentioned before, the Report Generator of the program is based on the above
described word processor. In order to define a report, you have to insert the variables
(parameters) of any application in the right position into the text (i.e. under the titles). For
example the parameter "net_sec" should be placed under the title “Branch of Network”. All
these parameters take automatically the exact values that have been calculated by the
program. More information about how to create a new output, or edit an existing one, as
well as about the printing outputs you defined is shown in the user’s guide.
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3.1.4.7 Vertical Diagram

This instruction serves only if you want to take a vertical diagram through the calculation
sheet, by filling properly the polar coordinates for each branch. In this case a rough
network drawing diagram is also provided by the program. In the (strongly recommended)
case that the network has been designed on AutoNET, the vertical diagram is
automatically created.

%t Twin Pipes System - [FATMP\BIKY\8_3_BUILDING.BLD] = | B S,
Files Project Data View Wertical Diagram Windows Libraries Help

DS d|lS &) iGl=lm  iES)E | | %]

‘Bz E =]=] [ ta vII A Arial o k) - g#|CE|  i|Twin Pipes Heating System Calculations -

b ) L K

f Calculation Sheet "

Metwork |Pipe |Radiator |Temperature |Water Des. |Pipe Max |Water Type |Fittings|Pipes |Total Polar |Heated|Space |[F
Section |LengtiLoads Difference Flow Pipe |Size Vel [Velocity of Fr.Drop{Friction |Friction |Angle |Space |Loads |T
(m) |(Mcallh) |(*C) (m3/Mh) |Size (mis) |(mis) Fitt. (mWG)|Drop  [Loss ) (Mcalfh)
(MWG) [(m.W.G.

1 1.2 32.70 0.6 F-1

2 (23 1538 0.6 F-2

3 (34 14.85 0.6 F-3

45 P50 3 Vertical Diagram ===

5 56 25.35 '

5 [67 11.00

7 |78 9.735 =

g [79 0.335

g (610 0.335

10 [5.11 0.165

11 412 0.165 .

12 313 0.335 .

13 214 6.000 . |

14 [14.15 1538

15 [15.16 14.85 E]'.‘ ﬁ

16 [16.17 G.850 .

17 [17.18 2535

18 [18.19 11.00

19 [19.20 9735

20 [19.21 0.335

21 [1822 0335

22 [1723 D165 : -
q m _ b

11 View MNetwork Section (eg. 1.2)

3.1.5 Libraries

Libraries include materials and equipment related to each application.

3.1.6 Help

Help support follows the usual windows standards.
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3.2 Heating

The Heating part consists of four applications which function either independently or in
conjunction with each other and/or the Fine HVAC Component. These applications are
listed below:

Thermal Losses: Heat losses are calculated in each building floor and room. This
procedure usually comprises the first step of a heating project.

Two Pipes System: All the necessary calculations for the installation of a Two Pipe
Heating System are made and the required equipment is selected (radiators, pipes,
boiler, burner, circulator, safety device, tank, chimney etc.).

Single Pipe System: All the necessary calculations for the installation of a Single Pipe
Heating System are made and the required equipment is selected (radiators, pipes,
boiler, burner, circulator, safety device, tank, chimney etc.).

Infloor Heating System: All the necessary calculations for the installation of an Infloor
System are made and the required equipment is selected (radiators, pipes, boiler,
burner, circulator, safety device, tank, chimney etc.).
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3.2.1 Thermal Losses

e

By executing the Thermal Losses [Ermos rrecemioneis =

application, the main menu screen e R "‘jg%‘ R B
appears, including the main menu | ;. u==== 52~ -0 -
options “Files", "Project Data", "View", || @@az (= (@

“Windows”, "Libraries" and "Help".

“Files”, “View” and “Help” and most of e e N S el

the other options are following the
rules described in the previous
section. The rest is described in short A A v A A
in the following paragraphs.

3.2.1.1 Project Data

There are three basic data categories of the project: Project info, Building parameters and
Structural elements. When “Building parameters” is selected, a window appears
presenting a list of items concerning mainly the building and some additional data. These
items and the values which should be given to them are explained right below, exactly in
the same order in which they appear in the window:

1) Building parameters tab

City: Select from the list that opens (by pressing F11 or the appropriate button into the
field) the city you want (you can add and use your own cities in Libraries -> Outer
Winter Temperatures).

Mean minimum outside temperature (°C): You can see (by pressing F11 or the
appropriate button into the field) the library list containing climatologic data for the
cities, and either select a value from it or type directly the desired temperature value.

Desired Indoor temperature (°C): You select from the list or type the more typical
indoor temperature, in case there are more than one value. This value can be
selectively edited in the fields of the spaces where a different temperature is required.

Not-heated spaces temperature (°C): The temperature of the building spaces which
are not heated (e.g. staircase) should be typed in this field.

Soil temperature (°C): The soil temperature should be typed in this field.

Annual mean external temperature (°C): You can see (by pressing F11 or the
appropriate button into the field) the library list containing climatologic data for the
cities, and either select a value from it or type directly the desired temperature value.

Calculation Methodology: You have the option to choose between the older (1977)
or the newer (1983) DIN standard, the European norm EN12831 or the American
ASHRAE method.

Default space increment (%): This value is used only in the case of non-automatic
increase calculations (see last option), as it is simply stated for every room, can be
selectively modified by the user.

Number of levels (floors): You define the number of the levels of the building.

Default height (m): You type a default height for each level. This value can be
selectively edited in the fields of the spaces where is required.

Energy units: You have the option to choose between Kcal/h or Watts for the results.
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¢ Floor on the ground level: The number of the floor which is on the ground level (e.g.
2nd floor) must be filled, so that the floor distances and, therefore, the rift increase due
to height (DIN 1983) can be automatically calculated.

e Heating system efficiency factor: You type the efficiency factor of the heating
system.

¢ Air exchange rate/hour: You select (by pressing F11 or the appropriate button into
the field) the number of air exchanges per hour depending on the type of the room or
type it directly. This value can be selectively edited in the fields of the spaces where is
required.

¢ Rotation angle: If you want to change the orientation of the building, you can rotate it
to a specific angle through selecting it from the list that opens.

2) DIN 77-83 tab
This tab is completed if you want to use the DIN77 or DIN83 methodology.

¢ Building characteristic number Hy: It depends on how much the building is exposed
to winds (see auxiliary table).

¢ Shut-Down period: One of the 3 options should be selected: "0 break hours", "8-12
break hours" or "12-16 break hours".

e Space characteristic number R: Depending on the ratio of the internal to external
openings, an auxiliary table, based on the selected DIN, appears.

¢ Automatic Increment Calculations: By checking the box, the increase percentage is
automatically modified in every room in combination with the above selected DIN.
Therefore, the increase percentage due to exposure, breaks and walls will be
displayed analytically for each space.

3) EN 12831 tab
This tab is completed if you want to use the EN12831 methodology.
¢ Floor slab depth (m): If the floor slab is beneath ground level, you type its depth.

¢ Area of floor slab (m?): You type the area of the considered floor slab. For a whole
building, it is the total ground floor area. For part of a building, it is the ground floor
area under consideration.

e Perimeter of floor slab (m): You type the perimeter of the considered floor slab. For
a whole building, it is the total perimeter. For part of a building, it includes only the
length of external walls separating the heated spaces under consideration from
external environment.

e Building volume (m?3): You fill in the volume of the building.

¢ Building exhaust air flow rate Vex (m?®h): If there is ventilation system in the
building, in this cell you fill in the exhaust air flow rate.

¢ Building supply air flow rate Vsu (m?h): If there is ventilation system in the building,
in this cell you fill in the supply air flow rate.

e Correction factor for influence from annual variation of external temperature
fg1: You type a value for the correction factor taking into account the influence from
annual variation of external temperature. Default value is 1.45.

e Correction factor for influence from ground water Gw: You select a value for the
correction factor, taking into account the influence from ground water. Default values
are either “1” if the distance between the assumed water table and the floor slab is
more than 1 m, or “1.15” if the distance is less than 1 m.
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Air exchange rate/hour at 50 Pa: You select (by pressing F11 or the appropriate
button into the field) or type directly the air exchange rate at 50 Pa pressure difference
between inside and outside per hour.

Shielding coefficient ei: You select (by pressing F11 or the appropriate button into
the field) or type directly the shielding coefficient depending on the exposure of the
building.

Supply air temperature tsu: You type the supply air temperature into the heated
space (either from the central air heating system, from a neighbouring heated or
unheated space or from the external environment). This value can be selectively
edited in the fields of the spaces where is required.

Calculation of reheating: In case there is a reheating system in the building, you
check this box.

Correction factor for reheating: You select (by pressing F11 or the appropriate
button into the field) or type directly the correction factor for reheating which depends
on the reheat time and the assumed drop of the internal temperature during setback.

Ceiling height correction >5m: For buildings with ceilings which have a height
greater that 5 m, you check this box.

Ceiling height correction factor fh,i: For buildings with design heat losses <60 W/m?
of floor area, for spaces with high ceilings a correction factor is used. You select (by
pressing F11 or the appropriate button into the field) the correction factor depending
on the height of the heated space.

Efficiency of heat recovery system nv: In case there is a heat recovery system, you
type its efficiency on exhaust air.

3.2.1.2 Structural Elements

This term is used to describe some of the usual types of the building structural elements,
which are summarized in the respective window:

f Structural Elements Lﬁr
Quter walls | InnerWalls Roofs Floos Openings
Outer Walls  |Description Outer Walls -
U Factor
(Kcal/m*hc)
1 W1 Cuter Wall 4 cm insulation  0.55
2 W2 Outer Wall 1 0.6
3 W3 Outer Wall 3 0.58
4 W4 Cuter Wall 4 1.28
5 Wa Outer Wall & 0.45
6 W6 Outer Wall 15 2.00
7 W7 Cuter Wall 10 0.56
8 Ve Outer Wall 12 0.55
9 W9 Outer Wall 21 0.57
10 W10 External Wall 0.430
1 Wi External Beam 0.444
12 W12 External Columns 0.444
13 W13
14 W14
15 W14 o
1.1 InAccessible

As shown in the window, the following structural element classification can be defined:
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o External Walls (W1, W2, etc): The thermal conductivity coefficient k can be typed
either independently or by selecting one of the walls from the respective column of the
list which appears when the appropriate button into the field is pressed.

rﬂﬁ External Wall Types ﬁ‘
2l #h
No Description Coefficient - Selection
4 1|Outer Wall -4 cm insulation  |0.55 |
2 Outer wall 155 3

B 3 Quter Wall Gcm Air Space 1.7

B 4/ Outer wall 1 0.6

| 5/ Outer Wall 2 14

B B/ Outer Wall 3 0.58

B 7| Outer wall 4 1.28

B 8/ Outer wall 5 0.45

B 9/ Outer wall 6 1.25

| 10| Outer Wall 7 0.47

In fact, this list contains the external wall library, which can be updated by the user
through the respective secondary option under "Libraries".

e Internal Walls (I1, 12, etc): The thermal conductivity coefficient k is typed in the same
way as for the external walls (if the appropriate button into the field is pressed, another
auxiliary table with the internal walls saved in the library appears, from which a wall
can be selected).

e Floors (F1, F2 etc.): The thermal conductivity coefficient k is typed (if the appropriate
button into the field is pressed, an auxiliary table with the library floors appears, from
which a floor can be selected).

¢ Ceilings (or Roofs) (C1, C2 etc.): The thermal conductivity coefficient k is typed (if
the appropriate button into the field is pressed, an auxiliary table with the library
ceilings appears, from which a ceiling can be selected).

e Openings (01, 02 etc.): You can type the opening dimensions (width, height), the
- ;

thermal ConductiVity [ Opening Types
coefficient k (if or 51 @
:)hett . ?pa:]oprflatg Mo Description Coefficient o Selection

utton Into the T1ie 3 1|Reg. Glass (Wood.Frame) 45 =
is pressed, the ] 2 Reg. Glass (Metal Frame) 5.0
auxiliary ||brary N 3/Reg. Absor. Glass (Wood.Frame) 45

4 Reg. Absor. Glass (Meta.Frame) 50
tab_le app?ars’ from A 5 D.Glass 6 mm Air Space (W.Fr) 28
which a window can | 6 D.Glass 6 mm Air Space (l.Fr) 32
be directly n 7/D.Glass 12 mm Air Space (W.Fr) 2.6
SeleCted), the air a 8 D.Glass 12 mm Air Space (M.Fr) 30 -
penetration
coefficient a
— =—

(infiltration) and the
sheets number (one, two etc.). The data which will remain blank can be filled in later
within the losses calculation sheet.

3.2.1.3 Thermal Losses Calculation Sheet

The calculation sheets for space losses are included in the respective

building floor sheets. If you select one of the floors, a list will appear *=
containing the respective losses sheets for the floor spaces along with

their management toolbar:
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-
[ Thermal losses - [FATMP\BIKY\8_3_BUILDING ELD]

Files ProjectData View Calculation Sheet Windows Libraries Help

HnEIE = N B

B s m@® 9o

x

s Qg Third Floor

] T

‘B I U ‘E == | Iy - é o |Aria| ~[10 |+ f Stuctural Elements -
B Thermal Losses Calculation Sheet oo =
Level - Spaces - Losses
"Easement Surface |Orientation |Subtracted Thicknnes{Length |Height or |Surface |Equal -
. - Type (m} Width (m2, Surface
' Ground Floor B iy Rumper ||
% 1 Living Room 2474
1 W2 MY 620 3.00 16.60 1
-4 2 Bedroom 1 1216 E
%' 3 Bathroom 843 2 o1 NV S 100 220 220 1
- 4 Bedroom 2 790 3 o1 NV S 100 120 120 1
- 5 Kitchen 1746 4 W7 NV S 620 030 186 1
2 Qg First Floor L 5 W2 = 6.65 3.00 19.95 1 -
- 1 Living Room 2878 |= a n ] b
' 2 Bedroom 1 1429 Z
.‘. P i A . Ny Wl ]
=y 3 Bathroom 397 i Drientaton inerement {36} Length im} ~rolaiThermaliosses
%y 4 Bedroom 2 790 Shut - Down Increment (% Width (m) Increments
S/ 5 Kitchen 1916 Des. Increment (%) Height (m) Final Thermal Losses
4 .‘ﬁ'ciﬂdLsil:'\ugrRoom 2069 Coef. Rorr Ajr Changesth Losses due to Opening S
‘ 2 Bedroom 1 1643 Coeff. H Property Losses due to air change
g‘ 3 Bathroom 770 Coeff. ZC “Main Pipe. Circuit” Total Space Losses
-/ 4 Bedroom 2 1033 Radiator No
g 5§ Kitchen 1746

&

¥l

When a new project is created this list is blank. When you enter this list (with the mouse)
and click the icon (with the “+” sign on the lower side) in the menu or press the key <Ins>,
a small window appears, where the name of the desired space should be typed (e.g.
Kitchen, Bathroom etc.). If you press “OK” this space Enters the list and all you have to
do is type the space dimensions in the thermal losses sheet. In the same way, if you click
the icon Delete Space (with the “x“ sign) or even press <Del> on the keyboard, after
selecting the name of the space, the specific space is deleted. By pressing <CtrI>&<I> or
clicking the icon of insertion (with the “+” sign in the middle) a new space is inserted.

3 Thermal losses - [FATMP\BIKY\B_3_BUILDING.BLD] - [Thermal Losses Calculation Sheet] [E=HEEn =)
[ Files ProjectData View Calculation Sheet Windows Libraries Help [=]&[=]
B EE N PN E RN S R IR EIE HEE e
‘B 7 O |§ == | Syl A v |Aria| »|10  |=| i Structural Elements v
Level - Spaces - Losses
" Surface |Orientation | Subtracted |ThicknnesiLength |Height or |Surface (Equal Total Subtracte: »
‘ Basement 4| Type (m) l(N’n)ith (m2) ﬁurfaca S‘Eﬂ‘rzf?ce E\ﬂré:}i l:l
4 g Ground Floor m Lo
- 1 Living Room 2474
1 W2 NV 6.20 3.00 18.60 1 18.60 5.26
% 2 Bedroom 1 1218 5 (=]
%' 3 Bathroom 843 o1 NW s 100 220 220 A 220
" 4 Bedroom 2 790 3 01 NW s 1.00 120 120 N1 1.20
- 5 Kitchen 1746 4 W7 NV S 6.20 0.30 1.86 1 1.86
2 R First Floor 5 w2 sSwW 6.65 3.00 19.95 1 19.95 530
t1 Living Room 2878 5 oo sw s 150 220 330 1 330
'y 2 Bedroom 1 1429
7 W7 SwW S 665 030 200 0 2.00
& 2 Bathroom 917 o
. 4 Bedroom 2 790 |z |t it
& 5 Kitchen 1918 H B 0 \ v
4 g Second Floor
&1 LivingRoam 2069 [ TR REeReR S [ Length (m) [ie] [ TromImhemallosse g
" 2 Bedroom 1 1643 Shut - Down Increment (%) | 30 Width (m) 1 Increments 35
-%' 3 Bathroom 770 Des. Increment (%) 35 Height (m) 3 Final Thermal Losses 13
‘I 4 Bedroom 2 1033 Coef Rorr 0t Air Changes/h 1 Losses due to Opening Siots| 29
' 5 Kitchen 1746 5
a -"Third Flaor Coeff. H 0. Property Losses due to air changes |80
--" 1 Living Room 2878 Coeff. ZC 1 “Main Pipe. Circuit” Total Space Losses 24
tz Bedroom 1 1429 Radiator No
'y 3 Bathroom 917 —
' 4 Bedroom 2 912 _
< [ S— T

To every space (left) corresponds a Losses Sheet (right), where up to 60 different

structural elements can be inserted and which can be separated in two parts:
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On the upper part, each row of the losses sheet corresponds to a structural element
while each column refers to the data which are going to be inserted or are going to result
automatically during the process of the sheet completion. Instructions about entering
these data are displayed in the status bar. For each row, the first column which refers to
some type of structural element should be filled first. If a typical element is concerned, the
corresponding data of the building typical data sheet are automatically filled.

For each row-structural element the following must be defined: The orientation, the
indication "Subtracted" (by S) since it considers an element that can be removed from the
element just above this one (such as windows, columns and beams), the thickness
(optional), the length and the height of the structural element, the number of similar
surfaces, the thermal conductivity coefficient and the temperature difference. The
openings are removed automatically under the following conditions:

e The openings must be entered under the walls to which they belong.

e A common orientation should be entered for the openings and the respective walls (or
"I"if it is about internal openings on internal walls (non heated), "H" for horizontal
openings/skylights, "P" for Pilotis Roof - attention for Pilotis you enter Ceiling, e.g. C1
and not Floor).

e The indication "S" (Subtracted) should exist in the correspondent column (for the
openings it is inserted automatically at the beginning).

Note: For Floors that are adjacent to the ground you do not fill in the second column,
while when the Floor is above a non heated space you fill "I". For Roof to external space
(or openings on the roof) you enter "C", to internal "I" and to pilotis "P".

On the bottom side of the screen appear data which refer to the overall sheet: These are
the total increase, the losses due to slots or air changes, the total losses due to thermal
conductivity and the total space losses, as well as some additional data that are used as a
link to the applications of Cost Distribution and Single Pipe System. All these data are
organized in 3 columns, the first two of which refer to parameters and the third to total
results about the space. Keep in mind that depending on the methodology selection you
make in the “Building Parameters”, different data are shown. More specifically, if you
select, for example, the DIN methodology:

In the first column appear the increase percentages due to exposure and breaks, as well
as the desired increase percentage which can be modified. The total increase percentage
automatically becomes equal to the value  grientation increment %) =

that exists on the general data sheet, which

Shut - Down Increment (%) |30

can be modified by the user. You can be — F:‘E |
based either on your judgement, or on the oot R s
gel.Raorr A

method (DIN) increase value. The last one
is displayed on the right side in brackets  CesffH 0.60
depending on the selected methodology  Coeff.ZC 1
and consists of two components: The

increase due to exposure Zy and the

general increase Zp due to breaks (Zy) and Cold Walls (Za) (Zp=Zy+Za).

Lower on the first column, the values R, H and Z are shown that are typed under the
“Building Parameters”. These values are taken into consideration automatically for the
calculation of the losses due to slots, losses that are displayed in the middle of the 3™
column.
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You can interfere to the calculation as you can change the values R (or r), H and Zr. In
the case of the DIN83 the coefficient H is increased automatically when the height is over
10 meters using the factor ega. If any of these values are zero, the losses due to slots are
also zero, which must be performed when there is forced ventilation (therefore the space
is over pressurised).

In the second column, the space dimensions which are on the upper part (Length,

Width, Height) are used for the calculation of the = Length(m (=5
adjacent surface (for the calculation of the increase  with m 1
due to breaks) and the losses due to air changes.  Heigntim 3.00

The calculation of the latter is performed as long as A Changesi 1
the number of changes per hour is entered in the  Property

row right below. “Main Pipe. Circut’

Below you can fill the symbolic name of the adEborie

Property (e.g. 1A, 1B, A1, 1IS or any other name you wish).

The circuit topology (to enable linking to the Single Pipe System program) can be defined
in the last two rows. Specifically, it is necessary to insert two numbers:

e The number of the vertical pipe and the circuit which passes through the specific space
(number the circuits by level and vertical pipes starting from 1). For example, if the first
vertical pipe of the building and the second circuit of the vertical pipe pass through the
specific space, you should type 1.2 in the specific level.

e The radiator serial number in the circuit (number the radiators in each circuit starting
from 1). If there is more than one radiator in the same space, their serial number is
inserted with a full stop (e.g. 1.2 or 2.4 etc). Note that in case of a twin pipes system no
entering is required, because you can call the load of any space directly from there.

‘NO'[ES

In case two different circuits pass through one space, it is recommended to divide the
space in two parts (e.g. Living-room part A, Living-room part B) in order to define the
corresponding circuit in each part. If this is not possible, the user can interfere
afterwards to the Single Pipe System and make the required changes.

e In caseyou use the Fine HVAC and you have designed the circuits in the ground
plan, it is obvious that you do not need to fill the two previous fields since the
topology is given and the program takes it automatically into consideration.

Finally, in the third column, the total results of the space thermal losses are presented.
First of all, the Total Losses due to Thermal Conductivity are presented, that are the sum

of the losses in the last column of the losses sheet TaEiThemallassss 1015
(space losses). The absolute value of the increase, increments 355
which corresponds to the percentage of the increase of  FinaiThermal Losses 1
the first column, is presented below. The sum of the tWO  [4sses due to Opening Sits| 2
previous values provides the Final Losses due 10 |ossesducioarchanges 2024
Thermal Conductivity (Final Thermal Losses) which are . < ace gsses 5
displayed right below. After that, the space losses due to

Openings Slots and Ventilation are presented (only one

of them is provided with a value). Finally, the sum of all previous values of column 3,
which provides the Total Space Losses, is presented in the lower part.

Also, the program enables the copying of each floor or space to any other, through the
usual copy-paste window functionality.
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3.2.1.4 Circuits-Radiators-Properties

The window “Circuits-Radiators-Properties” presents a list of the building spaces with the
circuits-radiators which correspond to each space, as well as the properties to which they
belong. With the help of this window, you can control the above data and detect any
omissions. This window is extremely useful in case the program displays a message
about an “Unspecified Property” or “Incomplete Circuits” during the creation of the link files
Single Pipe System (or Infloor Heating System).

3.2.1.5 Overall Data of Losses

A list appears with the spaces per level and a number with their names and their losses,
as well as the side and total losses sums.

[ Overall Data of Losses E@

SPACES TOTAL THERMAL LOSSES (Kcalih)

Level : Basement

Total Level Thermal Losses 0

Level : Ground Floor

Living Room 2474
Bedroom 1 1216
Bathraom 843
Bedroom 2 790
Kitchen 1748

L NERY N

Total Level Thermal Losses 7069

Level : First Floor

3.2.1.6 Properties Thermal Losses

A list appears with the Properties and losses Qol, (Total, due to Openings and Slots
respectively).

[E Properties Thermal Losses EI@
PROPERTIES THERMAL LOSSES (Kcal/h) -
Property Qol

Al 5853
F1 3922
B1 5224
c1 6228
E1 3861
D1 5224

cnt_n-pmm_\g

3.2.1.7 Energy Analysis

The program has the ability of Energy Analysis by the Degree Day Method. Based on the
results of the thermal losses, the program calculates the annual energy consumption
required for the main cities based on the Degree Days (from weather data) which have
been measured for each city on annual basis and for defined temperature limits. These
data are in the "Libraries" and can be updated by the user.

3.2.1.8 Libraries

The libraries refer to structural element types, as well as to temperature data. They can be
easily updated by you and therefore you can enter your own data exactly as you desire.
The categories, to which the libraries of the Thermal Losses application are divided, are
described in the User’s Guide.
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3.2.2 Two Pipes System

By executing the Two Pipes Heating System application, the main menu screen appears,
including the options "Files", "Project Data", "View", “Windows”, "Libraries" and "Help".

” o«

“Files”, “View” and “Help”, as well as a part of the window sub-options (cover page,
assumptions, technical descriptions, bill of materials etc.) follow the usual windows
standards and the description provided in section 3.1. The rest are described in short in
the following paragraphs.

3.2.2.1 Project Data

This pertains to the project basic data, which are divided into Project info (project
headings) and Network data. Network data concern:

Inlet Water temperature: Enter the inlet water temperature in °C (the return
temperature is calculated automatically)

Radiators Temperature Drop: Enter the radiators temperature drop (usual value
Dt=15 °C).

Room temperature: Enter the room temperature (usually 20 degrees Celsius).

Main pipe type: Select the pipe type of the main pipes (e.g. copper pipe).

Main pipes roughness factor: Roughness factor is entered automatically, depending
on the pipe type selected, but you can easily modify it. The measurement unit used by
the program is um.

Secondary pipes type: Select the pipe type of the secondary pipes (in case two
types are used, e.g. copper pipe for the vertical pipes and plastic pipes for the
horizontal piping).

Secondary pipes roughness factor: The roughness factor is entered automatically,
depending on the pipe type you have selected, but you can easily modify it. The
measurement unit used by the program is ym.

Maximum water velocity: Enter the maximum desired water velocity limit (based on
which the cross-sections are calculated).

Friction limit (mwg/m): Enter the friction limit per length of the piping in mwg/m.

Number of circulators: In case you have more than one circulator, enter their
number here so as to be able to use them in the Calculation sheet and the Circulator
calculation.

Energy units: Select the unit system (Kcal/h or watt).

Expansion tank type: Select between open and — more often used — closed
expansion tank.

Temperature drop per meter: If you do not have ideally insulated pipes, enter in this
field the temperature drop per meter of the length of piping (in °C/m).

Chimney calculations according to EN 13384.01: If you check this box, you can
calculate the chimney according to the European norm EN 13384.01.

Building geodetic height in relation to sea level: Enter the geodetic height of the
building.

Analytical calculation of contained water in the system: If you check this box, you
can calculate in detail the contained water in the system.
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¢ Combi system: This box is checked when you have several boilers and circulators in
the network. In this case, you check this box and type the “Number of circulators” in
the same window so as to calculate them.

e Fuel Type: Select the fuel that is used (oil, natural gas, LPG etc.).

3.2.2.2 Calculation Sheet

Z Twin Pipes System - [FATMP\BIKY\8_3_BUIL DING.BLD] - [Calculation Sheet] = | B
- Files Project Data View Calculation Sheet Windows Libraries Help — &
NS IS i[f=am @ 9o & |G| @
B 7 U == = Sy -] A - |Arial - oo |4
- — - - -
[zl &ty
Metwoark |Pipe Radiator |Temperature|Water |Des. |Pipe Max |Water |Type |Fittings|Pipes |Total Polar |Heated| =
Section |Length |Loads Difference |Flow Pipe |Size Vel |Velocity [of [Fr.Drop{Friction |Friction |Angle [Space
(m} (Mcalih) [(*C) (m3/h) |Size (m/s) |(mis) |Fitt. [(mWG)Drop |Loss ()
(MWG) |(m.W.G.
1 .2 4 1.986 125 06 0545 F-1 0127 0041 0168
2 23 0.75 0.436 34" 06 0331 F-2 0034 0005 0.038
3 34 0.8 0.354 10z 06 0489 F-3 0083 0019 0101
4 |45 2 0.272 112" 06 0376 F-2 0043 0028 0072
5 (56 0.5 1.485 15 0.099 112" 06 0137 F-4 0009 0001 0.010
6 [B7 0.65 2,600 15 0173 112" 06 0239 F-5 0022 0004 0.026
i -
Fl [ 3
15 View Water Flow (m3/h)

|8

Following the standardization described earlier, each row of this sheet corresponds to a
different network section while each column refers to data that will be filled out or will
ensue automatically during the procedure of completing data.

The space load is taken immediately (by inserting the level and space number (e.g. 1.2)
provided that a link to losses has been established and the respective supply corresponds
to the total required supply for the space. If there is more than one radiator in the same
space, the designer should intervene by distributing the load accordingly. The respective
radiator is calculated for the radiator type selected through the library.

Based on the supply in each network section and given the maximum velocity that
corresponds to this section, the cross-section of the section pipe is established. Despite
all this, the designer may give another standardized diameter, by selecting (through the 6"
column) the list of standardized diameters from the library that appears on the screen. In

whatever way the section has been defined, the [ ring: s
effective water velocity and the pressure drops (see |[ systemno ,
respective columns) of the piping and fittings in the
respective section of the network will be exactly 24
calculated. The fittings are completed in each No | —hiame Coeiz | No | *

. . . e M Radiator 25 E
section separately, opening the respective fittings || 7, cogucer 05
window. i 3 Elbow 90 degrees 1.3

. . . 4 Elbow 45 degrees 0.4 !
At this point, the fitting numbers for each type of || 5/Bend 90 degrees 0.4
accessory must be given or their combination. ||| ] 6 Bend 45 degrees 0.3
There is also the option to assign an increasing || L 7|Tee S0 degrees |15
number system for the fittings (in the upper row) for ||| 27880 e cpposiies 2.
avoiding the repeated filling out of the same. ok | [ Cancel
In the case of typical (similar) sections it is possible

to recall them (with their name from the first
column) in order to automatically transfer them.
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Reverse - Return (Tichelmann or Three Pipes System) Network Calculations: Apart
from the classic Two Pipes System described above, there is the possibility to define a
reverse-return network, which is a network where inlet and return do not comprise entirely
parallel networks, but follow a different path. It is easy to define such a network
considering a second network like, the one described above, which junctions are
numbered differently. Note that in this case Radiators do not need numbering because
they are already numbered.

The options concerning the boiler-room equipment (Boiler, Burner, Circulator, etc) are
found in the menu “Windows”, below the calculation sheet.
3.2.2.3 Boiler - Heat pump selection

The "Total Thermal Load Q," is automatically updated with the calculation sheet data.
This field remains blank only if the calculations have not been completed or the junction
point 1 (start) of the network does not exist.

Zt Boiler Selection EI@

Boiler Selection

Total Thermal Load Qol (Mcal/h) 3031

Hot Water Storage Tank Load or other Loads (Mcalih) | 11.21

Safety Factor ZL 0.25

Boiler Output QL=(1 + ZL) Qtot (Mcal/h) 51.80

Type of Selected Boiler WOLF HK-2 60
Boiler Output 48.60-57.60Mcalh
Water Capacity 59

Boiler Dimensions 1052x850x620mm
Cost

If an increase safety factor (e.g. 0.25 for 25% increase) is inserted, the Boiler power is
properly calculated and you can select the type among the options of the library of boilers.

3.2.2.4 Burner — Fuel Tank calculations

The necessary data for the burner and the tank selection are typed in the drawing screen
and the Burner is selected from the library.

3.2.2.5 Circulator calculation

The program enables the designer to have several circulators. You can either simply
select a circulator or select a circulator for Reverse solution by selecting "Circulator
selection by Hydraulic Solution Method" (you select it in the “Type of selected circulator”
field). In this case, the program determines the intersection point of the network
characteristic curve with the nearer circulator curve (operation point), on which all the
other results (velocities, supplies, radiators etc.) are based. In the libraries a list of
different circulators is included.
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2 Circulator Calculation

[ = =

Circulator Selection
Circulator Mo 1
Wiater Flow Rate © {m3rh) 04877
Highest Pressure drop Section (mwG) 1.8
Metwork Friction Drop (WG 1.708 B
Friction Coefficient C (C=DP/Q2) of Boiler (mG)/{m3ih)2 0.0z
Friction Coefficient C (C=DP/Q2) of Three Way Valve (mWEIman)2 o.os
Friction Coefficient C (C=DPIQ2) of Non Return Valve {mWENHim3h)z 0.04 G
Friction Coefiicient C (C=DP/Q2) of Other Parts (miWG)im3ih)2 i
Head loss (WG 181 -
Type of Selected Circulator WILO Star RS Qi
Size 92 8x180x130 (rfg
Flow Rate 3.1 mh ]
Head loss 4.2 G %
Motor Power Cutput 22W
Electrical Data 0.284-230V-2 UU
Cost ] Flow Rate Q (n3/h

3.2.2.6 Expansion Tank and Chimney calculations

In order to select an Expansion Tank you should fill properly the parameters shown in the
dialog. The required volume comes up automatically and the effective volume finally
appears, if the dimensions (length, width, height) are typed in the following fields.

Regarding the Chimney, the program provides the option for very detailed calculations

through mathematical curves.

3.2.2.7 Network Drawing

The (numbered) network drawing is shown on the screen, provided that polar coordinates
have been inserted in every network branch (see calculation sheet).

E |

m

-
Ft Twin Pipes System - [FATMP\BIKY\8_3_BUILDING.BLD] =
Files Project Data View MNetwork Drawing Windows Libraries Help
e EE NS DY
EEE| EEI% I%| Loy -I‘ A -|=r|a| ~ 9 - SQ O;l @ @ \Q g A Twin Pipes Heating System Calculations
= Bl EARSY S
F Calculation Sheet [=][@] =]
Network [Pipe |Radiator |Temperature |Water |Des. |Pipe  [Max |Water Type |Fittings|Pipes |Total |Polar |Heated/Space |Radiator Entering »
Section |Lengti Loads Difference Flow Pipe |Size Vel. |Velocity of Fr.Drop|Friction |Friction [Angle [Space |Loads |Type Water
(m)  |(Mcal/h) |(°C) (m3/h) |Size (mis) |(mis) Fitt (mWG) Drop  |Loss ) (Mcal/h)y Temp.
(MWG) |(mW.G,| c)
1 1.2 3270 0.6 F-1
2 [23
2 3.4 Tt Network Drawing E\EI
4 |45 G| e e A et 8 Ll e M s e e s e e e e R B e e £
5 [5.6 4
5 [6.7
7 |78 25
g8 [79 as
g |[6.10 . 85
10 [5.11 > o8 85
11 412 35
12 [3.13 85
13 [2.14 g
14 [|14.15 1
15 [15.16 & Zc
16 [1617 A
17 1718 4
18 [18.19
19 [19.20 a5
20 (1921 a5
21 [|18.22 a5
20 [17.23 a5
23 [16.24 85
24 |15.25 as
25 [14.26 A
';" a M xl LW ] " r'r'|” L 0 2 el ’
16212 InAccessible Pipe Friction Drop (mWG)
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3.2.2.8 Vertical Diagram

If you want to create a vertical chart directly from the calculation sheet (and not
automatically, using Fine HVAC), the above option creates the vertical chart provided that
polar coordinates have been inserted in every network section.

B o Pipes Systers - [FATMPERONE 3 BURLOMG.BLD] =]
| Bles PrejectDats Wiew Virticsl Diagram Windows Librasies Help |
S MR ETE N = Y o
et e 3 3 I IR - = etola @ A
Bwae B

W Caicutanicn Sheet o (=@

Notwork|Pips |Ragistor [Tempsestes [Water |[Des |Piga M |Watar Tipe | pas_ |Totsl |Polar | Heatac|Space |Radtar Entening =
Secton |Lengfloads  |Difwence  (Flow  |Fipe |52 Vel (Velocty  |of ction |Fricson |sngie  |Space (Loacs (Type iate
my " | caam) |(°C mak) |38 (mis) |(mis) Fint WGI Do |Loas | () Micaim) Temp.
(WG | .G | (G
1 1z mm aa £
2 23 1500 % Vestieal Disgram = | =
3 P4 4
4 H5  esso
5 _Bs 2535
T
7 s 5731 <. e
z | B
= L= (5
£
e g
#

| ]
¥
o

5 iz K000 B = 1 AR

812 imAncerstls Fips Frictien Drop (mNG)

3.2.2.9 Sections Friction Drop

This option shows the total friction in every terminal route so that you can see if the
network is balanced.

3.2.2.10 Network Checking

If this option is selected, a window appears containing various network checks and
possible errors which you should keep in mind during the final solution.

3.2.2.11 Hot Water Storage Tank Calculations

% Hot Water Storage Tank Calculations E@
Total Number of Baths in the Building n 4
Mumber of Apartments in the Building 4
Simultaneous Working Factor F 0.65

Desired Hot Water Storage Tank Capacity (1)
Hot Water Storage Tank Required Capacity (1) 325.00
Hot Water Storage Tank Selected ||

Desired Mean Hourly Thermal Request for the Hot Water Storage Tank (Mcal/h)
Max Hourly Thermal Request for the Hot Water Storage Tank (Mcal/h) 11.21

If you select this option, the next window appears where the Hot Water Storage Tank of
the installation is selected.

3.2.2.12 Libraries

The "Two Pipes System" application libraries contain pipes, radiators and fittings as well
as equipment for the boiler-room (Boilers, Burners, Circulators, Expansion Tanks, Heat
Pumps etc.). Each library category contains various material types which exist in the
market, but naturally it can be updated with the material types you desire.
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3.2.3 Single Pipe System

The main menu options are divided into the groups "Files", "Project Data", "View",
“Windows”, "Libraries" and "Help". “Files”, “View” and “Help” and most of the other options
are quite similar to the “twin pipe heating” application (they are discussed in detail in
paragraphs 3.1.1, 3.1.3 and 3.1.6 respectively). The rest are described in short in the
following paragraphs.

3.2.3.1 Project Data

This pertains to the project basic data, which are divided into Project info (project
headings) and Network data. Network data concern:

Space Temperature (°C): Enter the desired space temperature in °C (usually 20° C).

Inlet water temperature (°C): Enter the inlet water temperature in °C (the return
temperature is calculated automatically)

Water Temperature drop per level (%): Enter (if desired) a percentage of
temperature drop per level, due to minor losses in the vertical pipe of the installation.

Water Temperature drop at the circuits (°C): Enter the temperature drop at the
circuits (usually 15° C). This need to be entered only if the equal temperature drops
method is used.

Maximum velocity limit for the central pipes (m/s): Enter the maximum water
velocity limit in the main pipes.

Maximum water velocity limit for the circuits (m/s): Enter the maximum desired
water velocity limit at the circuits. In general, for Single Pipe System circuits with
copper or plastic pipes on the floor, water velocity should be between w=1.0-1.2 m/s.

Main pipe types: Select the pipe type of the main pipes (e.g. copper pipe)

Main pipes roughness factor: The roughness factor is entered automatically,
depending on the pipe type you have selected, but you can easily modify it. The
measurement unit used by the program is pm.

Circuits pipes type: Select, to enter the pipes type for the circuit pipes (e.g. copper
pipe).

Circuit pipes roughness factor: The roughness factor is entered automatically,
depending on the pipe type you have selected, but you can easily modify it. The
measurement unit used by the program is ym.

Circuits desired pipe size: Enter the desired circuit pipes size (diameter). Initially,
this will be the same for all circuits. Diameter may be selectively modified for specific
circuits in the calculation sheets (although in practice, most of the times loops with the
same diameter are used).

Desired switch Regulating (%): Enter the initial setting of the radiators switches
(usually 50%). For the last radiator of a circuit, most engineers set the switch to 100%.
If the program works with Fine HVAC, this setting is entered automatically.

Switch Equivalent Length: Enter the equivalent length of the switch (in m). By
default, the program considers that there is one switch for every radiator.

Branch Equivalent Length: Enter the equivalent length of the branch (in m). By
default, the program considers that there are two branches for every circuit (inlet &
return).
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Equivalent length of the curve: Enter the equivalent length of a circuit pipe curve. By
default, the program considers that there are two curves for every radiator.

Safety factor of main pipes length (%): Enter the average estimated increase of the
main pipes length (25-30%).

Number of levels (floors): Enter the number of levels (floors) to be heated with the
single pipe system.

Energy units: Select the unit system (Kcal/h or watt).

Expansion tank: Select between open and — more often used — closed expansion
tank.

Calculation Method: Select the method that will be used to calculate the installation.
The program gives you three options: 1) self- balancing (of equal pressure drops or
frictions), 2) of equal temperature drops and 3) hydraulic simulation with reverse
solution.

Chimney calculations according to EN 13384.01: If you check this box, you can
calculate the chimney according to the European norm EN 13384.01.

Building geodetic height in relation to sea level: Enter the geodetic height of the
building.

Analytical calculation of contained water in the system: If you check this box, you
can calculate in detail the contained water in the system.

Fuel Type: Select the fuel that is used (oil, natural gas, LPG etc.).

3.2.3.2 Calculation Sheet

The Single Pipe Heating System calculation sheet has the following form:

“4 Single Pipe Heating System - [F\tmp\PENNY\8_3_BUILDING.BLD] - [Calculation Sheet] |l S|
“t Files ProjectDatz View Calculation Sheet Windows Libraries Help - & %
Ds|E||B|R] €= @l (9 o] (%@
Blzlulll==l== O -| A - | Al -5 . @@@@|
Ciejsle =ieky
Level 1| Level 2 | Level 3]
Num Pipe | Circuit Collector |Temperature |Water  |Des Pipe  |Max Water  |Equivalent [Throttlin Pres Total -
MPipe Circ.|Length |Loads Mo Crop Flow Pipe Size Vel Velocity |Length (mWG) |Drop Pressure/ =
(m) (Mcalih) ("C) (m3ih) |Size (mis)  |(mis) (m) (mWG/m)|Drop ’
(mm) (mWG)
1 11 2822 2.849 1 11.18 0.255 14.50 DN16 1 0.429 4832 0.017 0.826
2 12 23177 4220 1 15.55 0.271 1450 DM16 1 0.457 43.27 0.019 0.828
3 1 6.00 15.00 1.024 1 0.6 0.490 7.800 0.012 0.092
4 |
5|
6 | [ ]
7|
8 |
a |
10|
11|
12 |
13 il
4 n 3
6:10 InAccessible Water Velocity (mis)

Each calculation sheet corresponds to a building level (floor) which is heated with the
single pipe system.
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Each row of the sheet corresponds to a different circuit of the level or to the section of the
vertical column that heats this particular level (or simply passes through it to feed the
circuits of higher levels) or to a horizontal section that connects two vertical columns.

Each column of the sheet contains the data entered by the user or calculated by the
program.

In the network Calculation Sheet, you enter the circuits existing on each level and the
columns which provide the heating medium to the particular level.

Each column-circuit row is numbered with the column and circuit serial numbers, inserting
a full stop ".", e.g. "2.3", which stands for "column 2, circuit 3".

At each level the circuits are numbered, starting from 1. If there are more than one
columns, the numbering of the circuits of each column begins from 1 (for example, the
circuits of column 1 will be 1.1, 1.2 etc, the circuits of column 2 will be 2.1, 2.1 etc.).

Please note that each column-circuit row corresponds to a sub-table that contains the
detailed characteristics of the particular circuit. To activate this table, go to the desired line
and press F11 or select "Calculations of the radiators of the circuit" from the list that
appears when we press the right button of the mouse. Instructions about data entering
appear at the bottom of the screen.

Finally, note that the network vertical columns are entered, for each level, right below the
last circuit, by entering the central column number for each column. For example, the
section of the central column 1 that feeds the 5™ level and comes from the 4™ level will be
given to the 5" level by entering "1" below the last circuit. At level 1, the section of the
central column 1, which will also be given number "1", is the section that leads to the
boiler-room collector.

In case another column begins from the collector of a certain level, it is specified by
entering the numbers of both columns, with a dash ("-"). For example, section "1-2" is the
horizontal section that connects two vertical pipes at the collector of the level below the
one you are working on. This way any possible case of single pipe heating network

installation is standardized.

3.2.3.3 Calculation of other equipment

Other equipment, concerning mainly the heating engine room, is calculated through a
series of windows, each one taking care of a specific part. Those windows for the single
pipe heating installation concern in particular the Boiler — Heat pump, the Burner, the Fuel
Tank, the Circulator pump, the Expansion Tank, the Chimney and the Hot Water Storage
Tank, as also explained for the two pipe heating system presented in the previous section.

3.2.3.4 Vertical Diagram

This option creates the vertical diagram of the network (if you want to create it directly and
not automatically using Fine HVAC). The Boiler Room is located on the bottom side with
its specific features automatically transferred from the calculation sheets.

3.2.3.5 Network Checking

If this option is selected, a window appears containing various network checks and
possible errors which you should keep in mind during the final solution. More specifically,
each circuit is inspected for temperature drop (the program locates and marks the circuits
where temperature drop exceeds 20 degrees). Furthermore, water velocity in the piping is
checked with respect to the maximum limit set in the “Network” data.
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3.2.3.6 Libraries

Libraries of the Single Pipe System include pipes and radiators as well as the equipment
of the Boiler Room (Boilers, Heat pumps, Burners, Circulators, Expansion Tanks, Heat

Pumps etc.) as in the case of the Two Pipes System. All these libraries can be updated by
the user.
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3.2.4 Infloor Heating System

The main menu of this application consists of the groups "Files", "Project Data", "View",
“Windows”, "Libraries" and "Help". “Files”, “View” and “Help” and most of the other options
are quite similar to the two others heating applications (they are discussed in detail in
paragraphs 3.1.1, 3.1.3 and 3.1.6 respectively). The rest is described in short in the
following paragraphs.

3.2.4.1 Project Data

This pertains to the project basic data, which are divided into Project info (project
headings) and Network data. Network data concern:

Space temperature (°C): Enter the desired temperature of the spaces to be heated.

Inlet water temperature (°C): Enter the inlet water temperature which is heated by the
boiler.

Water Temperature drop per level (%): If it is desired, the program can take into
account a slight temperature drop from one level to another due to thermal losses in
the central vertical pipes.

Main pipe water maximum velocity (m/s): Enter the upper water velocity limit in the
main pipes, which should not be exceeded.

Maximum velocity limit for the circuits (m/s): Enter the upper water velocity limit in
the circuits, which should not be exceeded.

Main pipe types: Enter the pipe type for the main piping (e.g. copper pipe).

Main pipes roughness factor (um): The roughness factor is automatically filled in,
depending on the selected pipe type but if you wish, you can modify it.

Circuit’s pipes type: Enter the pipe type for the circuit piping (e.g. copper pipe).

Circuit pipe roughness factor (um): The roughness factor is automatically filled in,
depending on the selected pipe type but if you wish, you can modify it.

Circuits desired pipe size (mm): Select the desired circuit pipe size (diameter) which
will initially apply to all circuits. This diameter can be modified selectively in the desired
circuits included in the calculation sheet, although loops of uniform diameter are usually
preferred in practice.

Coefficient of floor Thermal Resistance (Upward) (m?K/W): Enter the respective
coefficient of floor thermal resistance (if F11 or the appropriate button into the field is
pressed, an explanatory table appears).

Coefficient of floor Thermal Resistance (Downward) (W/m?K): Enter the respective
coefficient of floor thermal resistance (if F11 or the appropriate button into the field is
pressed, an explanatory table appears).

Default pipes spacing RA (cm): Enter the RA spacing of the pipes.

Main Pipes Fittings Sz: Enter the value of the total fittings resistance (if F11 or the
appropriate button into the field is pressed, an explanatory table appears).

Coefficient z of Entering and Leaving switches: Enter the value of the inlet and
return switch resistance (if F11 or the appropriate button into the field is pressed, an
explanatory table appears).

Number of levels (floors): Enter the number of levels (floors) to be heated from the
infloor system.
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¢ Energy units: Select the unit system (Mcal/h or Kwatt).

¢ Expansion tank: Select between open and — more often used — closed expansion
tank.

e Chimney calculations according to EN 13384.01: If you check this box, you can
calculate the chimney according to the European norm EN 13384.01.

¢ Building geodetic height in relation to sea level: Enter the geodetic height of the
building.

e Analytical calculation of contained water in the system: If you check this box, you
can calculate in detail the contained water in the system.

o Fuel Type: Select the fuel that is used (oil, natural gas, LPG etc.).

3.2.4.2 Calculation Sheet

The columns and the circuits (loops) of the infloor heating network are included in the
network calculation sheet. According to the applied standardization, circuits are numbered
in each floor and column (starting from number 1). Each sheet is corresponds to a specific
floor and each sheet row to a different circuit of a particular central column while each
column of the calculation sheet refers to the data which are going to be inserted or result
automatically during the data insertion procedure.

) tnfloor Heating System - [F:\tmp\PENNY\8_3_BUILDING.8LD] - [Calculation Sheet] | S
M] Files Project Data View Calculation Sheet Windows Libraries Help - [
R e A S 1R =) I E A L R S E 1L -
Blz|lul=[=l=|=][%-] A -] <[ 5|8 E[100%
A
| Level 1 | Level 2 | Level 3 | Level 4| Level 5|
Circul |Pipe Circuit | Temperature Water |Des. |Pipe Max  |[Water Fittings | Throftlin| Pipes | Total Heated |Space Space =
Nao Length |Loads rop Flow |Pipe |Size Vel. |Velocity |Fr.Drop \mWG |Friction |Friction |Space |Type Loads
m (Mcam) |(°C) m3h [Size [mm (mis) [(mls) (mWG) Drop  |Loss (Mcah
mm mWG  [(mW.G.) £
1 11 | 4545 | 0892 8.247 0108 12 07 0.266 0011  1.789 0499 2209 People Living Area 077
B 12 4242 0890 5297 0168 12 07 0.413 0.030 1267 1.001 2299 People Living Area 077
3 13 | 6061 | 1.107 9.320 0118 12 07 0.202 0026 1491 0782 2209 People Living Area 1
4 14 | 5455 1107 4850 0228 12 07 0.561 0.096 2203 | 2299 People Living Area 1
5 15 1515 0221 17.37 0013 12 07 0.031 0.000 2294 0005 & 2299 Baths 0.2
6 1 4 25.30 5974 70 0.6 0.513 0.020 0.019 | 0.039
7|
8 |
g
10
1"
12 -
4 (2
m
Pressure Drop at Level 2.356
1.2 View Fipe Length (m)

Attention should be paid to the fact that the sub-table of the circuit, which contains the
detailed features of the particular circuit and is activated if F12 is pressed or by selecting
"Options" from the list that appears when we press the right button of the mouse while in
the respective row, corresponds to each column-circuit row (which is symbolised with the
serial column and circuit number, separated by a full stop "." e.g. 2.3, which stands for
column 2 circuit 3). It should be mentioned that the vertical columns of the network are
entered, for every floor, in the 1st column of the sheet right below the last circuit, by simply
inserting the central column number for each column. This standardization is completely
relevant to the one applied to the Single Pipe System (see section above). If the above
standardization is followed, data should be entered not only into the floor sheets (circuit
table) but into the circuit sub-tables as well, for every network circuit. In the next
paragraphs (a) and (b) you can find an extensive description about the way to insert data:

(a) Infloor Circuit (loop) Table
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Data should be inserted primarily in the first column, which refers to the circuit symbolism.
The length of the pipe automatically comes up in the second column (provided that the
necessary calculations have been made). In the same column, extra accessories can be
added to the circuit (elbows, valves etc). if F12 is pressed or by selecting " Options " from
the list that appears when we press the right button of the mouse and the total z
(resistance) provided, using the table which automatically appears on the top left side of
the screen. The circuit load appears in column 3, on the condition that F12 has been
formerly pressed and certain data have been inserted into the displayed window (circuit
sub-table). More specifically, you should insert either the number of the floor and the
space heated by the particular circuit (e.g. 2.3 stands for floor 2 space 3 as it is shown in
the thermal losses calculation sheet) in the first row of the window or the space load
directly in the third line (in Mcal/h).

M] Infloor Heating System - [F:\tmp\PENNY\8_3_BUILDING.BLD] - [Calculation Sheet] =ahe X
MEHES Project Data  View Calculation Sheet Windows Libraries Help - |8 %
R HE N ST B A ERESI!

B I U =

Clefddel (&S

| Level 1 | Level 2 | Level 3 | Level 4| Level 5|

Sy« A || Arial -9 - 100% =
=

Circul [Pipe  |Circuit |Temperature Water |Des. |Pipe  |Max  |Water Fittings | Throttlin|Pipes  |Total Heated |Space Space ~
Mo  |Length |Loads |Drop Flow |Pipe |Size |Vel |Velocity |FrDrop|mWG |Friction |Fricion |Space |Type Loads
m (Mcafn) |(°C) m3ah |Size |mm |(mis) |(mis) (MWG) Drop |Loss {Mcah|
mm mWG  [(mW.G) =
1 11 4545 | 0892 8.247 0108 12 07 0.266 0011 1789 0489 2299 People Living Area 077
2 | 12 [4242 | 0830 5.207 0168 12 07 0.413 0.030 1.267 1.001 2299 People Living Area 077
3_ 13 | 6061 | 1.107 9.320 0119 12 07 0.202 0026 1491 0782 2209 People Living Area 1
4_ 14 | 5455 1107 4850 0228 12 07 0.561 0.096 2203 | 2299 People Living Area 1
5 | 15 | 1515 0221 17.37 0013 12 07 0.031 0.000 2294 0005 22099 Baths 0.2
r 1 4 25.30 5974 70 0.6 0513 0.020 0019 | 0039
7|
g |
g |
10 |
|
12 | 2
A [ +
Pressure Drop at Level Z.ﬁ
12 View Fipe Length (m)

During the calculation of each space thermal losses, it should be taken into account that
the Infloor Heating System requires a 16-hour minimum operation time.

Quite often part of the space under study needs to be covered by a separate additional
circuit of high thermal output. Such a circuit is called thermal “zone”. The aim is to have
the zone covering floor areas that cannot or are not normally used by the tenant of the
space (e.g. area close to the external walls or area beneath an immovable piece of
furniture etc.). This zone allows us to cover a substantial space load, since the maximum
floor temperature can be taken as 35 °C maximum. Note that space loads should not
contain any floor losses, which should also not be taken into account during the thermal
losses calculation.

When the results appear in the circuit row (after you have completed the “Options”
windows that is discussed below), it can be observed that all items (water supply,
temperature drop in the circuit, flow velocity, frictions etc.) have been calculated for the
specific pipe size selected in the “Network” window. If it is desired, this can be changed by
pressing F3 while in the "desired pipe size" column (see also relevant message in the
bottom of the screen). In the eleventh column, the required throttling is calculated so that
the installation functions properly (through precise regulation devices). For the worst
installation circuit, throttling automatically resets (reference circuit).
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(b) Options window (Circuit Sub-table)

As it has already been discussed above, control is transferred to the sub-table by pressing
F12 or by selecting " Options" from the list that appears when we press the right button of
the mouse in the relevant row of the circuit table.

Data appearing in the columns of this sub-table, as it can be seen, are as follows:

Heated space: The floor and space numbers are entered as they are appeared in the
Thermal Losses calculation sheet (e.g. 1.2).

Space type: It is determined whether it is a people living area, a bath or a high thermal
capacity area.

Space loads: It concerns the total space load, which automatically appears after
selecting the "Heated space" or typing it directly.

Floor surface (m?: Insert the

f M Options li_:hr
floor area of the heated space.
Heated Space
Space temperature (°C): Enter Space Tvpe People Living Ares
h d . d tem erature Space Loads (Mca/h) 077
t e desire Space p " Floor Surface (m2) 14
Under heated Space Room space Temperare (9. -
Under Heated Space Room Temp. (°C) 10
tem peratu re (OC): Enter the Coefficient of Thermal Resistance (Upward) (m2KAWW) 0.15
temperature of the space located Coeff. of Thermal Conduction (Downward) (W/m2K) 0.45
under the heated Space Density of Thermal Flow (Mcalh/m®) 0.055
Floor Surface Mean Temperature (*C) 26.19
cOefficient of thermal Floor Surface Max Temperature (*C} 29
resistance (U pward) (mzKIW) Desired Mean Floor Temperature (*C) 30
. . Corrected Value of Heat Transfer Density (Mcal'h/m®)
Enter the coefficient of upward ol Shor Thermal Fourer (heai
. . all Short Thermal Power (Mca/h)
thermal resistance either by Pipes Distance RA (cm) 53
typlng it directly or by Selecting it Mean Water Temperature (*C) 4213
from the table that OpenS Density of Thermal Flow Downward (Mcalih/m=) 0.009
Total Power of Infloor Heating System (Mca/h) 0.890
Coefficient of thermal Gircutt Lengih ()
Conduction (Downward) Supply and Return Circuit Length (m)

(W/mzK): Enter the Coeff|c|ent of Sum of Coefficients z of the Additional Accessory Fittings | 0.5
downward thermal resistance
either by typing it directly or by
selecting it from the table that
opens.

Thermal flow density (Mcal/h/m?): When the above fields have been completed, the
density of thermal flow is automatically calculated.

Mean floor temperature (°C): When the above fields have been completed, the mean
temperature of the floor surface is automatically calculated.

Max. floor temperature (°C): The maximum allowable floor area temperature appears
according to DIN 4725. Specifically, for residential areas trgmax < 29 °C, for high thermal
capacity area trgmax < 35 °C and for baths trg < tj + 9 °C, where t; is the space
temperature.

Desired floor temperature (°C): If the Mean floor surface temperature that has been
calculated exceeds the Maximum floor surface temperature, enter a desired mean floor
temperature so as to calculate the length of the pipes.

Corrected heat transfer density (Mcal/lh/m2): The corrected value of the thermal flow
thickness is then calculated and shown.
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¢ Fall Short Thermal Power (Mcal/h): This result concerns the power that cannot be
covered by the particular piping arrangement. Consequently, the designer should
shorten the piping spacing RA, define a thermal zone or install a radiator.

¢ Pipes spacing RA (cm): Enter the RA spacing of the pipes.

¢ Mean water temperature (°C): The average water temperature is calculated and
shown.

e Downward thermal flow density (KWatt/m?): The density of thermal flow downward
appears, as calculated by the program.

o Total Power of infloor system (Mcal/h): The total infloor heating power of the
installation is calculated.

¢ Circuit length (m): The required circuit length (net section) is calculated according to
all the above mentioned data.

¢ Supply and return circuit length (m): Insert the total inlet and return length from the
vertical pipe to the circuit.

e Sum of coefficients z of the additional accessory fittings: Enter the sum of the z
coefficients of all the fittings that are used in this circuit.

Some of the above values should be typed while others are automatically calculated (the
ones in red). Default values, which are the more common in each case, have been
inserted in advance so that the user will not have to insert data in all fields.

Any modifications in the above data bring about correspondent modifications in the values
of the circuit sheet, which instantly appear on the screen. In this way, the user supervises
and controls the procedure fully.

Regarding the calculations, it should be clarified that the space type (residential area, bath
or high thermal capacity area) automatically determines the maximum floor temperature
(29, 33 or 35 respectively). If the mean floor surface temperature is higher than the
maximum floor surface temperature, then the desired mean floor temperature should be
inserted. In this case, the circuit will not cover all losses. For this reason, the remaining fall
sort thermal power appears. Moreover, pipe spacing RA constitutes one of the principal
parameters determined by the user in each space. If this spacing is shortened, the circuit
pipe length is obviously increased and the mean water temperature drops. In all cases it is
assumed that the circuit length should not exceed a certain limit which is set by the
manufacturer of the particular pipe type and is approximately 150 m.

3.2.4.3 Calculation of other equipment

Other equipment, concerning mainly the heating engine room, is calculated through a
series of windows, each one taking care of a specific part. Those windows for the infloor
heating installation concern in particular the Boiler — Heat pump, the Burner, the Fuel
Tank, the Circulator pump, the Expansion Tank, the Chimney and the Hot Water Storage
Tank, as also explained for the single and two pipes heating system presented earlier.

3.2.4.4 Vertical Diagram

This option creates the vertical diagram of the network. The Boiler Room is located on the
bottom side with its specific features automatically transferred from the calculation sheet.

3.2.4.5 Libraries

Infloor Heating System Libraries include pipes as well as boilers, heat pumps, burners,
circulators and expansion tanks as in the case of Single and Two Pipes Systems.
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3.3 Air-Conditioning

The Air-conditioning package consists of four applications, which function either
independently or in conjunction with each other. These applications are:

e Cooling Loads: Cooling Loads are calculated (with the use of Ashrae or Carrier
method) in each building floor and space, a procedure which usually comprises the first
step of an Air-conditioning project.

¢ Fan Coils: In this application all the necessary calculations for the installation of fan
coils units are carried out and the required equipment is selected (pipes, cooling
system, pump, safety device etc.).

e Air Ducts: All the necessary calculations for the installation of a duct network are
carried out (with one of the three known methods) and the required equipment is
selected (duct dimensions, duct grills, fan etc.).

e Psychrometrics: The air distribution in the air-conditioned spaces is estimated based
on detailed psychometric equations, the psychometric change is depicted on the
Psychometric Chart and the appropriate air-conditioning unit is selected.
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3.3.1 Cooling Loads

When the program is loaded, the main menu with the option groups "Files", "Project Data",
"Windows", "Libraries" and "Help" appears on the screen. “Project Data” are divided in
project info (headings of the project), months, indoor design conditions, climatological
data, building parameters, structural elements, people, equipment and lighting loads.

3.3.1.1 Indoor design conditions

You define the desired indoor humidity (desired relative % humidity in the air-conditioned
spaces) and temperature (desired temperature in °C in the air-conditioned spaces) along
with the temperature difference between outdoor and non air-conditioned spaces (in °C)
and the temperature difference between soil and air-conditioned spaces (in °C).

3.3.1.2 Climatological Data

The data refer to the selected city, displaying the corresponding climatologic data
(latitude, longitude, mean temperatures, corresponding fluctuations for 6 months etc.) as
well as the average relative humidity in summer.

3.3.1.3 Months

The Reference month and Calculation months (i.e. from April until September) are defined
in this window.

3.3.1.4 Building Parameters

The data of the respective window include the following:

Area with Fog: In case there is usually fog in the area, check this box.

Number of levels (floors): The levels of the building can be up to 15.

Default Height (m): This value will automatically update the height of the walls in the
calculation sheet, while you will be able to make modifications wherever you desire.

Energy units: You select the units of the project (Mcal/h, KWatt, KBtu/h).

Resistance coefficient unit system: You select the units of the resistance coefficients
(Kcal/hm?C or Watt/m?K).

Calculation method: The program gives the option to select among Carrier, Ashrae
CLTD, Ashrae TFM and Ashrae RTS calculation methodologies. Moreover, when you
complete the data entry procedure with one of these methods, you can compare the
results with those of another method, by simply altering it.

Safety Factor (%): You can define in any desired space a general increase factor for the
loads (e.g. 5%), which will increase accordingly all the individual loads of the space.

Opening hour — Closing hour (1-24): Through these two options you can determine the
range of the time period in which you wish to have the calculation results (e.g. initial time 8
until final time 18). Naturally, the selection can be made for the whole 24 hours time (from
1 o’clock until 24 o’clock) but the result volume will be larger.

Rotation angle: If you want to change the orientation of the building, you can rotate it to a
specific angle through selecting it from the list.
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3.3.1.5 Structural Elements

|
e . =

Outer walls | InnerWalls Ceilings Floors Openings
Outer Walls  |Description Type of Type of Type U-Factor Weight Ll
ASHRAE ASHRAEWN TF|ASHRAE KcalimzZhc  |Kgim2 7
CLTD RTS B
1 V1 Outer Wall 4 cm insuC G1 7 055 300 2
2 W2 Outer Wall 1 C G4 7 0.6 300 2
3 V3 Cuter Wall 3 C G6 17 0.58 300 2
4 W4 Outer Wall 4 C G7 17 1.28 300 2
5 L Cuter Wall 5 C G8 17 0.45 300 2
G VW6 Outer Wall 15 A G138 5 2.00 700 2
7 W7 Cuter Wall 10 B G13 22 0.56 500 2
g Vs Outer Wall 12 B G15 22 055 500 2
9 VW9 Outer Wall 21 B HG 7 0.a7 500 2
10 W10 External Wall B G17 17 0.430 300 2
11 W11 External Beam C G17 7 0444 300 2
12 W12 External Columns C G17 17 0.444 300 2
13 W13
14 W14 i
< | 1 5
[ Ok ] [ Cancel ]

1:1 InAccessible

Outer Walls

This term corresponds to some common element types which characterise the building
and more specifically the typical structural elements such as outer and inner walls,
ceilings, floors and openings.

e Outer walls are specified through their U factor coefficient, weight (100, 300, 500, 700
kg), colour (light, intermediate, dark), as well as standardisation by Ashrae method (A,
B, C, D, E, F, G). You can select the desired typical data from the relevant library.

e Ceilings are specified through their U factor coefficient, weight (50, 100, 200, 300 kg),
colour (light, intermediate, dark), type by Carrier (sunny, shady, under water or
watered) or by Ashrae (types 1, 2, 3,.., 11 with or without suspended ceiling).

¢ Inner walls and floors are specified through their U factor coefficient.

¢ Openings are specified through their dimensions (in m), U factor coefficient, glass
coefficient, frame type and coefficient of air penetration a (the same coefficient applied
in heating). As far as the glass coefficient is concerned, a detailed auxiliary table is

available.
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3.3.1.6 People

In case you want to define the same people loads for all the spaces, you complete the
following window.

r a
People u
Description Sensible Latent Radiant Cluantity -~
0a oa eat I
(Kcalih) (Kcalih) (%)
1 Seated, very light work 60 39 60
2
B =
n
5
6
7
8
9
10
11
12 &
() Insert number of persons / m2 @ Insert number of persons
Opersting schedule ‘ND Ceincidence B|
123456789101112131415161718192021222324i

1.5 View Quantity

You select a description from the list that appears by pressing F11 or right click of the
mouse and automatically the sensible, the latent load and the radiant heat are completed.
The only thing that you have to do is enter the quantity in the last column which will be
either the number of persons in the space per m? or the number of persons in the space
(depending on which option you will check). Furthermore, you can select the operating
schedule depending on the building type by pressing the selection button.

When this window is filled in, all the spaces in the calculation sheet will automatically get
the same people loads but you can modify them separately in each space inside the
calculation sheet.

FINE — HVAC -77-



3.3.1.7 Equipment

In case you want to define the same equipment loads for all the spaces, you complete the
following window.

Description Sensible Latent Radiant CQluantity
oad load heat
(Kcalih) (Kcalmy) (%)
1
2
3
4
5
5}
7
8
9
10
11
12
() Insert number of devices / m2 @ Insert number of devices
Operating schedule INn change B|
123456?89101112131415161718192021222324
L L L e e o e s O s s O O A B
11 View Description Ctrl ”

You select a description from the list that appears by pressing F11 or right click of the
mouse and automatically the sensible, the latent load and the radiant heat are completed.
The only thing that you have to do is enter the quantity in the last column which will be
either the number of devices in the space per m? or the number of devices in the space
(depending on which option you will check). Furthermore, you can select the operating
schedule depending on the building type by pressing the selection button.

When this window is filled in, all the spaces in the calculation sheet will automatically get
the same equipment loads but you can modify them separately in each space inside the
calculation sheet.
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3.3.1.8 Lighting loads

In case you want to define the same lighting loads for all the spaces, you complete the
following window.

rI.ighﬁng Loads ;.
Description llumination |Radiant Watt
coefficient heat
(%)
1
2
3 |
4 |
5 |
5 |
e
5 |
9 |
10 |
T
12 |
() Insertillumination in watts / m2 @ Insertillumination in watts
Operating schedule INIJ coincidence B|

1 |2 (3 |4 |5 |6 |7 (8 (9 |10 |11 |12 |13 |14 (15 |16 |17 (18 |19 |20 (21 |22 |23 |24

[ Ok ][ Cancel ]

11 View

You select a description from the list that appears by pressing F11 or right click of the
mouse and automatically the special allowance factor and the radiant heat are completed.
The only thing that you have to do is enter the watts in the last column either per m? of the
space or for the whole space (depending on which option you will check). Furthermore,
you can select the operating schedule depending on the building type by pressing the
selection button.

When this window is filled in, all the spaces in the calculation sheet will automatically get
the same lighting loads but you can modify them separately in each space inside the
calculation sheet.
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3.3.1.9 Calculation Sheet

The calculation sheets for the space loads are included in the respective building floor
sheets. If one of the floors is selected, a list will appear containing the respective load
sheets for the floor spaces. The functionality is quite similar to the one described for the
heating losses spaces.

9% Coaling Loads - [FATMP\BIKY\E_3_BUILDING.BLD] - [Calculation Sheet] = | B |
@ FEiles ProjectData View Calculation Sheet Windows Libraries Help =& %
NEFIEIRNEE B o] oty
‘E|7|f| [ Fn ol o] [l 210 =] {surfaces -
' EEHEH @
Surface |Orientation |Subtracted |U-Factor Length |Heightor |Surface |Equal Total Subtracted |Calculated =
R Level 1 Type (Kealimh*c) | (m) Wigth | (m2)  |Surface |Surface |Area Surface |-
(m) Number [ (m2)  [(m2) (m2)
o B level2
S 1 LiingRoom 3194 1 2 WY 06 6.20 3.00 18.60 1 18.60 526 13.34
w 2 Bedoom1 1617 2 o1 NwW 4.5 100 220 220 1 2.20 2.20
- % 3 EBatroom gst 3 jo1 hw 45 100 120 120 | 120 120
gy 4 Bedroom2 1204 5
& 5 Kitchen 1337 NV 0.56 6.20 0.30 1.86 1 1.86 1.86
Lol 3 5 sw 06 665 300 1995 11 19.95 530 14.65
; . aiaa = " a o 1cn 2op 335 4 330 330
- 1 Living Room 31594 i 02 SV 50 1506 220 330 3.30 3.30
& 2 Bedoom1 1617 7 T sw 0.56 665 030 200 A 2.00 2.00
S 3 Bathroom 857 g
..y 4 Bedroom2 1204 g
% 5 Kitchen 1337 |
a Qg leveld
- 1 Living Room 3194 1
% 2 Bedroom1 1617 =
% 3 Bathroom 857 13
S 4 Bedroom2 1204 12 I8
..y 5 Kitchen 1337 = . b
o B level5
‘-; 1 Living Room 3194 People Total Load 164.0 Heat Gain from Lights 116.9 Max Space Values
:" 2 Bedroom 1 1817 People Sensible Load 112 Ventiation Total Load Max Sensible Load 2142
- 2 Bathroom 857 People Latent Load 52 Ventilation Sensible Load | 0 Max Latent Load
--my 4 Bedroom2 1204
& 5 Kichen 1337 Equipment Total Load 120.0 Ventiation Latent Load 0 WMax. Total Load 3194
Equipment Sensible Load | 120
Equipment Latent Load 0 System or Zone 1
< i v
11 View Surface Type F6.Surfaces F7:Loads F8:Shadings) Ctrl + Enter or F11 :Surface Types

The screen that corresponds to the space data is divided in two parts: the upper part
refers to the loads due to the structural elements of the space, while the lower part refers
to the additional loads due to lighting, people, equipment etc.

Concerning the upper part of the screen, each row refers to a specific typical structural
element (e.g. W1, O1 etc.). The data inserted (either from you or automatically through
the drawings) correspond to the Orientation, the Length (m) and Height (m) of the building
element, as well as the number of equal surfaces if exist. Openings are subtracted
automatically from walls, if orientations are alike.

Optionally, in the last three columns, the data for the shading calculation can be typed.
Three different shading mechanisms are possible:
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Inside shading: This applies only to windows in the case there are blinds, roller
shades etc. that cover their total surface at the same time. The most common values
for each case and according to the glass type appear in the auxiliary table, which is
activated when F11 or the selection button of the field is pressed.

Projection shading: This applies mainly to openings but it can be also used for wall
surfaces. If you press the right button of the mouse while in the respective column and
row and select from the list "Options", the window of the adjacent figure appears in the
right corner of the screen. Here you can fill the width of the horizontal and (or) vertical
projection of the opening and its distance from it. For example, for a balcony of one-
meter width, which hangs 0.5 meter above the O1 window, you type “1” in the field of
the horizontal projection width and “0.5” in the field of the horizontal projection
distance. As soon as you fill in and close this window, the word “SHADE” will be shown
in the “Projection Shading” column.
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¢ Arbitrary shading coefficients: You can select the shading coefficients for different
hours, with the help of the “Options” window (press the right button of the mouse while
in the respective column and row and select from the list "Options"). This option is used
when there are shadings due to elements that do not belong to the building (e.g.
neighbouring buildings). Note that a shading coefficient 0 means that the window is
completely shaded, a shading coefficient 1 means that it is not shaded at all and a
coefficient from 0 to 1 means that it is shaded partially. Regarding all other intermediate
hours, the shading coefficient is calculated automatically with the linear interpolation
method. As soon as you fill in and close this window, the word “SHADE” will be shown
in the “Arbitrary shading coefficients” column.

As far as the space loads calculation is concerned, the Maximum Space Load Values
appear in the bottom right corner of the screen, at every minute, and more specifically:

e The maximum sensible space load
e The maximum latent space load
e The maximum total space load

If you want to see the analytical calculations per structural element and hour, all you have

to do is press F7 or the button @ or press the right button of the mouse and select
"Loads" and the analytical loads due to each structural element as well as the sums for
each hour will appear on the screen. In this way you have absolute supervision and
control in every phase of the data entry procedure and can interfere accordingly (e.g.
make an opening smaller if you think that this causes a rather large increase of the space
load).

At the bottom left part of the screen appear the results that concern additional loads
due to People, Equipment, Lighting and Ventilation. More specifically, these data are
divided in two categories: total loads due to People and Equipment appear in the left
column while total loads due to Lighting and Ventilation appear in the right column.

People Total Load |164.U L“ Heat Gain from Lights 7223

People Sensible Load 112 Wentilation Total Load |1132 L”

People Latent Load 52 Wentilation Sensible Load 09
Equipment Total Load 94.00 “entilation Latent Load 573
Equipment Sensible Load 94

Equipment Latent Load 0 System or Zone 1

a) People total load: In the case of people loads, you press the selection button and fill in
the window that opens as it was described in paragraph 3.3.1.6.

b) Equipment total load: In the case of equipment loads, you press the selection button
and fill in the window that opens as it was described in paragraph 3.3.1.7.

c) Heat gain from lights: In the case of lighting loads, you press the selection button and
fill in the window that opens as it was described in paragraph 3.3.1.8.

d) Ventilation total load: This field is completed in each space due to either opening
slots losses (in the case of no forced air circulation) or loads due to air changes. In order
to estimate loads due to air changes you type the length, width and height space values
and select the number of air changes per hour (n). If there is no forced air circulation,
losses due to slots will probably occur. In this case, the number of air changes will be 0,
while the opening slots losses coefficient is defined (it should be approximately 0.5 - see
Calculation Assumptions).
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r N
Ventilation Options &J

Mean Length (m}) 46 45}

Mean Width (m) 1

Mean Height (m} 3.00

Aijr Changes per h

)]

Coeff. of Losses due to Openings Slot

Ok || Cancel |

Notes:

e If there is central air conditioning system, the loads due to air changes are not
“charged” to the space but to the respective air-conditioning unit (their calculation is
described in the section of Calculation Assumptions in detail).

e Losses due to slots are included in the calculations only if there are Fan Coils units
while they are ignored in the case of air ducts due to overpressure.

System or Zone: The window is filled in only if you want to group the spaces so that total
calculations for each group can be performed separately (up to 50 space groups can be
defined). The default zone or system number is 1. The air conditioning load requirements
of a zone can be covered by (usually) one or more systems. In the latter case, the load
allocation over systems is left to you.

Space Cptions Lﬁj

Desired Increment (%)

Room Temperature Dry Bulb (°C) 2500

Space Relative Humidity (%) 50.00

Cell Type 3 |:|
Air Circulation Medium El
Operation Type 1 |:|
Coefficient & 0.55 |:|

| Ok | | Cancel |

A ’]

If F11 or the appropriate button into the field is pressed, the above window is activated,
where you can insert the increment and the temperature and relative humidity values
regarding the specific space. In particular, regarding exclusively the TFM Ashrae method,
the shell type (from light to heavy construction type), the air circulation (low up to very
high), the operation type (not 24-hour or 24-hour) and the coefficient A (see adjacent
table) can be also defined. If F11 or the appropriate button into the field is pressed in each
one of the four last fields, an auxiliary table appears containing a list of relevant values
from which you can choose the appropriate one for the space under study.
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F N
Coefficient A 5
Coefficient A
. Air Supply and Type of Light
Coeff. A | Furnishings PPY ype g
Return Fixture
Heavy, no Low rate; supphy and Recessed, not
0.45 I
carpet return below ceiling vented
Medium to high rate,
0.56 Ordinary, no supply and return Recessed, not
et carpet below, or through vented
ceiling
Ordinary, with ) )
iy Medium to high rate, or
0.65 or without - - Vended
carpet FCU or Induction Unit
Vended or
. Ducted returns through freehanging in
0.75 Whichever light ftures airstream with
ducted returns

b 4

The sensible load part of all the above additional loads is added to the total load of the
structural elements and the final sum corresponds to the total room sensible load.

If the latent loads due to people and equipment are summed up, the total space latent
load results. The total sensible plus the total latent load comprise the total space load.
These per hour values are shown in the calculation sheet mentioned above.

In order to insert data faster, in case they have to be analytically typed (that is, if they are
not automatically updated from drawings through FINE HVAC), the program enables you
to copy a typical floor (extremely usual in practice) and a typical space, as shown in the
heating losses application.

3.3.1.10 Temperatures

The results of this window are directly linked to the applied methodology, which means
that some intermediate results-admissions of the method are shown.

3.3.1.11 Building Loads Summary

The total building loads are shown for each month and hour without including ventilation.

% Building Loads Summary EI@

TOTAL LOADS OF THE BUILDING FOR EVERY MONTH AND HOUR WITHOUT THE VENTILATION LOADS ( Mcal/h ) -

HOURS 8 9 10 11 12 13 14 15 16 17 18

23 July 20 21 20 20 19 21 24 2 29 30 26
24 Aug. 19 20 20 19 20 22 24 27 29 28 22
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3.3.1.12 Building Loads Analysis

All loads and their sum are shown per month and hour and they are described in detail
(including the unit ventilation loads).

5% Building Loads Analysis [=n EER[E=E|
TOTAL LOADS OF THE BUILDING FOR EVERY MONTH AND HOUR WITH THE VENTILATION LOADS ( Mcalih ) -
L4
HOURS 8 9 10 11 12 13 14 15 16 17 18
23 July
SPACE LOAD
SURFACES : 12 13 13 13 13 14 16 19 22 22 18
Red. : 1 1 1 1 1 1 1 1 1 1 1
Com. : 11 13 13 12 12 13 15 18 21 20 16
LUGHTNG = 2 2 2 2 2 2 2 2 2 2 2
Rad. 1 1 1 1 1 1 1 1
com : 1 1 1 1 1 1 1 1 1 1 1
PEOPSENS: 2 2 2 2 2 2 2 2 2 2 2
Rad. 1 1 1 1 1 1 1 1
com : 1 1 1 1 1 1 1 1 1 1 1
EQUPSENS: 2 2 2 2 2 2 2 2 2 2 2
Rad. : 1 1 1 1 1 1 1 1 1 1 1
Con 2 2 2 2 2 2 2 2 2 2 2
INFLTRATON 0@ 0 © © o o0 o0 ©0 0 0 0
[ b

3.3.1.13 Systems Loads Analysis

All loads and their sum are shown per month and hour and they are described in detail for
each System (including the unit ventilation loads).

3.3.1.14 Total Loads Diagram (Without Ventilation)

The following chart appears, displaying the load variation per hour and calculation month
regarding the building total loads without ventilation.

$ Total Loads Diagram (Without Ventilation) EI@
23 luly
NO VENTILATION =LoT
Il L ATENT
28 Il SENSIBLE
26
24
22
20
18
£ 15
5 14
=
12
10
a8
sl
e
2]
o
2 2 1m0 11 12 13 14 15 16 F 18
HOURS
24 Aug.
NO VENTILATION =LoT
I LATENT
Zi) M SENSELE
26
24
22
20
18
£ 18
g 14
12
1w
8
6
e
o]
o
8 8 10 11 12 13 14 15 16 1F 18
HOURS
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3.3.1.15 Total Loads Diagram (With Ventilation)

m Total Loads Diagram (With Ventilation) E@

23 July
WITH
THE VENTILATION sLoT
WENTILATION
I EQUIP.LATENT
I PECPLE LATENT

I EQUIP.SENS.
I PEOP SENS.
I LIGHTING

Bl SURFACES

m

Mcalh

The above chart appears, displaying the load variation per hour and calculation month
regarding the building total loads including ventilation.
3.3.1.16 Systems Diagram

The following chart appears, displaying the load variation per hour and calculation month
regarding the total loads for each system.

% Systems Diagrams = e <

1 sLoT
VENTILATION

N EQUIP LATENT

I PEOPLE LATENT

I EQUIP.SENS.

I PEOP.SENS.

Il LIGHTING

B SURFACES

1

Mealh

3.3.1.17 Libraries

Libraries refer to structural element types (walls, openings, ceilings etc.), temperature data
as well as auxiliary loads and their coincidences (people, equipment etc.).
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FETIRS e e )

Energy Units |weaim -
Mo Description U-Factor Weight Width Color Type yp| =
|4 4 (Kgim2) (m}) Ashrae ihr
CLTD 'FI'||_
| 1 Outer Wall -4 cm insul; 0.55 300 0.30 Middle Type C Ty E
| 2 Outer Wall 155 300 0.30 Middle Type C TV
| 3 Outer Wall Gcm Air Spe 1.17 300 0.30 Middle Type C TV
l 4 Quter Wall 1| 0.6 300 0.20 Middle Type C TV
| 5 QOuter Wall 2 14 300 0.20 Middle Type C TV
| G Outer Wall 3 0.58 300 0.25 Middle Type C TV
| 7 Outer'Wall 4 1.28 300 0.25 Middle Type C TV
| 8 Outer Wall 5 0.45 300 0.30 Middle Type C TV
9 Quter Wall 6 125 300 0.25 Middle Type C TV
10 Outer Wall 7 0.47 300 0.35 Middle Type C TV
| 11 Outer Wall 8 143 300 0.30 Middle Type C TV
<[ r
A
1B 1 5 0 0 Y e Y T e =) =
[ ok ][ cancel | [ Import>> || Importfromwep>> |

You can insert and use your own data, easily by selecting a category (e.g. the external
walls as it is shown above) and press the append record button ¥ In the new line you fill

in the element data, press to save them and OK to close the window.
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3.3.2 Fan Coils

The main menu of the Fan Coils application includes the options "Files”, “Project Data”,
“View”, “Windows”, “Libraries” and “Help”. “Files”, “View” and “Help” are similar to the
“Two pipes heating system” application and are discussed in detail in paragraphs 3.1.1,
3.1.3 and 3.1.6 respectively. The rest are described in short in the following paragraphs.

LT}

3.3.2.1 Project Data

This pertains to the project basic data, which are divided into Project info (project
headings) and Network data. Network data include:

Water temperature (°C): Enter the inlet water temperature in °C (the return
temperature is calculated automatically)

FCUs Temperature Difference (°C): Enter the fan coils units temperature difference
(usual value Dt=5 °C)

Dry bulb temperature (°C): Enter the dry bulb room temperature.
Wet bulb temperature (°C): Enter the wet bulb room temperature.
Main pipe type: Select the type of the main pipes (e.g. steel pipes).

Main pipes roughness factor: The roughness factor is entered automatically,
depending on the pipe type you have selected but if you want, you can modify it. The
measurement unit used by the program is ym.

Secondary pipe type: Select the type of the secondary pipes (in case two types are
used).

Secondary pipes roughness factor: The roughness factor is entered automatically,
depending on the pipe type you have selected but if you want, you can modify it. The
measurement unit used by the program is pym.

Maximum water velocity (m/s): Enter the maximum desired water velocity limit
(based on which the cross-sections are calculated).

Friction limit per meter length of piping (mwg/m): Enter the friction limit per length
of the piping. The recommended maximum pressure drop in water supply systems is
30 kPa per 30 m of equivalent pipe length, i.e. 10% approximately, or 10 m of water
column per 100 m of equivalent pipe length.

Number of pumps: In case you have more than one pump, enter their number here
so as to be able to use them in the Calculation sheet and the Circulator calculation.

Energy units: Select the unit system.

Type of cooling engine: You can select between an air cooled or a water cooled
engine.

FCU model: By pressing the selection button, you choose from the library the type of
the FCUs. If you want, you can add your own suppliers and units in the Libraries ->
FCUs.

Temperature variation per meter length of piping (°C/m): If the pipes are not well
insulated, enter the temperature variation per meter. In case they are insulated, this
value is zero.

FCU fan speed: Select from the list the speed of the fan among low, medium or high.
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¢ Analytical calculation of contained water in the system: If you check this box, you
can calculate in detail the contained water in the system.

3.3.2.2 Calculation Sheet

rLf=| Fan Coils - [FATMP\BIKY\8_3_BUILDING.BLD] - [Calculation Sheet] = | E] |-,
|:=| Eiles  Project Data View Calculation Sheet Windows Libraries Help = | & =
B =31" I IFYNHE IS E e () AL I -
Blzlulll=l=l=I=&- A - | Al -ls |- 100% |-
Clrsjel (Elely
Metwork Pipe FCU Temperature |Water Des. Pipe Max Water Type Fittings |Pipes Total -
Section Length |Capacity |Difference Flow Pipe Size Vel Velocity |of Fr.Orop |Friction |Friction
(m) (Mcalin) |("C) (m3in) Size (mm) |(mis) |(mis) Fitt. FC Drop Loss
(mm} mWwG (MWG)  |(MmW.G.
1 12 2.6 1.642 1.25" 0.6 0.451 F-1 0.070 0.023 0.004
o 23 22.0 1.003 1" 0.6 0.479 F-1 0.080 0.316 0.396
3 |34 24.4 0.735 kil 0.6 0.557 F-2 0.145 0.617 0.762
4 45 11.2 0.494 kil 0.6 0.374 F-3 0.054 0.140 0.194
5 |56 101 1617 5 0.323 12" 0.6 0.447 F-4 1.035 0.254 1.289
5 |57 07 0.857 5 0171 e 0.6 0.237 F-5 0.250 0.006 0.256
7 |48 0.5 1.204 5 0.241 112" 0.6 0.333 F-5 0.528 0.007 0.535
s .9 0.9 1.338 5 0.268 112" 0.6 0.370 F-5 0.635 0.016 0.651
9 210 0.7 3194 5 0.639 34" 0.6 0.484 F-5 1778 0.014 1.791
10 |
11
12 |
13
14 |
15 |
16 | [ ]
a7
18 i
4 L} 3
16: 9 InAccessible Water Velocity (m/s)

As shown in the figure, each row of the sheet corresponds to a different network section
while each column refers to data that will be inserted or will result automatically during the
procedure of data insertion. Instructions regarding data insertion appear in the status bar.
In each row, first fill in the fields of the first column, which refer to section designations.
Network standardisation is based on the familiar principles explained earlier for the two
pipes heating system.

In the network section, you enter the number of each circuit and its length. Each column-
circuit row is numbered with the column and circuit serial numbers, inserting a full stop ".",
e.g. "1.2", which stands for "column 1, circuit 2". In Fan coils application, all the levels are
shown in the same calculation sheet and the circuits are numbered, starting from 1. If
there are more than one vertical pipes, the numbering of the circuits of each one begins
from 1 (for example, the circuits of vertical pipe 1 will be 1.1, 1.2 etc., the circuits of
vertical pipe 2 will be 2.1, 2.1 etc.).

Please note that each column-circuit row corresponds to a sub-table that contains the
detailed characteristics of the particular circuit. To activate this table, go to the desired line
and press F12 or select "Options" from the list that appears when we press the right
button of the mouse and the following window will open.
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L2 Options @

Polar Angle F || |
Conditioned Space 21
Space Sensible Heat (Mcalh) 2585
Space Latent Heat (Mcalh) 0.235
Entering VWater Temperature (*C) 7
FCLU Model 800
FCU Fan Speed Low
Sensible Load Capacity (Mcalh) 3.019
Latent Load Capacity (Mcalh} 1.045
Type of Pipe W ain
Circulator No

Pipe Dezign Length (m})

b 4

In the above window, the cells “Conditioned space”, “Space sensible heat’ and “Space
latent heat” will be automatically inserted if from the application of Cooling Loads you
have previously exported the results to the Fan coils application (in the Cooling Loads
window, from Files menu choose Export to -> Fan coils) otherwise, you can add them on
your own and automatically the fan coil type will be selected.

If there are more than one Fan Coil unit in the same space, you must intervene by
allocating the load accordingly. Calculation of the fan coil unit is performed automatically
in relation to the information of the network data and displayed in the above window.

Regarding fittings, friction drops, similar sections, Reverse Return type of networks etc.,
same rules as stated earlier for two pipes heating system, can be applied.

3.3.2.3 Cooling Engine

In this window a Cooling engine or a Cooling tower is selected (from Libraries, if F11 or
the appropriate button into the field is pressed) and its operation features are inserted.
Note that detailed calculations for the cooling system are performed within the
Psychrometrics application.

“‘Network Drawing”, “Vertical Diagram”, “Sections friction drop” options, as well as the
windows “Technical Description”, “Assumptions” “Bill of materials” and “Cover Page”
follow the rules stated in the previous paragraphs.

3.3.2.4 Libraries

The "Fan Coils" application libraries contain pipes, FC units and fittings as well as
equipment for the engine-room (Cooling engines, Pumps, Expansion Tanks etc). Each
library category contains various material types, which exist in the market, but it can be
easily updated with the material types you want. As far as the "Fan Coils" library is
concerned, various unit types are registered. Specifically, for each manufacturer a tab is
displayed with fan coil sizes (200, 400 etc.), Z coefficients, codes and costs.

If the key “Loads” is pressed, the corresponding outputs for the various temperatures (dry
bulb, wet bulb and water inlet temperature) are displayed.
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(1

Tempers Dt 178 [17'wB [17WB |18.5WB|18.58|185wE19.5"WB[19.5WB[195WEB| 21'WB |21'WB |21'WB || =
Entering " ater | Total |Sens. [Sens. [Total [Sens. |Sens. |Total [Sens. [Sens.  |Total |Sens.  |Sens.
Z3DB |25DB 25DB [27DB 2/DB [23DB 2fDB |23DB
1 u 1960 1350 1550 2380 1525 1725 2680 1715 1915 3120 1685 1890 A
2 5 5 1790 1270 1475 2200 1450 1650 2480 1640 1840 2925 1610 1810 r
E 6 1620 1190 1400 2020 1370 1575 2330 1560 1760 2745 1535 1735
4 4 1540 1170 1370 [1965 1355 1550 2265 1540 1740 2700 1510 1710
3 T 5 1375 1100 1305 1800 11280 1480 2090 1460 1665 2530 1440 1640
B 6 1180 1025 1210 [1600 1200 1405 1870 1385 1590 2300 1360 1555
7 4 1110 1000 1180 1555 1180 1385 1820 1360 1565 2270 1340 1540
g 9 5 945 935 1070 [1350 1110 1310 1640 1295 1500 2070 1260 1465
E 6 850 850 970 1150 1030 1205 1435 1220 1420 1890 1180 1395 8
[ Cancel ] [ Ok ]

1.1 InAccessible

. ==

-

You can insert and use your own data, easily by selecting a category (e.g. pipes as it is

shown below) and press the append record button . In the new line you fill in the pipe

data (inserting and the Diameters), press H to save them and OK to close the window.

Mo Description

Cooper Tubes
Plastic Pipes
Steel Pipes
Cooper Tubes

Cooper Tuhes TALOS

1
2
3
4
5 Cooper Tubes Outokumpu
f
T
8

Coopet Tubes WICL Rohr
Coopet Tubes TALOS flex

I T— e

Diameters

4
45
1.4
1.5
1.5
1.5
1.5

Asperity
[um]

Standard - Source

Outakumpu

TALOS
WICL
WICL

e

m. |

EBEBII@BIIIII@I
Import == ] [

Import from web==
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3.3.3 Air-Ducts

When the program is loaded, the main menu with the option groups "Files", "Project Data",
"Windows", "Libraries" and "Help" appears on the screen. “Files”, “View”, most “Windows”
options and “Help” are similar to what has been described earlier (paragraphs 3.1.1, 3.1.3
and 3.1.6 respectively), while the rest are summarized below. These options and their
secondary options are described in detail in the following paragraphs.

3.3.3.1 Project Data

This pertains to the project basic data, which are divided into Project info (project
headings) and Network data. Network data include:

Air Supply temperature (°C): In this field you fill in the temperature of the air entering
the space from the supply grilles (15-16°C).

Desired Spaces temperature (°C): This is the desired temperature in the air-
conditioned spaces (significant only if Psychrometrics has not been preceded).

Air-duct material: The Air-duct material to be used is selected (if F11 or the
appropriate button into the field is pressed, the respective library is displayed).

Air-Ducts Roughness Factor (um): Air-duct roughness factor which depends on the
duct material is inserted. If the duct material has been selected from the libraries,
roughness is automatically updated.

Secondary air-duct material: The secondary air-duct material to be used is selected
(if F11 or the appropriate button into the field is pressed, the respective library is
displayed).

Secondary air-ducts Roughness Factor (um): Air-duct roughness factor, which
depends on the secondary duct material, is inserted. If the duct material has been
selected from the libraries, roughness is automatically updated.

Maximum air velocity (m/s): This field concerns the upper air velocity limit in the air
ducts. This value is used as an upper limit if the method of equal pressure drops is
applied or it is taken as the value of the air velocity when the method of equal velocities
is applied instead.

Pressure drop per meter (mm. W.G./m): This is the value of the corresponding
network pressure drop per m when the equal friction method is applied, while it is of no
significance if the method of velocity reduction is applied instead.

Type of Cross-Section: Cross section type in the longest part of the network is
inserted (circular, square or rectangular). Of course, there is always the possibility to
modify it in a specific section of the network.

Desired Air-duct dimensions (width and height): The desired air duct dimensions
should be determined only if rectangular air ducts are selected where you are able to
define a fixed value for width or height. Note that, when both dimensions of the air-duct
rectangular cross section are determined (or one dimension for circular or square cross
sections), then the velocity and pressure drop in each network branch are determined
without following the principles of any of the available methods. On the contrary, if only
one dimension is inserted, height or width, then the other dimension results
automatically from the selected calculation method. Of course, the fixed value for
height or width determined here, does not constrain you because there is always the
possibility to modify it in a specific section of the network.
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¢ Rounding step of Air-duct dimensions (mm): In case that accuracy to mm is not
needed, the air-duct cross-section value is calculated approximately in increments (e.g.
50 mm).

e Grilles Sound Level (dB): This field concerns the upper limit of the noise level at
grilles, which should not be exceeded. This limit can also be selectively modified for a
specific room grille.

e Desired grilles dimensions (length and width): Similar instructions to those given
above for the desired air duct dimensions are applied.

¢ Number of Fans: It concerns the number of the installation Fans (1-40).
¢ Energy units: You can choose the units of the results among Mcal/h, KWatt or KBtu/h.

e Calculation Method: You can select the calculation method among the three
available, a) Velocity reduction b) Equal friction and c) Static regain.

¢ Minimum Air velocity (Regain method): This concerns the minimum air velocity in
case the Static regain method is selected. You should keep in mind that you are
allowed to insert a minimum velocity limit value, if the velocity at the air outlets is
considered very low.

¢ Speed calculation method: You can select the speed calculation method between the
one with Equivalent cross section area or with Real duct cross section area.

3.3.3.2 Calculation Sheet

4+ Air-Ducts - [FATMP\BIKY\8_3_BUILDING.BLD] - [Calculation Sheet] |
1*" Files Project Data Calculation Sheet  Edit View Windows Libraries Help - |5 =
0SSR (e=]m =Y % =@
B 7 U E]E = & AL A -0 |- AR 100% |-
e ET A I ER T e
MNetwork |Conditioned |Space |Temperature|Air Flow|Duct Duct Fric.Orop Air Type Fittings [AirDucts |Total Polar  [AirDuct -
Section |Space Loads |Difference |(m3/h) |Leng. Cr.Sect.|per m. Velocity |of FrDrop |Fri.Drop |Friction [Angle |1:Circ.
(Mcal/h)|(°C) {m) (cm2) |(mmW.Gim) [(m/s) |Fitt (mmWG)|(mmWG) Loss E 2:3quare
(MW.G.) 30rth.
1 12 10872 545 7375 004 6.00 F-1 4.41 0.24 465 Orthogonal
2 [23 270 Orthogonal
3_2.4 10872 3.00 T3TS 004 6.00 2 3.09 0.13 322 Orthogonal
4_4.5 8229  3.00 5125 005 6.00 2 3.09 0.16 3.24 Orthogonal
5_5.5 5486  3.00 3125 0407 6.00 2 3.09 0.20 329 Orthogonal
rBJ 2743 875 1500 0.08 5.52 F-2 4.85 072 5.58 Orthogonal
7_?.8 1042 1.26 7500 008 4.34 2 1.61 0.10 172 Orthogonal
3_8.9 5.2 1.56 9.00 5977 572 5000 0.08 378 F-3 1.05 0.47 1.52 Orthogonal
9_8.10 5.4 116 9.00 4444 283 3750 008 3.50 g 0.38 0.23 0.61 Orthogonal
F?.‘H 1701 234 1000 0.08 4.90 2 2.08 0.19 2.25 Orthogonal
T‘I‘I 12 5.5 1.30 9.00 4981 427 3750 008 3.62 1 0.48 0.36 0.84 Orthogonal
F‘H 13 51 314 9.00 1203 196 7500 008 4.49 8 0.62 0.16 0.78 Orthogonal
FB.‘M 2743 575 1500 0.08 5562 F-1 373 0.48 421 Orthogonal
?1415 1042 126 7500 008 434 2 1.61 0.10 172 Orthogonal
?15 16 42 1.56 9.00 8977 572 5000 008 378 F-3 1.05 0.47 1.52 Orthogonal -
P m b
11 View MNetwork Section

As shown in the figure, each row of this sheet corresponds to a different network section
while each column refers to data concerning this network section (see status bar). The
operation concepts are based on the principles stated earlier. The starting point of the air-
duct network (where the fan is located) corresponds to the number 1. The total air flow
rate in each space can be calculated either approximately based on the Space load and
the Temperature difference between supply and return air or accurately if Psychrometric
Calculations have been previously performed (see Psychrometrics application). Given
the values of those data, flow rate values are summed up properly and are automatically
displayed in the Air flow column. Based on these flow rates in each network section and
the calculation method (equal pressure or velocity), air-duct dimensions as well as
standard sizes for the grilles are determined in each section. Air-duct cross section
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(circular, rectangle etc.) and its desired dimensions are those entered in the general data,
but you modify or insert any other desired dimension here.

Based on the above dimensions, effective air velocity and pressure drop can be
calculated in the calculation sheet.

Finally, the respective grille dimensions are also determined so that the noise level,
specified in general data, is not exceeded. The grille dimensions are automatically
calculated after a grille type has been selected on Network window from the respective
library by pressing F11 or the appropriate button into the field, as it is shown below.

& Air-Ducts - [Ftrp)BIKYYE_3 BUILDING BLD] - [Calculation Sheet] S ==
Al Files ProjectDate  Calculation Sheet  Edit View Mfindows Libraries Help
Dsd| S8 | lulm =l FAETS
HEEEE Oy +| A Metwork Options Al [®]
Eiﬂlilﬁ} &Ll Air Suply Temperature (°C) 16
Desired Spaces Tempersiure (°C
Metwork |Conditioned |Space |Tempg 4 i L - [Total Polar  |AirDuct Ces.WidDes Hei Grilles |Type of | Type D »
gection |Space Loads |Differel  ajr puct Material Friction |Angle 1:Cire or Diamjof Duct |Sound | Duct G|
icaliny| gy | O eer Sige]shicet @ ke F 25quare ofDuct |gmm)  |Level Grille  |Le
— Air Ducts Factor (im) i Qrth, ; fulu] = (dB) =
1 4 Type of Materials ogonal ain
: b3 Secondary Air-Duct Material Cll = ogonal 250 Main
E a :
3 |24 Secondary Air-Duct Roughness Factor (im) &l dh oganal 250 [Main
a5 Max Alr Welosty (mis) be Descleion il "eTCET | LTI e o
5 [56 u 1 Stasl shest . 3 aganal 250 Ma!n
[ Pressure Drop per meter (mm WG in) ] 2 Plastic [ cancel | Jogenal 250 Main
7 |78 aganal 250 Main
5 |ag 52 156 gon | TvpeofCrossSection ] J)lexble agonal 250 a0 Main  T-50 Fl
g g0 &4 116 800 | Des A DuctWiokt i) (Orthog) ] AiFledbla melal ngnnal 260 30 Main  T-50 i
10 [F11 ogonal 250 Main
11 1112 &5 1an  gon | DeESArDuetegh (mm) Orheg.) agonal 250 a0 Main  T-50 FY|
12 1113 A1 314 900 | Rounding Step of Air Duct Dimensions (mm) ogonal 250 30 Main  T-50 F¥l
13 [514 Griles Sound Level (dg) T LELIC] 250 Main
14 [14.15 72 Crthogonal 250 Main
15 1516 42 156 900 | Desired Griles Length (mm) 52 Orthogonal 250 30 Main  T-50 F¥l
16 1517 44 TA6 800 | pecined Grites Vinth gmm) 51 Orthogonal 250 30 Main  T-50 F¥l
17 _[1418 B.25 Onthagonal 250 Main
18 [18.19 45 130 .00 | MmberofFans(140) 1 o 84 Orthaganal 250 30 Main  T-50 Fl
19 1_52.120 44 344 800 | Energylnts . 4.;18 g::ogona: i:g 30 Ea?n T-50 Fyl
20 2 agona ain
21 P12z Skl Wetiod Eausl Friction 72 Orthogenal 250 Main
22 |22.23 32 1.56 3.00 Min Alr Welocity (Regain Method) (mis) 1 .52 Orthoganal 250 30 Main T-50 Fyl
23 [2234 34 BB 800 | o et 61 Orthagenal 250 30 Main  T-50 Fyl
24 [21.35 i ot eelyelent iemeter £.25 Orthogonal 250 Mair
26 [2526 35 130 9.00 | e 84 Orthagonal 280 30 Main  T-50 Fyl
26 [25.27 34 314 900 =) AR 57 Orthogonal 250 30 Main  T-50 F¥l
27 428 F11 : Select Material |4 2 Orthogonal 250 Main s
R i v
[ %1 view Network Section H

The grille width, height and existing noise level are displayed at the bottom of the
calculation sheet window. Note that in the middle of the window, it is possible to insert the
desired dimensions (usually one of them is inserted in the general data and the other one
is automatically calculated).

Fittings of the air-duct network (e.g. elbows, T-junctions etc.) are entered for each section
in the column “Type of fittings” by activating the corresponding window with F11 or the
appropriate button into the field.

Note that, in case the equal friction method is used and you want to balance the
network, dampers can be adjusted accordingly (keep in mind that the equal pressures
method ensures well "balanced" networks only if the network has been symmetrically
designed). The column “Air ducts Friction Drop” shows how well balanced the network is
and indicates which sections need restriction using dampers.

If the method of static regain is applied instead, then friction losses in each network
section are balanced by the recovered static pressure, which in turn depends on the
velocity in the previous and next section. So, nothing appears in “Total friction loss”
column (zero friction losses), except for the first network section that starts at the fan
(section 1.2 in the above example) and, of course, the sections where you have specified
both dimensions of the air-duct cross section. Consequently, total friction losses in this
case are equal to the friction losses in the first section, which starts at the fan.
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All the above apply to the air supply network. The return network is standardised
similarly by determining again junction points and (outlet) grilles and assigning a slightly
lower flow rate, compared to the supply grilles, to each grille (i.e. 70-80% of the air inlet
flow rate so that room is slightly over-pressurised). Apparently, the return network is
completely independent and does not have grilles in all rooms. Since the fan has to
overcome friction losses for the most mailing supply and return section, the corresponding
friction losses are added and displayed in the calculation sheet.

In the case of typical (similar) air-duct network sections, it is possible to recall them (with
their name from the first column) in order to automatically transfer them.

Note: The Air-duct program is also suitable for any other ventilation project. In order to
calculate a ventilation network, it should be first standardized as previously explained with
the only difference that the load and temperature differences should be deleted (from the
corresponding column) and flow rates for all sections terminated in grills should be

inserted. Furthermore, sections should be inserted with “.” and not wit ' as there is not
a secondary network.

3.3.3.3 Fan Calculation

In order to use and calculate more than one fan, you must first define in the “Network”
window the “Number of fans” (Project Data -> Network). After that, in the calculation sheet
you will fill in the number of each fan in the “Fan No” column, remembering that each fan
that covers the requirements of a network section, should be set in the starting section of
the network (see image below). In the “Fan No” column you type directly the fan number
or press F12 or select "Options" and fill in the “Fan number” cell.

‘*‘ Calculation Sheet E@
Network AirDucts |Total Polar  [AirDuct Des WidDes.Hei Grilles |Type of [Type Des. Des Duct AirDuct |Grille  |Grille  |Grille  |Range [Range [Fanho |L =
Section FriDrop |Friction [Angle |[1:Circ. or Diam|of Duct |Sound | Duct |of Grille |Grille  [Width |Height [Lenght |Width |Noise (A Grille |B Grille N

(mMmWG) |Loss F 2:3quare  |of Duct |(mm) |Level Grille |Length (Width ((mm) [(mm) |(mm) |(mm) |{dB) (m) (m)
al (mW.G) 3:0rih. mm (dB)

1 e 61 498 Orthogonal 250 Main 5000 250.0 |

2 [23 0.32 251 Orthogonal 250 Main 450.0 2500

3 [34 0.40 327 Orthagonal 250 Main 4000 2500

4 45 0.57 1.65 Orthogonal 250 30 Main K104 Al 250.0 250.0 4550 4550 2961 412 2

5_45 0.15 1.08 Orthogonal 250 30 Main K104 Al 250.0 250.0 4550 4550 2849 395 2

5 |27 o.02 073 Orthogonal 250 30 Main K104 Al 100.0  250.0 3050 (305.0 2168 233 2

7_2 8 0.08 072 Orthogonal 250 30 Main K104 Al 100.0 250.0 3050 305.0 2166 233 2

s [[1o lozs 078 Orthogonal 250 30 Main 1500 2500

g [9.10 0.28 0.66 Orthogonal 250 30 Main 150.0 2500

Wmﬁ 0.09 074 Orthogonal 250 30 Main K104 Al 150.0 250.0 3800 3800 2102 283 2
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The program allows the use of one to forty different Fans and you can calculate them from
Windows -> Fan calculations. For the selected Fan (type its number in the first row) the
total network airflow and the total friction drop of the section with the highest pressure
drop are displayed in the window.
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ﬁ' Fan Calculations EI@

Fan Mo 1 |

Air Flow (m3/h)

Most Malign Section (mmWG)

Metwork Friction Drop {(mm W.G.)

Filters Friction Drop (mmWG)

Alternatar Air - Air Friction Drop

Air Conditioning Unit Friction Drop (mmWG)
Other Friction Losses (mm W.G.)

Static Pressure (mmW.G.) 0.00
Type of Selected Fan

Size

Flow Rate

Static Pressure

Motor Power Qutput

Electrical Data

Cost

Regarding the selected Fan number (1, if only one fan exists), the following data appear:
e The calculated air flow in m%/h, according to the calculation sheet data.

e The highest pressure drop section (in mmWG), that is the section with the highest
friction losses.

e The total Network (pipes and fittings) Friction Drop, which corresponds to the above
section and has been calculated in calculation sheet.

e The filters, alternator air-air and air-conditioning unit friction drops as well as other
friction losses (for safety reasons, some further friction losses are supposed, that is the
theoretically calculated friction values are usually increased by approximately 20-30%,
in mmWG).

If the above friction values are added together, the result will be the installation total Static
pressure (in mmWG). In order to select a fan type from the program libraries, press F11 or
the appropriate button into the field "Type of Selected Fan".

When you select the fan type, the following options will be completed automatically and
you fill in only the Cost.

3.3.3.4 Libraries

The "Air-ducts" application libraries include duct materials, grilles, fittings and fans as well
as the common Offer libraries. As in any other application, each library category contains
various material types, which exist in the market, but naturally it can be updated with the
material types you want. Fittings libraries contain the various air-duct fittings in list form
while the main features of each fitting [Z coefficient (resistance) and cost] are also
mentioned. Duct material library contains different types of materials (e.g. from Tin Plate,
Plastic, etc.), along with their roughness and specific gravity and thickness. As for the
"Grilles" library, it contains grille types with their standard dimensions and all other
features needed for the calculations. You can insert and use your own data, easily by
selecting a category (e.g. grilles as it is shown below) and press the append record

button. In the new line you fill in the grille data (inserting and the Size), press to
save them and OK to close the window.
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All suppliers v] [AH categories

[ Ok ] [ Cancel ] [

Size

MNo Description Coefficient Range
| s z Factor
M 1 ET40FYROGENIS 27 16.66
[| 2150 FyROGENIS 761 1403
| 3/k104AFYROGENIS 629 8234
|| 4/k1048 FYROGENIS 6.52 15.04
| s/k1034 FYROGENIS 75 1549
|| &/k1038 FYROGENIS 72 17.43
|| 7/k1024 FYROGENIS 93 1388
| s/k1028 FYROGENIS 95 1474
|| alk1014 FYROGENIS 9.02 19.95
| 10/k1018 FYROGENIS 95 1958
[ 1m30 28 1666
|| 12/B13 51 6134
| 1ae17 297 1597
| 14/t 7.61 16.20
| 1s/ts2 761 1403
| 16133 761 1310
|| 17/t54 7.61 1123
] 18tk 4638 1857
| 19tk 5552 1494

Flow Supplier Agent
Proportion
Factor

| FYROGENIS Orthogonal
FYROGENIS Orthagonal &
FYROGENIS Orthagonal

0.84 FYROGENIE Orthogonal

0773 FYROGENIS Orthogonal_ |

072 FYROGENIZ Orthogonal
FYROGENIS Qrthogonal
FYROGENIS Orthogonal
FYROGENIS Orthogonal
FYROGENIS Orthogonal
FYROGENIS Orthagonal
FYROGENIS Orthogonal
FYROGENIS Orthogonal
FYROGENIS Orthogonal
FYROGENIS Orthogonal
FYROGENIS Orthogonal
FYROGENIS Orthogonal
AEROGRAMMI Orthagonal
AEROGRAMMI Orthogonal

C
Import == ] [ Import from web=>

v

Edit drawing
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3.3.4 Psychrometrics

Based on the analytical psychrometric equations, this program carries out the air-
conditioning unit selection and the air distribution in the air-conditioned spaces while it
also provides the psychrometric variation on the psychrometric chart as a result. When the
program is loaded, the main menu with the option groups "Files", "Project Data", “View”,
"Windows" and "Help" appears on the screen. “Files”, “View”, “Help” and most of the
“Windows” options are quite similar to the “Heating losses” application and are discussed
in detail in paragraphs 3.1.1, 3.1.3 and 3.1.6 respectively. The rest are summarized in the

following paragraphs.

3.3.4.1 Project Data

These are the basic data of the installation. They are divided into Project info (headings
of the project), Calculation parameters, Indoor and Outdoor design conditions and,
finally, Spaces data.

1) Calculation Parameters concern the following:

¢ Minimum temperature of the psychrometric chart: Define the minimum temperature
(°C), which will be shown in the psychrometric chart.

e Maximum temperature of the psychrometric chart: Define the maximum
temperature (°C), which will be shown in the psychrometric chart.

¢ Energy units: You can select among Mcal/h, KWatt or KBtu/h units.

e Outside air: The required outside air can be inserted either as a volume (in m*/h) or as
a percentage of the total air (%).

¢ Heat recovery unit: If a heat recovery unit is used, you select its type (Heat Recovery
Ventilator or Energy Recovery Ventilator) otherwise you choose “No”.

¢ Air-duct losses: Check this box if you want to take into account air duct losses,
otherwise, they will be ignored.

e Fan losses: You select "No" if you want the fan losses to be ignored, or choose
between “Before” if the fan is located upstream of the air-conditioning unit, or "After" if
the fan is located downstream of the air-conditioning unit.

e By-pass factor BF: This concerns the air-conditioning unit by-pass factor and varies
between 0 — 1 (0 means no by-pass at all, 1 means 100% by-pass).

o Coolant temperature difference: Fill in the temperature difference of the coolant
medium (°C).

¢ Heating medium temperature difference: Fill in the temperature difference of heating
medium (°C).

¢ Outside air percentage: In case you have required the outside air to be inserted as a
percentage, fill it in, in this field.

¢ Air duct losses in percentage of room loads (%): In case you have checked the “Air
duct losses” box, define them here as a percentage of the room loads.

¢ Fan losses: In case you take into account the fan losses, you can define the load here
(if you want, you can modify it in the “Systems” window later, selecting the specific
system). The energy units are those that have been selected in “Energy units” field.

e Percentage of supply air exhausted from space (%): In this field, you fill in the
percentage of the supply air that is exhausted from the space.
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2) Indoor design conditions concern the following:

Altitude: Fill in the altitude of the location in m.

Outside air preheating: If a preheater is used in the heating system, select “Yes” in
this field (you can also select or change it later in the “Systems” window).

Exit air temperature from preheater: In this field fill in the temperature of the air that
is leaving the heater (you can also select or change it later in the “Systems” window).

Desired indoor temperature in summer:
This concerns the desired temperature (in
°C) of the cooled rooms.

Desired indoor relative humidity in
summer: This concerns the desired relative
humidity (%) of the cooled rooms.

Desired indoor temperature in winter:
This concerns the desired temperature (in
°C) of the heated rooms.

Desired indoor relative humidity in

Indoor Design Conditions Lﬁ

Desired Indoor Temp. in Summer (*C} m

Desired Indoor Rel. Humidity in Summer (%) 5p g
Desired Indoor Temp. in Winter ("C) 20.0

Desired Indoor Rel. Humidity in Winter (%}

wn

0.0

[ ok || Ccancel

e ]

winter: This concerns the desired relative humidity (%) of the heated rooms.

3) Outdoor design conditions concern the outdoor temperature and relative humidity
values during the day in summer as well as in winter.

4) Spaces

The data that will be used for the calculation of the air-conditioning units for each space
should be typed in this window.

Space Options @1
Level Mo |Space Mame Sys. Time |RSH RLH WRSH VA o
(Kwatt)  [(KWatt) (KWatt) (m3/h)
1 2 1 Living Room 1 17 31 0.1 17
2 2 2  Bedroom 1 1 17 1.6 0.1 1.0
3 2 3 Bathroom 1 7 0.6 0.1 0.5
4 2 4  Bedroom 2 1 17 07 0.1 07
5 2 5  Kitchen 1 17 1.2 0.1 1.1
6 3 1 Living Room 1 7 3.1 0.1 1.7
7 3 2  Bedroom 1 1 17 1.6 0.1 1.0
8 3 3 Bathroom 1 7 D& 01 0.5
9 3 4 Bedroom 2 1 17 07 0.1 07
0 3 5  Kitchen 1 17 1.2 0.1 1.1
il 4 1 Living Room 1 7 3.1 01 17
12 4 2 Bedroom 1 1 17 1.6 0.1 1.0
13 4 3 Bathroom 1 17 06 0.1 05
14 4 4 Bedroom 2 1 7 07 01 07
15 4 5  Kitchen 1 17 1.2 0.1 1.1
16 5 1 Living Room 1 17 3.1 0.1 17
17 5 2  Bedroom 1 1 7 1.6 01 1.0 1
Ok | [ cancel
Level Level

More specifically, for each space the following data should be typed:

o The level where the space is, its number and name.

e The system where the space belongs.
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The hour when the maximum load appears, regarding the system where the space
belongs.

The sensible (RSH) and latent (RLH) cooling load of the space.
The thermal losses of the space (WRSH).
The required outside air quantity of the space (VA).

The above data will be automatically completed as long as you have followed the
following procedure:

1)

For the cooling loads and the quantity of fresh air to be transferred:

- From the Cooling loads application, in the Calculation Sheet you fill in the “System or
Zone” for each space (in case you have more than one system).

- When you finish, you select from Files -> Export to -> Systems - Psychrometry (total,
spaces of ventilation loads)

- Open the Psychrometrics application and select Files -> Import from -> Cooling

For the thermal loads to be transferred:

- When you finish the Thermal losses application, select Files -> Export to -> Systems
- Psychrometry

- Open the Psychrometrics application and select Files -> Import from -> Heating

3.3.4.2 Psychrometric Point Calculations

If this option is selected from the “Windows” menu, the basic psychrometric calculations
are performed. In the following image if you provide two of the six basic psychrometric

quantities and press F8 or the calculation button from the toolbar, the remaining four
quantities will be calculated.

,ﬁ Psychrometric Point Calculations EI@

Dry Bulb Temperature (*C)

Wet Bulb Temperature ("C)
Relative Humidity (%)
Velume (m3/Kg)

Enthalpy (KjKg)

Humidity (grikg)
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3.3.4.3 Systems

This option is the main window of the Psychrometrics application (you open it from
Windows -> Systems). When it is selected, the air-conditioning unit calculation is carried
out for each one of the Systems, in which the spaces have been grouped.

T Peychiometry - [CARINELL HVAC\CALC\TEST.BLD) = =]
Eies PropectDats Yiew Windows Help

QS A || B rde ol
(B o] A L
o e I =N e s 5 Y Y

Crolng WERGLE defmicication, pret &

Desired Temperaturs in Summer (°C) Tree
Desired Foslative Humedty in Sunmar (%) Fr
Outdoor Trmperaturs in Summer ("C) Tadh
oo Fislativs Humdly i Suser (%) Fa
Systrm Servsile Heal (KWelt) RSH

Systan Latert Hest (iva) FiLb
Cudsate o

1TV w © ardko 2

Cutzide Ak Gusntty (m3h or Percentage (%) Va  S44.58
PR Tr—— Ny

HUML

Fercentage of Load Lows in the Ar-Ducts (%) 0
FanLosses N

Total Fan Load (Kvee) 0

Erygass Factor B 0150
Coolant Tempersture Difterence (°C) DT

st recavary Uk

EE e ] IRY RULE TEMPERATLRE t ¢ C 3

Solulion Method . C

Ciesired Temgerature

Deesired Hurmidity

Duldoor Tempurature

Outdiar Humidity a ‘ E 1450 grikge
Mizad Alr Foint Tamparatiss . : 3 L TR
Mezed Paing Humidity F - Wm - 14.50 gukge
Dew Poird Temperature - B =2103 °C

Do Bt Hurnidity a i 1450 gikge
Entaring Tamparatura . . 3 C - 419 %0
Enteeing A Weinass s : - 1450 grkgr
Outlel Ternperabare - B -2153 *C
Leanving Ao Wotniss . 1450 gukge
Entieing Viates Tompbratuns 4 sawt b G- 2153 °C
Supnly Alr Yieiness - i = 1450 grkgr

F11: Select Memod Fil: Calculabons

The systems window provides a list of the systems on the left side (System 1, System 2
etc.) while the Cooling and Heating tabs appear on the upper side. In this way you can
access any system, either Cooling or Heating, and follow the instructions given in the next
section. Note that, for better monitoring of the results, you can have on screen a) the
above window with all the information shown at the same time b) just the psychrometric
chart or c) just the results. Switching between the above three monitoring ways is enabled
through the three relative icons of the toolbar (see adjacent image) when the window
“Systems” is active. As far as data, applicable methods and
calculation results are concerned, a detailed description follows for

both the cooling and the heating application.

A. Cooling
In order to calculate a Cooling System, the following data should be typed:

e Desired temperature in summer (°C): This concerns the desired indoor temperature
in the cooled rooms. This option is filled in automatically with the value that was given
in “Calculation parameters”.

¢ Desired relative humidity in summer (%): This concerns the desired indoor relative
humidity in the cooled rooms. This option is filled in automatically with the value that
was given in “Calculation parameters”.

e Outdoor temperature in summer (°C): This concerns the outdoor temperature at the
peak hour of the System. This option is filled in automatically with the value that was
given in “Calculation parameters”.

-100 - FINE - HVAC



e Outdoor relative humidity in summer (%): This concerns the relative humidity at the
peak hour of the System. This option is filled in automatically with the value that was
given in “Calculation parameters”.

o System Sensible Heat: This is the sensible cooling load of the System at its peak
hour. It is completed automatically from the sum of the sensible load RSH of each
space of the system (from “Project Data” -> “Spaces”).

¢ System Latent Heat: This concerns the latent cooling load of the System at its peak
hour. It is completed automatically from the sum of the latent load RLH of each space
of the system (from “Project Data” -> “Spaces”).

e Outside air: The required outside air can be provided either as quantity in m*h or as
percentage. This option is filled in automatically with the value that was given in
“Calculation parameters”.

¢ Outside air quantity (m®h) or percentage: This concerns the total outside air of the
System in m3h or the respective percentage. It is completed automatically from the
sum of the air capacity VA of each space of the system (from “Project Data” ->
“Spaces”).

e Air-duct losses: You enter either "No" if you want to ignore the air duct losses, or
"Yes" if you want them to be taken into account in the calculations. This option is filled
in automatically with the value that was given in “Calculation parameters”.

¢ Percentage of load loss in the air-ducts: In case you have selected “Yes” in the “Air
duct losses” box, define here the percentage of the system loads. This option is filled in
automatically with the value that was given in “Calculation parameters”.

¢ Fan losses: In case you take into account the fan losses, you can define the load here.
This option is filled in automatically with the value that was given in “Calculation
parameters”.

e Total fan load: To be inserted only if the fan load is to be taken into account in the
calculations. This option is filled in automatically with the value that was given in
“Calculation parameters”.

e Bypass factor BF: This concerns the air-conditioning unit by-pass factor which varies
between 0 - 1. This option is filled in automatically with the value that was given in
“Calculation parameters”.

e Coolant temperature difference DT (°C). Based on the coolant temperature
difference after it passes through the cooling element, the required quantity of the
coolant can be calculated. This option is filled in automatically with the value that was
given in “Calculation parameters”.

¢ Heat recovery unit: If a heat recovery unit is used, you select its type (Heat Recovery
Ventilator or Energy Recovery Ventilator) otherwise you choose “No”.

¢ Sensible effectiveness: When a heat recovery unit has been selected, in this field you
fill in its sensible effectiveness.

¢ Latent effectiveness: When a heat recovery unit has been selected, in this field you fill
in its latent effectiveness.

After the above information have been specified, you follow the steps | and Il which are
described below:
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Method Selection:

If the arrow in the first field is pressed, a window will appear listing the seven methods
included in the program:

Solution Method

Cooling with drying, with reheating

Cooling with drying, with return air by-pass
Cooling with drying, 100% fresh air

Cooling without drying, pre-cocled air
Cooling with drying, pre-cooled air

1. Cooling and dehumidification, without reheating: This is the most common method.

. Cooling and dehumidification, with reheating: It is usually used when the latent load

is high in comparison to the total loads (e.g. ball rooms).

. Cooling and dehumidification, with return air by-pass: Part of the return air is by-

passed through the unit-cooling element.

. Cooling and dehumidification, 100% outside air: It is used in applications where it is

necessary to have supply air coming totally from outdoors (e.g. surgeries).

. Cooling without dehumidification, pretreated air: This method should be selected if

the air-conditioning unit is to undertake only the outside air load while the room loads
are covered by Fan Coils or another unit.

. Cooling and dehumidification, pretreated air: The same as the previous method but

with dehumidification.

. Precooled air with heat exchanger, pretreated air: This method is selected in order

to calculate the temperatures and total heat of the heat recovery unit.

Calculation Activation:

While in the Systems screen, press F8 or the button from the toolbar and the
calculations of the air-conditioning unit of each System will be executed. The results
appear at the bottom of the page while the psychrometric chart showing the respective
psychrometric variation is displayed on the right. More specifically, the appearing results
are:

The air mixture conditions (dry and wet bulb temperature, absolute and relative
humidity).

The air inlet conditions in the air-conditioning unit (dry and wet bulb temperature,
absolute and relative humidity).

The air outlet conditions from the air-conditioning unit (dry and wet bulb temperature,
absolute and relative humidity).

The air inlet conditions in the air-conditioned rooms (dry and wet bulb temperature,
absolute and relative humidity). Note that there are two ways to alter the air supply
temperature in the spaces:

¢ Modifying the by-pass factor of the air-conditioning unit.

¢ Modifying the calculation method and using the "Air return By-pass" method.
The effective coefficient of sensible heat.
The coefficient of the system sensible heat.

The coefficient of the air-conditioning unit sensible heat.
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The quantity of the air delivered by the air-conditioning unit, the fresh air, the supply air
and the return air.

The fresh air loads.
The air-conditioning unit loads.

The cooling element supply.

B. Heating
For the calculation of a Heating System, the following data should be inserted:

Desired temperature in winter (°C): This concerns the indoor desired temperature in
the heated rooms. This option is filled in automatically with the value that was given in
“Indoor design conditions”.

Desired relative humidity in winter (%): This concerns the desired indoor relative
humidity in the heated rooms. This option is filled in automatically with the value that
was given in “Indoor design conditions”.

Outdoor temperature in winter (°C): This concerns the outdoor temperature at the
peak hour of the System. This option is filled in automatically with the value that was
given in “Indoor design conditions”.

Outdoor relative humidity in winter (%): This concerns the relative humidity at the
peak hour of the System. This option is filled in automatically with the value that was
given in “Indoor design conditions”.

System Sensible Heat: This is the sensible heating load of the System at its peak
hour. It is completed automatically from the sum of the sensible load WRSH of each
space of the system (from “Project Data” -> “Spaces”).

Outside air quantity (m3/h) or percentage (%): This concerns the total outside air of
the System in m3/h or the respective percentage. It is completed automatically from the
sum of the air capacity VA of each space of the system (from “Project Data” ->
“Spaces”).

Air-duct losses: You enter either "No" if you want to ignore the air duct losses, or
"Yes" if you want to be taken into account in the calculations. This option is filled in
automatically with the value that was given in “Calculation parameters”.

Percentage of load loss in the air-ducts (%): In case you have selected “YES” in the
“Air duct losses” box, define here the percentage of the system loads. This option is
filled in automatically with the value that was given in “Calculation parameters”.

Fan losses: In case you take into account the fan losses, you can define the load here.
This option is filled in automatically with the value that was given in “Calculation
parameters”.

Total fan load: To be inserted only if the fan load is to be taken into account in the
calculations. This option is filled in automatically with the value that was given in
“Calculation parameters”.

Bypass factor BF: This concerns the air-conditioning unit by-pass factor which varies
between 0 - 1. This option is filled in automatically with the value that was given in
“Calculation parameters”.

Heating medium temperature difference (°C): Based on the heating medium
temperature difference DT after it passes through the heating element, the required
quantity of the heating medium can be calculated. This option is filled in automatically
with the value that was given in “Calculation parameters”.
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¢ Heat recovery unit: If a heat recovery unit is used, you select its type (Heat Recovery
Ventilator or Energy Recovery Ventilator) otherwise you choose “No”.

¢ Sensible effectiveness: When a heat recovery unit has been selected, in this field you
fill in its sensible effectiveness.

¢ Latent effectiveness: When a heat recovery unit has been selected, in this field you fill
in its latent effectiveness.

¢ Outside air preheating: In this field you select if the entering outside air is preheated
or not.

¢ Exiting air temperature from preheater: If you chose “Yes” in the previous field, enter
here the temperature of the air when it is exiting the preheater.

After having set values on the above, the steps | and Il that are described below should be
followed at this point as well:

I Method Selection:

If the arrow in the first field is pressed, one of the nine methods included in the program
can be selected:

ol

Heatlng with humldlfcﬂtlun Steam (cooling has not preceded)
Heating without humidification {cooling has preceded) E
Heating without humidifization {cooling has not preceded)

Heating without humidification - Steam, pre-cooled air

Heating weith humidification-Steam, pre-cocled air bl

1. Heating and humidification - Steam (cooling has preceded): This method involves
air heating and humidification with a steam humidifier. The air inlet quantities will be
those already calculated in the cooling calculations.

. Heating and humidification - Steam (cooling has not preceded)
. Heating without humidification (cooling has preceded)

. Heating without humidification (cooling has not preceded)

. Heating without humidification — Steam, pretreated air

. Heating and humidification - Steam, pretreated air

. Heating and humidification - Spraying (cooling has preceded)

0o N OO 0B~ WODN

. Heating and humidification - Spraying (cooling has not preceded)

9. Heating and humidification - Spraying, pretreated air

10. Preheated air with heat exchanger — pretreated air

Il. Calculation Activation

While in the Systems screen, press F8 or the button from the toolbar and the
calculations of the air-conditioning unit of each System will be executed. The results

appear at the bottom while the psychrometric chart showing the respective psychrometric
variation is displayed on the right.

More specifically, the results are:

e The air mixture conditions (dry and wet bulb temperature, absolute and relative
humidity).
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e The air inlet conditions in the air-conditioning unit (dry and wet bulb temperature,
absolute and relative humidity).

e The air outlet conditions from the air-conditioning unit (dry and wet temperature,
absolute and relative humidity).

¢ The air inlet conditions in the air-conditioned rooms (dry and wet bulb temperature,
absolute and relative humidity)

¢ The effective coefficient of sensible heat.
e The coefficient of the system sensible heat.
e The coefficient of the unit sensible heat.

e The quantity of the air delivered by the air-conditioning unit, the fresh air, the induced
air and the return air.

e The outside air loads.
e The air-conditioning unit load.
¢ The heating element supply and finally.

¢ The humidification water quantity.

3.3.4.4 Space Conditions — Cooling

If you select from Windows -> Space Conditions — Cooling, the supply and return air as
well as the prevailing conditions in the space after the air supply (dry and wet bulb
temperature, absolute and relative humidity) are displayed for all the spaces.

.
28 Psychrometry - [FATMP\BIKY\8_3_BUILDING.BLD] - [Space Conditions - Cooling] =NEEN X
‘_ﬁ Files Project Data View Windows Help = |[&] =

EICIEECEC = e e (%]
B2 [5] EEEE & e T [
BleEk @ (gejale
Space Conditions - Cooling -
L. Mo SYS. SPACE MAME VEA WE THDB THWB WH FH
ma3ih maih oL °C grikar %
2 1 1 Living Room 111385 111385 26.00 18.62 10.55 50
2 2 1 Bedroom 1 554.68 554.68 26.00 18.67 10,61 50
2 3 1 Bathroom 198.06 198.08 26.00 18.85 10.85 51
2 4 1 Bedroom 2 241.72 24172 26.00 18.80 10.78 51
2 5 1 Kitchen 417.29 417.29 26.00 18.70 10.66 50
3 1 1 Living Room 1113.85 1113.85 26.00 18.62 10.55 50
3 2 1 Bedroom 1 554.68 554.68 26.00 18.67 10,61 50
3 & 1 Bathroom 198.06 198.06 26.00 18.85 10.85 Ly |
3 4 1 Bedroom 2 24172 24172 26.00 18.80 10.78 51
i T 1 Kitchen 417.29 417.29 26.00 18.70 10.66 50
4 1 1 Living Room 111385 111385 26.00 18.62 10.55 50
4 2 1 Bedroom 1 554 68 554 68 26.00 18.67 10.61 50
4 3 1 Bathroom 198.06 198.06 26.00 18.85 10.85 51
4 4 1 Bedroom 2 24172 24172 26.00 18.80 10.78 Ly |
4 5 1 Kitchen 417.29 417.29 26.00 18.70 10.66 50
h 1 1 Living Room 1113.85 1113.85 26.00 18.62 10.55 50
5 2 1 Bedroom 1 554.68 554.68 26.00 18.67 10,61 50
5 3 1 Bathroom 198.06 198.06 26.00 18.85 10.85 51 2
L] 2
F8: Calculations
b
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3.3.4.5 Space Conditions — Heating

If you select from Windows -> Space Conditions — Heating, the supply and return air as
well as the prevailing conditions in the space after the air supply (dry and wet bulb
temperature, absolute and relative humidity) are displayed for all spaces.

3.3.4.6 Systems Conditions — Cooling

If you select from Windows -> System Conditions — Cooling, the supply and return air as
well as the prevailing conditions in the space after the air supply (dry and wet bulb
temperature, absolute and relative humidity) are displayed for the spaces of each system.
3.3.4.7 Systems Conditions — Heating

If you select from Windows -> System Conditions — Heating, the supply and return air as
well as the prevailing conditions in the space after the air supply (dry and wet bulb
temperature, absolute and relative humidity) are displayed for the spaces of each system.
3.3.4.8 Air-conditioning units

The complete data for the selection of the Air-conditioning Units appear.

‘g Psychrametry - [FATMP\BIKY\8_3_BUILDING.BLD] - [Air-Conditioning Units] = | B |
‘%Eiles Project Data  View Windows Help - & %
Nl QR e S e R
(Bl S o A o

Air-Conditioning Units -

SYSTEM : 1- COOLING

DEVICE AIR FLOW (m3/h) Vsa 10102.43
DEVICE SPECIFIC HEAT FACTOR  GSHF . 0.9648
FRESH AIR LATENT HEAT GAIN  (KWatt) OALH o 0.000
OUTDOOR AIR SEMSIBLE HEAT  (K\Watt) OASH : 0.000
FRESH AIR TOTAL HEAT (KWatt) OATH o 0.000
TOTAL LATENT HEAT  (KWatt) TLH o 1.040
TOTAL SENSIBLE HEAT  (KWatt) TsH . 28499
DEVICE TOTAL HEAT (KWatt) GTH : 29539
COOLANT FLOW RATE (m3/h) P : 591

SYSTEM : 1-HEATING

CALCULATIOMS HAVE NOT BEEN PERFORMED

4 2

F8: Calculations
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3.4 Examples

In this chapter three step-by-step examples are presented, which will help you understand
in practice the basics of drawing in FINE HVAC. These simple examples aim mainly at
helping you start drawing building entities (walls, openings etc.) along with heating and
cooling networks. More specifically:

- Example 1, describes the steps of drawing a simple level and defining the spaces
so as to calculate thermal and cooling loads.

- Example 2, describes the steps of drawing a simple two-pipes heating network,
proceeding to the calculations and generating the necessary drawings. The same
steps can be applied also to the single-pipe and fan-coils application.

- Finally, example 3, describes the steps of drawing an air-duct cooling network,
proceeding to the calculations and generating the necessary drawings.

Apart from the following examples, you can watch the same steps (and much more) in the
videos you will find in http://www.4msa.com/FineHvacENG.html.

3.4.1. Building design example

In this example, the drawing of the
adjacent simple building is described,
including the steps from the beginning
(creating a new project) to the end
(calculating thermal and cooling loads) so
that you can easily understand the
function of FINE HVAC in practice.

For this example, we will import two
architectural plan views that have been
designed in AutoCAD although you can
start drawing from scratch. If you have
already designed the building in IDEA
Architecture 11, you can skip this
example.

1. From FILES menu, we select “New project”, type “Example_1" and press “Accept”.

2. From AutoBLD menu, we select “Building definition”, define as level 1 the “Basement”
in elevation “-3” and from “File” we load its architectural drawing. Before we define the
second level, we press “New” (so as to save the changes) and we follow the same
steps for the second level, as it is shown below.
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When we finish, we press once again “New” and then “Accept” and automatically we
defined the two levels with their architectural drawings.

3. Before we start drawing, we “Lock” the architectural drawings from the layers list on
the left by pressing the “Lock” symbol as it is shown below. The name of the
architectural drawing will be BASE_FLOO1 _XREF for the first level,
BASE_FLOO2_XREF for the second level etc.
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4. From AutoBLD, we select Walls > Outer wall and in
the properties window we define the height (3 m in
our example) and the width (0.25 m) of the wall, the
height and the width of the column (it will be
automatically designed along with the wall), its type
etc.

When we finish, we press “Accept” and we design
the wall by defining three points:

- First, we click on the beginning of the wall
(where the left red spot is, in the following
image)

- Then, we click on the end of the wall (where the
upper right red spot is) and

Outer Wall S
wiall Type
* Swaight  Curved
¥ Cleanup Join
% o Elevation
Height 300
Color 30
y W s Thickness : 020
I Color 30 . ByLavER Lengthi1: 000
Length2: 000
Color 2D B ewER Beam
Attibutes Ci B
U Fastor i Fived side :
Color 2 Fived wall side -
Weight (Kg/iF) 300 Connection with Roof
Type of ASHRAE CLTD c -
e ath [
Type of ASHRAE TFM G4
Type of ASHRAE RTS 17 Thermal Bridges
- __ThemalBridges..|
Aocept Cancel

- Finally, we click on the side that the wall “grows” (where the down right red spot

D Fine 14NG - ICAFINELA FVACWCALD Detached hovse bid Detached huse dag] o5
W) e Gde Veew beat Fomat Tock AwcBD AtoNiT P Ouw Dimancon Moddy Wadow Halp .
w1 GHd | dA DRV 9| F8 Aks| s B /AT @ | |/ /L2037 3 o8 - RA
<5450+ 030R
|aw|==3<a O
#1[7e 40 i

® @ L]
L ]

|
» (5 Pl Ve

I =

| E

|

| L P gy yrrs

Ig;_--. BA¥ing open drawinga... .
PR 1429G Lavetd Bacement narioce Heatng B Devation 920 13051, 5.44.280 CHTHO TP [(TRAGK W1 [MODIL o

You can enable the “Entity snaps” toolbar (or the “ESNAP” setting) so as to select

easily the edges of the wall.

Continuing in the same way, we draw all the walls (inner and outer) of the ground

floor.
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6.

-110 -

From AutoBLD, we select Opening > Door and in the properties window, we select the
height (2.20 m in our example), the length (1 m), the type of the door etc.

When we finish, we press “Accept” and we design the [=
door:

First, we select the wall upon which we want to place
the door.

We click on the starting point of the door (where the |... e
left red spot is, in the following image)

We click on the ending point of the door (where the
upper right red spot is). As long as you have
specified the length of the door, it is not necessary to | “*-
specify this point exactly. You only need to specify a
point near the start towards the side that the second
point is located.

Finally, we click on a point that shows the direction towards which the door will

open (where the down right red spot is).
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wil&Sd dA | XEY Ve A s /R |9 ||/ 2007 Mo @R " RA
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aw || ==Yl |0
FO|[vs D
T T TP
% Gomeral =
Coor O BYLAYER
rvr | FRAME ™
1 Uretype BYLAT] E
(T 3
|l
|
L L]

4| 4] ¥ | W] Model { Lapal ) Laymt [/

FINE 14NG Levek] Basernent Isterficer Heating Sy, Bievation .00 124.51.78.44.2.80 ORTHO [POLAR [ESNAP [ETRACK [LWT [MGDEL | TABLET |DVH
= T 1 T

From AutoBLD, we select Opening > Window and in
the properties window, we select the height (1.20 m in
our example), the length (1 m), the rise (0.80 m), the
type of the window etc.

When we finish, we press “Accept” and we design the
window:

- First, we select the wall upon which we want to
place the door.

- We click on the starting point of the window (where
the upper red spot is, in the following image)

- We click on the ending point of the window (where
the down red spot is). As with the door, as long as

TSde F Cortw © ZndSide

you have specified the length of the window, it is not necessary to specify this
point exactly. You only need to specify a point near the start towards the side that
the second point is located.
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7. After drawing the walls, openings, doors etc. the ground floor has been designed as it
is seem below. In the drawing, you can add the columns (from AutoBLD > Column)

and the floors/ceilings (from AutoBLD > Floor - Ceiling).

In the following image, we have deactivated the architectural drawing, so as to have a
better inspection of the drawing. To do this, go to AutoBLD > Layers management >

and uncheck the “XREF” box.
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8. We set the “North direction” symbol in the drawing, from AutoBLD > North direction.
9. In order to calculate the “Thermal Losses” and the “Cooling Loads”, we have to define

the spaces of the ground floor.

From AutoBLD > Definition of plan view elements > Space definition, we choose “By

point” and we zoom in, in a space:

- We click on an internal point of this space (where the left red spot is, in the

following image)
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- We click on an external point of this space (where the right red spot is, in the
following image)

- Inthe command line, where the prompt “Enter space name” appears, we write
“Bedroom 1” and press “ENTER”.
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10. We repeat step 9 for all the spaces of the level, as it is shown in the following image,
and we can now proceed to the calculation of heating and cooling loads from:

- AutoBLD > Calculations > Thermal Losses (detailed information in Chapter 3.2.1).

- AutoBLD > Calculations > Cooling Loads (detailed information in Chapter 3.3.1).
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3.4.2. Heating Network design example

1.

Continuing working with the previous drawing, from AutoNET > Select application, we
choose “Two pipes system’.

Automatically, the “Two pipes system” toolbar is Ty pipes System =
shown on the screen (see adjacent image) and you ——
can either work from there or from the AutoNET |2 %. % /L M w0
commands.

First of all, we place the radiators in the rooms of the ground floor. From AutoNET >
Radiators, we select the “IV505” radiator type, press “Accept” and place it in “Bedroom
1”. In this way, you can select on your own the type and the number of the radiators in
each room.

Alternatively, from AutoNET > “Automatic radiators placement”, if we click on the
“Living room” and press enter, the program automatically selects the number, the type
of the radiators (depending on the “Thermal loads” of the space) and places them in
the room. We repeat the same for the rest of the rooms.
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3. From AutoNET > Supply pipe > we select “Straight supply pipe” and start drawing it

between the walls and the radiators as it is seen in the following picture.
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4. The next step is connecting the supply pipe with the 1y pipes system

el

radiators and we do this easily by selecting from AutoNET
> Supply pipe > Connect radiators to an existing pipe (or

|yw%z@ﬁza

ir
4
- We click on the first radiator SR

o

We click on the supply pipe next to it and finally 2%

s

from the corresponding symbol of the toolbar):

Press ENTER and they are automatically connected.

"qlConnect Receptors to Existing Pipe

- We repeat the step for all the radiators.
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5. In order to place the vertical pipe that leads to the basement, we select from AutoNET

> Main vertical pipes > Main vertical supply pipe:

- We click on the location we want to place the vertical pipe (in the command line

you can see the “Enter XY location” prompt message).

- We type the height “-3” which is the starting point of the vertical pipe in this

example (the basement elevation).

- We type the height “0” which is the ending point of the vertical pipe in this example

(the ground floor elevation) and the supply vertical pipe is created.
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6. From AutoNET > Supply pipe > we select “Straight supply pipe” and draw a part of
the pipe connecting the horizontal to the vertical pipe as it is shown below.

You can use the “Entity snaps” toolbar (it is highlighted in the picture) to connect
precisely the two pipes.
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7. We repeat the steps 13-17 for drawing the return network (drawing vertical and
horizontal pipes and connecting them with the radiators) and we have set the two
pipes heating network for level 2.
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8. By selecting the level of the basement (you can use “ ¥ to change levels or double
click on the level’s name in the left side of the screen) we draw the horizontal supply
and return pipe starting from each vertical pipe as it is shown below.

You can easily connect the horizontal to the vertical pipe using the “Perpendicular
snap” point (highlighted in the following picture).
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9. Finally, from AutoNET > Network start point, we set the supply and return start point
symbols. You can easily connect the symbols to the horizontal pipe using the
“Endpoint snap” point (highlighted in the following picture).
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10. Before we proceed to the heating calculations, we select from AutoNET > Network
recognition. This is an important step in order to make sure that the network has been
drawn correctly. If there are any mistakes, a warning message will appear, otherwise,
the network sections are numbered as it is shown below and we can proceed to the
calculations.
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11. From AutoNET > we select Calculations and in the window that opens automatically,
we select Files > Update from Drawing.

From Windows menu > we open the Calculation Sheet where the network information
have been transferred (detailed information in Chapter 3.2.2).

Fles FProjectData View Calculation Sheet Windows Libraries Help

Llsldala) (elale (@@ lele i4|a®

gz m = & AaE Ls L2l H00% (L] Twis Pipes Hestng System Caluistons.
([ElEtie) &y

% Calculztion Sheet

Network (Pipe  |Radiator | Temperature|Water Water | Type|Fittings|Pipes |Totat |7 Radiator Enteting
Seclion |Length (Loads Difference [Flow ocity [of |Fr.Drop Friction |Frickion Tie {Veater
C) G)|Drop s £
(MWG)

Vel
{m) {Mcalh) {mah) {S. ) [(mis)  [FiE | (mWC Less {7} {libcaliy; {Temp.
(TG HC

112 158 0238 0329 F1 0028 0128 0155

23 7400 0190 0262 8 0010 0054 Q085

4 5208 0138 0192 F2 0006 0022 0028

4.5 3875 0.126 0174 8 0.005 0.013 0018

a6 9.868 0.035 X 0048 F-3 0001 0004 0004 & 9524 WEOS

5.7 0218 0.091 X 0126 F-4 0003 0000 0034 > 1368 505

4.8 0218 0.013 0018 F-4 0.000  0.000 2.3 2185 WSOS

£} 0147 0.851 0071 F4 000t 0000 G00T BITt 905
0218 0048 0086 F4 0001 0000 OO 072t WNOOS

11.01
T416
5082
3875
9646
0.096
0.096
0168
0036

View Network Section (eg. 1.2)

When we finish the calculations, we save and close the window and return to FINE
HVAC.

12. From AutoNET > we select Update Drawing and in the opening window we choose
which network segments and radiators information we want to be show on the screen.
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By clicking “Auto Placement”, the selected information is shown in each level.
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13. Finally, from AutoNET > we can select Convert single line to 3D and the program
automatically creates 3D pipes in relation to the calculation results.

 Fire 1 NG - [CAFINELS_HVACICAL bl heusim bl Detached houte dag]
B) Fie Edt View lriet Formet Took AutoBLD  AuloNET Pl Duw Dimension Modity Window Help
e@0Sd 2 4007 90 8| Jksls B FERAT ][/ /G0 r@wedan - RA

(<%a8R+0AL/ +vaF Fax|[d=bTsen(# 5y BEE: Bu0d v e | deday
a~][=#veumoar] [xa] [®
|| £F |[7 % a0 vons_ra vs =] [[B onaven =]

[

ELATER =] | eneaLoa: = e .

CAE|0O® XN

Bk

0 [ P Ve

/,—__;}f—N

IFM'IM (453357 53.2.50 [SHAF [GRID [ORTHO [POLAR [TSMAP [FTRACK [LWT [MODEL [TASLIT [OVN g
S

-118 - FINE - HVAC



3.4.3. Cooling Network design example

1.

4.

Continuing working with the previous drawing, from g Ducts =

AutoNET > Select application, we choose “Air ducts”. P _
. ) . VYL E A

Automatically, the “Air ducts” toolbar is shown on the

screen (see adjacent image) and you can either work from there or from the AutoNET

commands.

From Plus menu > we select “Set elevation” and in the command line we type “2,6”
meters. In this way, everything that we are going to design will be placed in 2,6 min z
axis in relation to each level.

First of all, we place the grilles in the rooms of the ground floor. From AutoNET >
Grilles (or directly from the “grilles” symbol of the toolbar), we select the “K 104 A”
type, press “Accept” and place it in “Bedroom 1”. In this way, you can select on your
own the type and the number of the grilles in each room.

Alternatively, from AutoNET > “Automatic grilles placement”, we select the type of the
grille we want, we click on the “Living room” and press enter. The program
automatically places the grille in the center of the room. We repeat the same for the
rest of the rooms (we can select more than one room each time).
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From AutoNET > we select “Supply air duct” and start drawing the network of the air
ducts. If you want, you can draw them in a different elevation by repeating step 25 (in
our example, we draw the air ducts in an elevation of “2,8” m).
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5. The next step is connecting the supply air duct with the grilles and we do this easily by
selecting from AutoNET > Connect grilles to existing duct (or from the corresponding

symbol 3 of the toolbar). Instead of this command, you can use the “Connect grilles
to existing duct with flexible duct”:

6. In

We click on the first grille
We click on the supply air duct next to it
We press ENTER and they are automatically connected.

We repeat the step for all the grilles (we can connect more than one grille to an air
duct each time).
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order to place the vertical air duct that leads to the basement, we select from

AutoNET > Vertical air duct > Supply duct:

-120 -

We click on the location we want to place the vertical duct (in the command line
you can see the “Enter XY location” prompt message).

We type the height “-3” which is the starting point of the vertical duct in this
example (the basement elevation).

We type the height “2,8” which is the ending point of the vertical pipe in this
example (from the “Set elevation” command we have set the elevation we are
drawing the air ducts in the ground floor in “2,8” m) and the vertical duct is created.
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7. From AutoNET > we select Supply air duct and draw a duct connecting the horizontal
to the vertical air duct as it is shown below.

You can use the “Entity snaps” toolbar (it is highlighted in the picture) to connect
precisely the two ducts.
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8. By selecting the level of the basement (you can use “ ¥ to change levels or double
click on the level’s name in the left side of the screen) we draw a horizontal supply air
duct starting from the vertical duct as it is shown below.

(ou can easily connect the horizontal to the vertical duct using the “Perpendicular
shap” point).

Finally, from AutoNET > Network start point, we set the supply start point symbol. You
can easily connect the symbol to the horizontal pipe using the “Endpoint snap” point
(highlighted in the following picture).
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9. If you want, you can easily draw the return air ducts network by repeating the steps
26-31.

FINE - HVAC -121-



10. Before we proceed to the cooling calculations, we select from AutoNET > Network
recognition. This is an important step in order to make sure that the network has been
drawn correctly. If there are any mistakes, a warning message will appear, otherwise,
the network sections are numbered as it is shown below and we can proceed to the
calculations.
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11. From AutoNET > we select Calculations and in the window that opens automatically,
we select Files > Update from Drawing.

From Windows menu > we open the Calculation Sheet where the network information
have been transferred (detailed information in Chapter 3.3.3).
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Network Section

When we finish the calculations, we save and close the window and return to FINE
HVAC.

12. From AutoNET > we select Update Drawing and in the opening window we choose
which air ducts and grilles information we want to be show on the screen.
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By clicking “Auto Placement”, the selected information is shown on each level.
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13. From AutoNET > we select Convert single line to 2D, in the command line we type “S”

(as we only have supply network) and the program automatically creates 2D pipes in
relation to the calculation results.
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14. Finally from AutoNET > we select Convert single line to 3D and the program
automatically converts the network into 3D in relation to the calculation results.
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